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Introduction

The Representative Payee Manager system is an easy and comprehensive approach to automating much of the work
associated with representative payee services. The system tracks all details about transactions for clients. Some of
the features included are:

Client Information

e Basic client information
e Client demographics

e Case notes

e Monthly budgets

e Asset tracking

e Event tracking

e Contacts

e Housing and employment
e Impairments

e Document linking

e Photo

Financial Information

e Recurring payments, deposits, and transfers
e Check, deposit, and transfer entry

e Batch payments for vendors and clients

e Print all or selected checks

e Reconcile your bank account

e Mass and individual accounts

e User-defined check layout

e Interest allocation

Reports

e Transactions by client, date, and type

e Balances and budgets

e Income and expense graphs

e Case notes and statistics

¢ Vendor transactions

e Client lists and information

¢ Reconciled and outstanding transactions
e Over 170 reports with multiple variations

Security

e Userlogon and password protection
e Security levels for controlling access
e Limit access to clients by types

e Audit trails



System Navigation

In addition to following traditional Windows design standards, other visual cues make using the system easier. Cues
such as the use of color make it easier to see information and to determine if it can be changed. All user data displays
in sunken boxes. Within the boxes, green text with a white background indicates the data can be changed, whereas
black text with a white background indicates the data is read-only. Black text with a gray background indicates data
that cannot be directly entered but is instead calculated by the system (for example, age or account balance). Labels
are displayed to the left or top of the data item and are black text. Data items of similar types are grouped together
with frames and have a blue title in the top left corner of the frame.
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A consistent approach has been taken in designing all the screens. The sample screen above demonstrates many of
those standards:

e Button - used to open a screen or report, or process or close a screen, as indicated by the label on the button.

e Checkbox - used to indicate a Yes/No value. In this case, it indicates whether to batch payments for this vendor
by default. Checked means "Yes"; unchecked means "No."

e Dropdown list - used for a list of selectable values. Start typing to move to an item in the list, or use the "down"
arrow to the right to open the list and choose an item. If the desired value is not in the list, entering an invalid
value (such as an "x") will prompt a message with instructions for adding to the list (if the list can be changed).

e Grid - alist of rows that lets you enter or view multiple rows of information.
¢ Add Row - click the + button to add a new row.
e Delete Row - click the X button on a row to delete that row.
e Radio button - used to select only one option out of two or more possibilities.

e Navigation bar - the navigation control at the bottom of most screens allows the user to move between records,
such as individual clients or vendors. The buttons allow moving to the first, previous, next, or last record on a
screen. "Record 2 of 12" means you are currently editing or viewing the 2nd record and there are 12 total
records.

e Scroll Bar - use the vertical and horizontal scroll bars to scroll both up/down and left/right when more data exists
than can be seen on the screen at one time.
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e Search - use the "Search" box to find information in the currently displayed records. Type in a value to search for
and use your "Enter" key to search. Use "Enter" again to find subsequent matches.

e Using the "Search" box at the bottom of the Clients or Vendors screen will search all the displayed clients or
vendors (excluding information in grids under those clients or vendors).

e Use the "Search" box in a grid to find information within the records displayed on the grid. For example, using
the "Search" box below client case notes will search the case notes for the selected client.

e Record selector - the record selector at the left of most screens indicates the editing status for the current
record. For screens that use grids and show multiple records on a screen, the record selector is located at the left
of each row but has the same functionality. The available symbols on the record selector are described below.

*
l: This indicates a new record in which you can enter information.
EI This indicates the currently selected record when no changes have been made to the record.

[: This indicates that a record has been modified but not saved. To discard changes made and restore the original
data, select the "Undo" option from the Records menu or use the "ESC" key on your keyboard. Use "ESC" once to
clear out information entered in the current field. Use "ESC" twice to clear out the entire record entered but not yet
saved.

** Use the "ESC" key on your keyboard if you start entering information and do not want to save it **

@
[ This indicates a record that is locked (being changed) by another user.

Date Entry

Date | 01/24/2024
B January 2024 e Calendar

Su Mo Tu We Th Fr Sa date picker

1 2 3 4 5 6

7 8 9 10 11 12 13

14 15 16 17 18 19 20

21 22 23[ 24| 25 26 27
28 29 30 3

Today

The Calendar Date Picker displays when you enter a date field. Use it to select a date from the calendar instead of
manually entering a date. Click Today to enter the current date in the field.

Enter dates manually using the format m/d; the date defaults to the current year. For example, enter 1/1 to enter
January 1 in the current year. To enter dates in other years, use the format m/d/y (for example, enter 1/1/23 for
January 1, 2023).



Ribbon Menu

File RPM

Backup/Restore v ...«,.. »Zj E

Import/Export ~

£ Find

P Client ~
—l

List X
Maintenance Transaction v

Utilities

@ Help
1 System Info
7 Tech Support
Help

FE)

Reports

° +
22 °
:.(:_’ -
Users Change  User
Password Settings

Security

Setup v bﬂ Save

Dashboard Clients Transactions Vendors Reconcile

File View Reports Edit Records | Filter/Sort

The above menu is the default ribbon.

The Text Formatting section (not pictured) will only be displayed for screens where Rich Text format can be used.
This includes the Personal, Case Notes, and Notes tabs on the Clients screen.

The Spell Check button will be added to the Text Formatting menu when using the Case Notes or Notes tabs. Spell
Check functionality comes from Microsoft Office. Spell Check will be available if you are using the same version of
Office as the Access runtime version you are using for RPM.

2 | QEEEIE L | B

Print Zoom | One | Two More Export Excel Word Email Email Close Print
3 Page | Pages Pagesv | toPDF PDF Preview

Print Zoom Export Report Close Preview

When viewing reports, an additional ribbon will be available, as shown above. Use the Export to PDF button to export
a report to a PDF file. The PDF file can be saved or emailed. Use the Email PDF button to send the report to yourself.
The Email button is built-in Microsoft functionality and may not work with all email systems. If the Email button does
not work with your system, use Email PDF or Export to PDF instead.

Shortcut Menu

A shortcut menu is available on most screens. Open it by right-clicking on a field on a screen. The available options
may vary based on the current screen.

¥ Cut

Copy

[%-‘j

©

Find...

SortAtoZ

N N
—

ot

SortZto A

-

Filter By Selection

Filter Excluding Selection



Finding Records

Find ? X
Find
Find What: | Alvarez] v| [ FindNext |

Cancel

Look In: Current field v
Match: Whole Field v
Search: All v

[IMatch Case Search Fields As Formatted

To find information on a screen, right-click in the field to search and select Find from the Shortcut Menu, or use the

Find

button on the Records menu.

Find What - enter the information to find (for example, social security number, date, or amount). The Find What
format must match the format on the screen.

Look In - select "Current Field" to find in the current field. Select "Current Document” to search all fields on the
screen.

Match - select "Whole Field" to find information that matches the entire value. Select "Any Part of Field" to find
information that is a partial match. Select "Start of Field" to find information that matches the start of a field (such
as the start of a last name).

Click Find Next to find the first match. Click Find Next again to search for additional matches.

Sorting Records

To sort information on a screen, right-click in the field to sort and select "Sort A to Z" or "Sort Z to A" from the shortcut
menu. Sorting is also available by clicking in a field and selecting the "Ascending” or "Descending" options on the
Filter/Sort menu. Use Remove Sort to remove the sort, or close and reopen the screen.

Filte

ring Records

To filter information on a screen, right-click in the field to filter and select "Filter by Selection" or "Filter Excluding
Selection" from the shortcut menu. Filtering is also available by clicking in a field and using the "Filter" or "Selection”
options on the Filter/Sort menu.

The "Selection” options are the following:

Equal to the current value

Not equal to the current value
Containing the current value
Not containing the current value

Below is an example of filtering based on a date. Click a date on the Transactions screen, for example, and filter the
records that equal or do not equal that date.



Y Selection~ | Zl Descending

Equals 01/20/2024

Does Not Equal 01/20/2024

On or Before 01/20/2024

On or After 01/20/2024 ’

Y Filter ?l Ascending ’

Between...

Below is an example of filtering based on a transaction category. Click a category on the Transactions screen, for
example, and filter records that equal or do not equal that category.

Y Filter 2| Ascending
Y Selection v | %l Descending 5

‘ Equals "Insurance" .
Does Not Equal "Insurance”
’ Contains “Insurance”

‘ Does Not Contain “Insurance”

The Filter button on the Filter/Sort menu will show additional filtering options depending on the type of field being
filtered. With a date field, multiple dates can be selected. Under the "Date Filters" option on the shortcut menu,
options such as "Today," "Last Week," "This Month," and "Year To Date" are available, as shown below.

e ey e .
Equals...
I Process Pmts I Process Deps
Does Not Equal...
ount Ichecking Befores
riteria Afteri
ite  End Date Pmt. Method i
— Between...
12023 | [ v
- Tomorrow
atails" to view, edit, delete, or void a trg
Today
Date Pmt. Method Check# .
Yesterda
[ 01/20/202 [xeFT | =Y
- Next Week
2| Sort Oldest to Newest SRRAESH
This Week
| Z] Sort Newest to Oldest PSS
Last Week
¥ L
Next Month
- Date Filters > i
This Month
(Select All)
t Month
i (Blanks) St Mont
10/20/2023 Next Quarter
10/23/2023 This Quarter
10/24/2023 bast Quarter
10/25/2023
10/30/2023 Next Year
10/31/2023 This Year
11/01/2023 Year To Date
oK Cancel Last Year
I 1 : Past
Balance Eifiige
L} 10f299 | » M Sez
P All Dates In Period >

Click Remove Filter on the shortcut menu or the Toggle Filter button on the Filter/Sort menu to stop filtering. Filters
can also be removed by closing and reopening a screen.



System Logon

RPM Logon
User ID IAdminUser OK
Password II Cancel

Each user will be assigned a user ID and password by an RPM administrator at your company. The password is case-
sensitive. For example, "PASSWORD" is not the same as "password." Click OK to continue or Cancel to exit the
system.

If you forget your password, it can be reset by another RPM user who has rights to the Users screen.



Open Company

This is used to switch between company databases in RPM. This option is only available with an RPM Multi-Company
license.

Open Company

Select Company

iCompany 1
Company 2

OK Cancel

For SQL databases, use the SQL Connect utility to set up new companies. For Access databases, use the Company
Connect utility to set up new companies.

From Logon

RPM Logon
User ID ]AdminUser OK
Password || Cancel

Open Company

Before logging in to RPM, select Open Company at the bottom of the "Logon" dialog to access the "Open Company"
dialog. Select the Company you wish to open and click OK.

Enter a user ID and password, then click OK to complete your logon to the selected company. Your user ID must be
set up in each company database before you can use it to log in; user IDs do not transfer across company databases.

Click Cancel on the "Logon" dialog or the "Open Company" dialog to close RPM.



From Ribbon Menu

Select Open Company from the Company section of the ribbon menu to select a different company database. Select
the Company you wish to open and click OK.

Click Cancel to leave the current company open.



Getting Started

See our "Getting Started" topics in our Knowledge Base for specific steps to start using RPM:
rpmccs.com/resources/category/getting-started/

Account Types

RPM can use both mass and individual checking accounts. Regardless of the account type used, RPM will track the
balance for each individual client.

Using a mass account has some benefits. A single batch check can be sent to a vendor for all clients or groups of
clients. Deposits can be imported from a bank file using the Import ACH Deposits utility. There is only one account to
reconcile. Mass accounts may be interest-bearing, and the interest can be automatically distributed to clients.

e Mass Account - a bank account shared by multiple clients, also known as a collective account. All deposits

are made into the shared account. Payments are made for all clients from the shared account. All
transactions are tracked through the shared account, but RPM keeps track of each individual client's
transactions and balance within the account.

e Individual Account - a bank account belonging to a specific client. Deposits are made separately into each

client's account. Payments are made for each client from their account. Individual transactions and balances
are tracked for each client.

Regardless of the type of account(s) used, all money in RPM will be assigned to individual clients.

Entering Clients and Initial Balances

The following tasks can be completed before you start using RPM for live transactions:

1.
2.
3.

Set your desired default settings on the System Setup screen.
Set up your check format using the Check Layout screen.

Enter clients on the Clients screen. At a minimum, fill out the information on the Basic tab before entering
transactions. The remaining tabs can be filled out at any time.

Print the Client List (on the Reports screen under the "Clients" section) to verify the client information.

Enter vendors on the Vendors screen. Set the "Transaction Defaults" for each vendor. To batch payments by
default for vendors, set the "Batch Payment" option for the vendor and for client types under the "Client Type" list
on the List Maintenance screen.

Set up the categories to use for deposits and payments under the "Deposit Category" and "Payment Category"
lists on the List Maintenance screen. Categories can be changed at any time, and the changes will be reflected in
any existing transactions already using the category.

Use the Schedule Pmts and Schedule Deps tabs on the Clients screen to set up any recurring scheduled
payments and deposits. Enter the "Next Payment" date or "Next Deposit" date for the first date to process
transactions in RPM. To set up scheduled payments or deposits for all clients or a type of clients, use the Create
Scheduled Payments and Create Scheduled Deposits screens.

If you are moving existing clients and balances from another system, you MUST follow these steps when you
are ready to go live:

1.

2.

Reconcile your bank account. You will need the reconciled balance for each client and any remaining uncleared
checks and deposits.

Use Enter Deposit on the Transactions screen to enter each client's current reconciled bank balance.

10
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Use the Reconcile screen to mark all the existing deposits as reconciled. The "Cleared Balance" on the
Reconcile screen should match your current reconciled bank balance.

Use Enter Deposit to enter any remaining uncleared deposits.

Use Enter Payment on the Transactions screen to enter any remaining uncleared payments. Select "Manual
Check" for the Payment Method and enter the original check number, or select "EFT" or "Debit" for payments
without a check number.

Print All Balances - By Client (on the Reports screen under "Balances") to ensure client balances in RPM match
your existing balances. If the balances match, you are ready to begin entering or processing all future
transactions in RPM.
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Dashboard

(B  Representative Payee Manager - a X

File  RPM

Backup/Restore ~ = Q P IT EH /71 Client~ m 2 E_ Q= L Find 7) Help
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3] Dashboard X X
Close Refresh User Community
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Transactions Clients
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; "h Date Client Contact Type Case Note User ID
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8 4 0 directives. Scheduled in-office g for T 7123
for client to come in and discuss with our legal rep
Scheduled Unprinted XEFT not Vview | 07/19/2024 Abbott, Lisa Andrea Telephone Lisa called o request additional PN funds. Will need to review AdminUser
Transfers Checks Exported August budget
6 12 17
Receipts not Events Count 2
Received Date Client Event - Category Notes
9 View | 07/23/2024 Wiliams, AmL___ Advanced Directives In-ofice meeting with client 1:30 PM
View | 08/01/2024 Davidson, Linda Annual Report
Open the User Settings screen under the Security
menu to configure your Dashboard Settings.

Include Transactions thru Date Num Lock  Powered by Microsoft Access

The Dashboard screen provides quick access to scheduled tasks in RPM. Tasks include outstanding transactions,
urgent case notes, and events not completed. Select Dashboard from the View menu to open this screen.

This is the first screen shown in RPM if "Display Dashboard when opening RPM" is selected on the User Settings
screen. Other default options for the Dashboard, including the account manager and date range options, can also be
set in User Settings.

The "Filter Account Manager" option allows you to see tasks for all clients or just tasks assigned to a selected
account manager.

Transactions

The "Transactions" buttons show the outstanding items of each type of transaction up to the "Include thru" date.
Clicking a button opens the corresponding screen for processing those items. You must have appropriate security
rights to process the items. Without process rights, a report of the items displays instead.

For example, the Scheduled Payments button displays the count of scheduled payments to be processed up to and
including the "Include thru" date. With rights to process payments, clicking Scheduled Payments will open the
Process Payments screen and display those payments to be processed. Without rights to process payments, clicking
the button will open the Scheduled Payments report.

User Community

The "User Community" section at the top of the screen displays recent news and activity from our RPM User
Community. Click View News and View Activity to open the latest posts.

Anyone can view news posts. Only members of the User Community can view and comment on activity posts. To join
the RPM User Community, visit our website: rpmccs.com/login

Clients
The "Clients" section displays urgent case notes and events not yet completed during the date range. Click View for
an item to go directly to that case note or event on the Clients screen.

Click Refresh to update displayed counts and items. This can be useful if other users are also updating information in
RPM.
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Clients

Select Clients from the View menu to open the Clients screen. The information on this screen is organized using
tabs. Click the desired tab to view that information for the selected client. The information on each tab is explained in
the following topics.

To add a client, click the New button. When adding a new client, the cursor will default to the "SSN" field before
continuing with the client's name. Entering the SSN first allows you to check for duplicate clients before proceeding.

[E  Representative Payee Manager - a X
File RPM
Backup/Restore v f] R v i E_,B‘ <‘l Client v 2 IELI = SO Find 7 (@ Help
A 2 & [ e 5 - = | &
Import/Export ¥ | pachiboard Clients Transactions Vendors Reconcile List ~ Setue~ Reports | Users Change User ] I Save  Toggle Fitter A\ System nfo
Maintenance Transaction v Password Settings 2 ¢ . £ Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help ~
=5l Dashboard X [-3] Clients X X
Close | New | Graph | Client Account Balances 01/20/2025 Total Less Min. &
- Checking: Mass $1,788.58 | $1,788.58 | $1,688.58 @ Filterstatus @ Active CInactive  C All
Select Client [Crawford, Barbara Joanne ¥ |savings: Individual $900.00 | $900.00 | $800.00 v  Filter SupportType © All  selected |Individual Accts
K Basic Personal | Schedule Pmts | Schedule Deps J Schedule xfer | View Trans | Budget | Housing | Employment | Impairments |
Events l Case Notes | Notes | Contacts ] Photo | Documents | Test Scores | Custom | Assets I
Basic Status
Name |Barbara |Joanne |(rawford Pref. |Barb Client Type Rep Payee v~  Status Active v
Address 1 |411 Fourth St Phone I(soz) 555-4879 SSN |”'-”-6666 View/Edit Claim #s Acct. Mgr. Williams, John v AddDate |12/01/2013
Address 2 |Apt. 11A Cell |(Soz) 555-4668 Birthdate | 11/07/1941 Age | 83 Support Type |Mass Accts v StartDate | 12/01/2013
Zip/City/St [40207-1234 |Louisville % Mail Statement ¥ Email [barbcrawf@test.com =
| | ! '——] Basic Notes
Account(s) Balance Total Balance Custom Notify support staff if Barb requests additional funds.
Minimum $100 Account(s) $2,688.58 Financial goal [Birthday gifts for 11 grandchildren Be sure to address as Miss Crawford!
Limit $2,000 Assets $10,500.42 Preferred communication |Mai] v
Mass Account(s) Individual Account(s)
+ |Account Name Balance Default Bal. Pay. Inactive + |Account Name Balance Default Account # Bank Type Next Chk # B
¥] x |[Checking v 78858 W I T ] x [savings [ $900.00 T 54321235 [First National Banl - [checking | 1 Reset
*| x o ] T T T *| x ] T—I | v |(hecking v | Reset
< >
Client 4 4 30f10 | » » > | NZUnfiltered | Search
Clients Num Lock  Powered by Microsoft Access

The Clients screen contains information about each client. Use the "Select Client" field to quickly move between
clients by name. Start typing a letter or last name to move to that part of the list. Select a client to go to that client's
record. See System Navigation for more navigation details.

Account balances display at the top of the screen. This includes the balance on the current date, the total balance,
and the total balance less the minimum entered (if any) for this client. Enter a different date to see the balance on that
date. Each user can turn their own balance display on or off on the User Settings screen.

If a balance limit and/or minimum is set for a client, balances beyond that threshold will be highlighted. Each user can
manage their own balance highlight settings on the User Settings screen.

By default, all balances over a limit and/or under a minimum will be highlighted. If you wish to apply balance
highlighting only to the clients' default accounts, this can be changed on the System Setup screen.

The "Filter Status" options allow you to see active, inactive, or all clients. To view all clients (active and inactive), click
the All option.

The "Filter Support Type" options allow you to see clients assigned to all or a selected support type. Set your defaults
on the User Settings screen.
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Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support
types are assigned to your user ID, you will only be able to access those types of clients. If client types or support
types have NOT been assigned to your user ID, you will be able to access all clients. "Access Limited to assigned
Client Types and/or Support Types" displays at the top of the screen if your user ID has been set up for client and/or
support type filtering.

By default, clients are sorted alphabetically by name. To change the sort, right-click in the field you wish to sort and
select "Sort Ato Z" or "Sort Z to A" from the Shortcut menu.

Fields on the Basic tab are explained below.
¢ Name - client's name in First, Middle, Last name order.
e Pref. - client's preferred name. This is optional and will not appear on transactions.

e Address - client's mailing address. Either a 5-digit or 9-digit ZIP code can be entered. Typing the ZIP code first
will automatically fill in the city and state.

e Phone - area code field is included but not required.
e Cell - area code field is included but not required.

e SSN - when you enter the SSN, the system will check for duplicates to prevent entering the same client more
than once. After the initial entry, only the last four digits of the SSN display. Click View/Edit to view the entire
SSN or to modify it. Click the same button again to hide the SSN from view.

e Claim #s - use this button for entering claim numbers for the client (see the Claim Numbers topic for more
information).

e Birthdate - client's birthdate. The client's current age is automatically calculated and displayed next to the
birthdate.

e Mail Statement - check to mail the Client Statement (Window Envelope) report to the client's mailing address.
Set the default "Mail Statement to Client" option on the System Settings tab on the System Setup screen.

e Email - email address. Click the Mail button next to the email address to start an email message addressed to
that person using your default email application. This functionality may not be available for all email applications,
but it should work with Outlook.

e Client Type - select a value from the list (List Maintenance > Client Type).
e Acct. Manager - select a value from the list (List Maintenance > Account Manager).

e Support Type - defaults to the currently filtered support type. A different value can be selected from the list (List
Maintenance > Support Type).

e Status - select a value from the list. A client can only be "Active" or "Inactive.” Transactions cannot be entered
for "Inactive” clients. The default when adding a new client is "Active."

e Add Date - defaults to the date the client was added to the system.

e Start Date - the date this person became a client. This is used to determine a client's anniversary for various
reports.

e Minimum - the minimum balance for the client. A warning message displays if a transaction would lower the
client's balance below their minimum. View clients with balances below their minimum on the Reports screen
under Balances > Balances Under Minimum.

e Limit - the balance limit for the client. Leave blank or zero if the client does not have a limit. View clients with
balances exceeding their limit on the Reports screen under Balances > Balances Over Limit.

e Total Balance Account(s) - displays the client's total balance for all mass and individual accounts.

e Total Balance Assets - displays the client's total balance for all assets.

e Custom - displays up to two custom dates, text fields, or lists. Select which fields will appear here by visiting the
Custom Client Fields tab of the System Setup screen.

e Basic Notes - text field for entry of pertinent notes for the client.
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e Mass Account(s) - select any mass accounts to be used by this client. Mass accounts are shared by multiple
clients. Click the + button to add a new row.

Account Name - select a mass account to which you want to assign this client. New mass accounts can be
added in List Maintenance > Mass Account. The account name will be disabled if the mass account is marked
as inactive on the List Maintenance screen.

Balance - displays the client's current balance in this account.

Default - check if this will be the client's default account. When entering transactions, the default account will
populate automatically. The first account entered (mass or individual) will be automatically set up as the
default account. If additional accounts are added, a different account can be selected as the default.

Bal. Pay. - check if you want to automatically create a transaction for the client's balance in this account when
running the Client Balance Transactions utility.

Inactive - check to make the mass account inactive for this client. The account name will be disabled if the
mass account is marked as inactive in List Maintenance.

e Individual Account(s) - enter any individual accounts to be used by this client. An individual account can only be
used by the client for which the account is entered. Click the + button to add a new row.

Account Name - enter a name for the account. You do not need to enter the client's name as part of the
account name. The client's name displays along with the account name on other screens to distinguish
between accounts.

Balance - displays the client's current balance in this account.

Default - check if this will be the client's default account. When entering transactions, the default account will
populate automatically. The first account entered (whether mass or individual) will be automatically set up as
the default account. If additional accounts are added, a different account can be selected as the default.

Account # - enter the account number for this account. This is not required but must be entered to print
account numbers on the checks (for example, if you are using blank check paper or checks without the
encoding already printed).

Bank - select the bank for this account. Add new banks in List Maintenance > Bank. This is not required but
must be entered if you want the bank information to print on the checks (for example, if you are using blank
check paper).

Type - indicate whether this is a Checking or Savings account.

Next Chk # - enter the next check number to be used for this account. After saving the record, the next check
number can be reset using the Reset button to the right of the "Next Chk #" field.

Bal. Pay. - check if you want to automatically create a transaction for the client's balance in this account when
running the Client Balance Transactions utility.

Inactive - check to make the individual account inactive.

To update values shared by multiple clients at once, use the Client Information Update utility.
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Personal Tab

IE  Representative Payee Manager - a X
File RPM
Backup/Restore f’b ;{O‘ 74 E,‘ﬁ <?E| Client v . é El Qi O Find 7 (@) Help
i v “ e 5 A
Import/Export ¥ | pachiboard Clients Transactions Vendors Reconcile List ~ Setup~ Reports | Users Change User | - I save Y ToggleFitter A\ System Info
Maintenance Transaction v Password Settings [P Paste ) Saved Record v € Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help A,
(5] Dashboard X [3] Clients X X
Close | New | Graph | Client Account Balances 01/20/2025 Total Less Min. & i A 3 s . ~
- S Checking: Mass $1,187.00 | $1,187.00 | sS1,087.00 @  Filterstatus © Active ©inactive All
Select Client  [Baker, Mark Luis Santiago ¥ |savings: Individual $1,173.87 | $1173.87 | $1,073.87 v FilterSupportType © All € Selected |Individual Accts =
L Basic Personal Schedule Pmts | Schedule Deps l Schedule xfer | View Trans | Budget l Housing | Employment | Impairments I
Events | Case Notes | Notes | Contacts ] Photo | Documents | Test Scores l Custom | Assets |
Personal Identifiers ~Statement Notes These notes will print on Client Statement reports.
Gender Male v Birthplace Louisville, KY Questions about balances should be addressed to Tim Deen at tdeen@abcpayee.org.
Pronouns He/him v Mother's Maiden |Elardi
Race White v Father's Name Samuel
Ethnicity Hispanic/Latino
Referral
Marital Status  |Married v Roferral Source ’("ti
——— ou v
Marriage Date | 06/06/1977
8 /06/ Referral Date 10/16/2013
Divorce Date
Spouse Death 2o ~Government Status Account Information for XEFT Transactions
Termination
PN Amount W T REnot vl County Jefferson v Routing Number (111111118
Medicaid Num. W Term. Date  E— Ward Number ~ Account Number ;8561451321 "
Medicare Num. [2a5326368 Death Date — County District C: |3~ Account Type Checking Savings
Savings Acct. - Legislative District [0+ RPM Client ID 3

Client 4 4 20f10 | » » b+ | NZUnfiltered | [Search
Select Client Num Lock  Powered by Microsoft Access

The Personal tab is used for entering demographic information for a client.

Fields are explained below.
e Gender - select a value from the list (List Maintenance > Gender).

e Pronouns - select a value from the list (List Maintenance > Pronouns).

e Race - select a value from the list (List Maintenance > Race).

e Ethnicity - select a value from the list (List Maintenance > Ethnicity).

e Marital Status - select a value from the list (List Maintenance > Marital Status).

e Marriage Date - used to track the date of the client's marriage, if applicable.

e Divorce Date - used to track the date of the client's divorce, if applicable.

e Spouse Death - used to track the date of the client's spouse's death, if applicable.
e PN Amount - the personal needs amount (used for information only).

e Medicaid Num. - the Medicaid number.

e Medicare Num. - the Medicare number.

e Savings Acct. - a flag indicating whether the client has a separate savings account (used for information only).
e Birthplace - used to track the client's place of birth. This may be useful as a Social Security identifier.

e Mother's Maiden - used to track the maiden name of the client's mother. This may be useful as a Social Security
identifier.

e Father's Name - used to track the name of the client's father. This may be useful as a Social Security identifier.
o Referral Source - select a value from the list (List Maintenance > Referral Source).

o Referral Date - used to track the referral date.

e Term. Reason - select a value from the list (List Maintenance > Termination Reason).

e Term. Date - used to track the termination date.
e Death Date - used to track the date of the client's death, if applicable.
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County - select a value from the list (List Maintenance > County).

Ward Number - select a value from the list (List Maintenance > Ward Number).

County District - select a value from the list (List Maintenance > County District).
Legislative District - select a value from the list (List Maintenance > Legislative District).

Statement Notes - used to enter notes to print on client statement reports. The Text Formatting section of the
ribbon menu can be used to format the statement notes (bold, underline, italics, highlight, etc.).

Routing Number - routing number for XEFT transactions paid to the client.

Account Number - bank account number for XEFT transactions paid to the client.
** To validate the routing and account number, a $0 XEFT transaction can be entered using Enter
Payment on the Transactions screen to send a pre-note transaction for a client. **

Account Type - checking or savings account.
RPM Client ID - system-generated unique client ID.
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Schedule Payments Tab

IE  Representative Payee Manager - - a X
File RPM
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(5] Dashboard X [3] Clients X X
Close | New | Graph | Urgent Notes | Client Account Balances 01/20/2025 Total Less Min. &
- = Checking: Mass $1,606.73 | $1,606.73 | S1,50673 @  Filterstatus ® Active Cinactive € All
SelectClient [Abbott, Lisa Andred] ¥ |savings: Individual $2,960.00 | $2,960.00 | $2,860.00 v Filter SupportType © All € sSelected |Individual Accts i
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X |View Trans [Checking: Mass v |Utility v | |water ~ |Monthly ~ T |Hillside Apartments  ~ [1 v [Print < | TEN T $28.00 $0.00 | 0z
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The Schedule Pmts tab is used to schedule recurring payments for a client. Transactions can be created for
scheduled payments using the Process Payments screen.

Click the + button to add a new row.

Click the X button on a row to delete that row. Use the "End Now" button to deactivate a scheduled payment instead
of deleting it.

Click View Trans to see existing transactions that have been processed for the scheduled payment.

Scheduled payments can be displayed on 1 or 2 lines. The 2-line option will include these additional items:
e Audit Rpt button beneath the View Trans button.

¢ "Remaining Balance" field for any payments with a "Total Due" entered.

e Day of the week under the "Next Payment" date.

e 2 lines of information for the larger entry fields.

e End Now button under the "End Date" to immediately inactivate the scheduled payment.

Changes and deletions will be logged in the audit events. Click Audit Rpt to see any changes made to the displayed
scheduled transaction. Use the reports in the "Audit" section on the Reports screen to see changes made to all
scheduled transactions.

Fields are explained below.

e Account - select the account. This defaults to the client's default account.

e Category - select a category from the list (List Maintenance > Payment Category).

e Subcategory - select an optional subcategory from the list (List Maintenance > Subcategory).

e Frequency - select the frequency. When a scheduled payment is processed, the next scheduled payment date
will be automatically updated based on the frequency. See details for the available frequencies in the Transaction

Frequency topic.
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Pay To Client - select this to make a payment to the client. A transaction can be paid to either a client or a
vendor.

Pay To Vendor - select the vendor for a payment to a vendor. Vendors can be added on the Vendors screen.

Vendor Address - select the vendor address. If the vendor has only one address, it will be used by default. If the
vendor has more than one address, select the address to use. Leave the selection blank if no address is needed.

Payment Method - select a value from the list. Select "Print" if you want a check to print. The other payment
methods will add a transaction to the register without printing a check. See details for the available payment
methods in the Payment Methods topic. Set the default payment method for a vendor on the Vendors screen. Set
the default for payments to clients on the System Settings tab on the System Setup screen.

Mail to Client Addr. - select this to print the client's mailing address on a check.

e For a check paid to a vendor, the client's mailing address will print on the check instead of the vendor's
address. Use this to mail a check that is paid to a vendor directly to a client. Set the default for a vendor on
the Vendors screen.

e For checks paid to clients, select this to print the client's mailing address on the check. If this is not selected,
no mailing address will print on the check. Use this to separate checks that will be mailed to a client from
those that will be picked up by the client. You can set the default "Mail to Client Address" option on the
System Settings tab on the System Setup screen.

Batch Pmt. - select this to batch the payment (to print multiple transactions on a single check or export multiple
transactions as a single XEFT). This will group all payments to a vendor in the same account and for the same
date on a single check or XEFT. Select "Batch Pmt." for client payments to print a single check or export a single
XEFT to a client for more than one category. This option defaults to checked for "Print" and "XEFT" payment
methods if the selected vendor is marked as "Batch Payments" on the Vendors screen and the client type is
marked as "Batch Payment" in List Maintenance > Client Type. Check or remove this option for any scheduled
payments manually.

Verify Each Pmt. and Ver. (Verified) - select "Verify Each Pmt." if each instance of the payment needs to be
verified before it can be processed. Select this option, for example, for a payment amount that varies each
month, such as a utility payment. When the bill is received each month, enter the current amount and click "Ver."
to mark the payment as verified. The payment will then be available to be processed. Once a verified payment
has been processed, the "Ver." option will be removed, and the payment must be verified again before the next
occurrence can be processed. Set the default for a vendor on the Vendors screen. The "Ver." box will be
highlighted in green if the payment requires verification but has not been verified.

Rcpt. Req. - select this if a receipt is required after the payment is processed. Mark the receipt as received on
the Transaction Detail screen. View transactions requiring a receipt not yet received on the Reports screen under
Transactions > Receipt Required Not Received.

Payment Amount - the monetary amount of the payment. If this varies, the amount can be updated before
processing the payment.

Total Due - use this amount if the client owes a total and will make payments until the total is paid. For example,
if the client owes $1,000 and the vendor has agreed to payments of $100 per month, enter a "Payment Amount"
of $100 and a "Total Due" of $1,000.

Remaining Balance - this only applies if a "Total Due" has been entered. The "Remaining Balance" is
automatically calculated when payments are processed.

Next Payment - enter the next date the payment should be processed. Once a payment is processed, the next
payment date will be automatically updated based on the selected frequency. This date can be changed if the
payment schedule changes.

End Date - enter an end date if the payment should end after a certain date. Leave the date blank to continue the
payment indefinitely. If a "Total Due" has been entered for the payment, the end date will be automatically
calculated and cannot be changed.

End Now - use this button to immediately end the scheduled payment before the next payment date. This will
inactivate the scheduled payment.

Sort by Client - select this to sort a check paid to a vendor by the client's name instead of the vendor's name
when printing the check. Set the default for a vendor on the Vendors screen.
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e Check Memo - enter the memo to be printed on the check. This defaults to the client's name and the payment
category.

e Notes - notes about this scheduled payment. Notes are included on some reports but will not print on a check.

e Start Date - defaults to the date the scheduled payment is entered, but can be changed. This is for informational
purposes only.

e User ID - the user who entered or updated this scheduled payment. This will be automatically filled in by the
system.

e Last Updated - the date and time the scheduled payment was last updated. This will be automatically filled in by
the system.

Quick Projected Balance

This is used to quickly see the client's projected balance for upcoming scheduled transactions, including payments,
deposits, and transfers. Use the "Select Account" list to select an account other than the client's default account. The
"Thru Date" defaults to the last day of the current month but can be changed to another date. Click Calculate to see
the projected balance for the upcoming scheduled transactions through the selected date.

To see scheduled payments that are no longer active, select the "Inactive” option under "Filter Payments.” Otherwise,
only active payments display. An active payment is any payment that has a "Next Payment" date and is assigned to
an active mass or individual account.

To see any active payments that need to be verified before processing, select the "Active Unverified" option under
"Filter Payments."
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Payment Methods

The following payment methods are available:

e ATM/Cash - an ATM transaction or cash given to the client.

e Check - a check that has been printed in RPM.

e Credit Card - a transaction made using a credit card.

e Debit - a debit transaction. This is most often used for an adjustment, such as a bank fee.
e Debit Card - a transaction made using a debit card.

e Deposit - a deposit transaction.

e EFT - an electronic transaction. This is most often used for payments that are automatically withdrawn from
an account.

e Export Transfer — a transfer transaction that can be exported to a file using the Export XEFT Transactions
screen.

¢ Manual Check - a manually entered check. This is most often used for any handwritten checks or for entering
past checks when converting from another system.

e Print - a check that is ready to be printed.

e Transfer - transfers between clients and/or categories within the same account. There is no actual bank
transaction for this.

e Transfer In - the deposit transaction for a transfer between different bank accounts. The accounts can be for
the same client or different clients.

e Transfer Out - the payment transaction for a transfer between different bank accounts. The accounts can be
for the same client or different clients.

e XEFT - an electronic transaction that can be exported to a file using the Export XEFT Transactions screen.
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Transaction Frequency

The following frequencies for scheduled transactions are available:

e One-Time - one time only.
e Daily - every day.
o Weekly - every week. The transaction will occur on the same day each week—for example, every Monday.

o Weekly Exclude 5th - every week for the first 4 weeks of a given month. The transaction will occur on the
same day of the week. If the month has a 5th week, that week will be skipped.

e BiWeekly - every other week. The transaction will occur on the same day every other week—for example,
every other Monday.

e Monthly - every month. The transaction will occur on the same date every month—for example, the tenth day
of every month.

e Monthly 1st Week - every month. The transaction will occur on the 1st occurrence of the same day of the
week each month—for example, the 1st Wednesday of each month.

e Monthly 2nd Week - every month. The transaction will occur on the 2nd occurrence of the same day of the
week each month—for example, the 2nd Wednesday of each month.

¢ Monthly 3rd Week - every month. The transaction will occur on the 3rd occurrence of the same day of the
week each month—for example, the 3rd Wednesday of each month.

¢ Monthly 4th Week - every month. The transaction will occur on the 4th occurrence of the same day of the
week each month—for example, the 4th Wednesday of each month.

¢ Monthly 5th Week - every month. The transaction will occur on the 5th occurrence of the same day of the
week each month—for example, the 5th Wednesday of each month. Not every month will have a 5th week, so
some months will be skipped.

¢ BiMonthly - every other month. The transaction will occur on the same date every other month.
e Quarterly - every three months. The transaction will occur on the same date every three months.
e SemiAnnually - every six months. The transaction will occur on the same date every six months.
¢ Annually - every year. The transaction will occur on the same date every year.

¢ BiAnnually - every other year. The transaction will occur on the same date every other year.
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The Schedule Deps tab is used to schedule recurring deposits for a client. Transactions can be created for scheduled
deposits using the Process Deposits screen.

Click the + button to add a new row.

Click the X button on a row to delete that row. Use the "End Now" button to deactivate a scheduled deposit instead of
deleting it.

Click View Trans to see existing transactions that have been processed for the scheduled deposit.

Changes and deletions will be logged in the audit events. Click Audit Rpt to see any changes made to the displayed
scheduled transaction. Use the reports in the "Audit" section on the Reports screen to see changes made to all
scheduled transactions.

Fields are explained below.

e Account - select the account. This defaults to the client's default account.

e Category - select a category from the list (List Maintenance > Deposit Category).

e Subcategory - select an optional subcategory from the list (List Maintenance > Subcategory).

e Frequency - select the frequency. When a scheduled deposit is processed, the next scheduled deposit date will
be automatically updated based on the frequency. See details for the available frequencies in the Transaction
Frequency topic.

e Deposit Amount - the monetary amount of the deposit. If this varies, the amount can be updated before
processing the deposit.

¢ Next Deposit - enter the next date the deposit should be processed. Once a deposit is processed, the next
deposit date will be automatically updated based on the selected frequency. This date can be changed if the
deposit schedule changes.

e End Date - enter an end date if the deposit should end after a certain date. Leave the date blank to continue the
deposit indefinitely.
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e End Now - use this button to immediately end the scheduled deposit before the next deposit date. This will
inactivate the scheduled deposit.

e Notes - notes about this scheduled deposit.

e Start Date - defaults to the date the scheduled deposit is entered, but can be changed. This is for informational
purposes only.

e User ID - the user who entered or updated this scheduled deposit. This will be automatically filled in by the
system.

e Last Updated - the date and time the scheduled deposit was last updated. This will be automatically filled in by
the system.

To see scheduled deposits that are no longer active, click the option "Show Inactive Scheduled Deposits." Otherwise,
only active deposits display. An active deposit is any deposit that has a "Next Deposit" date and is assigned to an
active mass or individual account.
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The Schedule Xfer tab is used to schedule recurring transfers for a client. Transactions can be created for scheduled
transfers using the Process Transfers screen.

Click the + button to add a new scheduled transfer.

Click the X button on a row to delete that scheduled transfer. Use the "End Now" button to deactivate a scheduled
transfer instead of deleting it.

Click View Trans to see existing transactions that have been processed for the scheduled transfer.

Changes and deletions will be logged in the audit events. Click Audit Rpt to see any changes made to the displayed
scheduled transaction. Use the reports in the "Audit" section on the Reports screen to see changes made to all
scheduled transactions.

Fields are explained below.
e "From" Client - the client from whom the money will be transferred.
e "To" Client - select the client who will receive the transferred money.

e "From" Account - select the account from which the money will be transferred. This defaults to the client's
default account.

e "To" Account - select the account into which the money will be transferred.

e "From" Category - select a category from the list (List Maintenance > Payment Category or Deposit Category)
for the outgoing side of the transfer. For transfers between different accounts belonging to the same client, the
"From Category" and "To Category" will default to "Xfer."

e "To" Category - select a category from the list (List Maintenance > Payment Category or Deposit Category) for
the incoming side of the transfer. For transfers between different accounts belonging to the same client, the
"From Category" and "To Category" will default to "Xfer."

e "From" Subcategory - select an optional subcategory from the list (List Maintenance > Subcategory) for the
outgoing side of the transfer.
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e "To" Subcategory - select an optional subcategory from the list (List Maintenance > Subcategory) for the
incoming side of the transfer.

e Frequency - select the frequency. When a scheduled transfer is processed, the next scheduled transfer date will

be automatically updated based on the frequency. See details for the available frequencies in the Transaction

Frequency topic.

e Payment Method - select from the available payment methods. For transfers within the same account, the
payment method defaults to "Transfer" and cannot be changed.

e Transfer Amount - the monetary amount of the transfer. If this varies, the amount can be updated before
processing the transfer.

e Next Transfer - enter the next date the transfer should be processed. Once a transfer is processed, the next
transfer date will be automatically updated based on the selected frequency. This date can be changed if the
transfer schedule changes.

e End Date - enter an end date if the transfer should end after a certain date. Leave the date blank to continue the

transfer indefinitely.

e End Now - use this button to immediately end the scheduled transfer before the next transfer date. This will
inactivate the scheduled transfer.

e Notes - notes about this scheduled transfer. This defaults to the "from"/"to" client and "from"/"to" account.

e Start Date - defaults to the date the scheduled transfer is entered, but can be changed. This is for informational

purposes only.

e User ID - the user who entered or updated this scheduled transfer. This will be automatically filled in by the
system.

e Last Updated - the date and time the scheduled transfer was last updated. This will be automatically filled in by

the system.

To see scheduled transfers that are no longer active, click the option "Show Inactive Scheduled Transfers."
Otherwise, only active transfers display. An active transfer is any transfer that has a "Next Transfer" date and is
assigned to an active mass or individual account.

Transfers between different clients can only be updated under the "from" client's screen. By default, only transactions

from the current client display. In the "Filter Transfers" section, select "To this client" to view transfers to this client.
The transfer displays as view-only on the "to" client's screen; click Edit to go directly to that transfer on another
client's record.
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The View Trans tab is used for viewing client transactions. If the client has more than one account, use the "Select

Account" list to select another account. All data on this tab is read-only.

Click Details to the left of a transaction to view the detailed information for that transaction. With the appropriate
security rights, transactions can be edited, deleted, or voided from the Transaction Detail screen.
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The Budget tab is used for entering a monthly budget for a client.

Click the + button to add a new row.
Click the X button on a row to delete that row.

Fields are explained below.

Monthly Income - used for tracking budgeted income sources for a client.

e Category - select a category for each source of income. The values in the "Category" list can be maintained
in List Maintenance > Deposit Category.

e Subcategory - select an optional subcategory for each source of income, if applicable. The values in the

"Subcategory" list can be maintained in List Maintenance > Subcategory.

e Amount - enter a monetary amount for the budgeted income. This is not used for any actual transactions.

The budget can be compared to actual deposits on the Reports screen under Transactions By Client > Actual

Vs. Budget Totals.

e From - the source of the budgeted income. This field is optional.

e Income Notes - notes about the income source. This field is optional. Click Notes to expand this field into a
larger box for entry or viewing.

e User ID - the user who entered or updated this income budget record. This will be automatically filled in by

the system.

e Last Updated - the date and time the income budget record was last updated. This will be automatically filled

in by the system.

e Total Monthly Income - the total monetary amount of all income categories listed above. This is

automatically calculated.
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Monthly Expenses - used for tracking budgeted expense categories for a client.

Category - select a category for each type of expense. The values in the "Category" list can be maintained in
List Maintenance > Payment Category.

Subcategory - select an optional subcategory for each type of expense, if applicable. The values in the
"Subcategory" list can be maintained in List Maintenance > Subcategory.

Amount - enter a monetary amount for the budgeted expense. This is not used for any actual transactions.
The budget can be compared to actual payments on the Reports screen under Transactions By Client >
Actual Vs. Budget Totals.

Pay To - the recipient of the budgeted expense. This field is optional.

Expense Notes - notes about the expense. This field is optional. Click Notes to expand this field into a larger
box for entry or viewing.

User ID - the user who entered or updated this expense budget record. This will be automatically filled in by
the system.

Last Updated - the date and time the expense budget record was last updated. This will be automatically
filled in by the system.

Total Monthly Expenses - the total monetary amount of all expense categories listed above. This is
automatically calculated.

Difference - the difference between the total monthly income and total monthly expenses. This is
automatically calculated.
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The Housing tab is used for entering housing and roommate details for a client.

Click the + button to add a new row.
Click the X button on a row to delete that row.

Fields are explained below.

Housing - used for tracking housing changes for a client.

e Start Date - the first date of the client's residence at this location (or, if not available, the client's enroliment
date at your company).

e End Date - the last date of the client's residence at this location. This field is optional.

e Type - select a "Type" for each housing record. The values in the "Type" list can be maintained in List
Maintenance > Housing Type.

¢ Address - enter an address for the housing record in the "Address," "ZIP," "City," and "St" fields. Typing the
ZIP code first will automatically fill in the city and state.

e Housing Notes - enter any notes about this housing record. Click Notes to expand this field into a larger box
for entry or viewing.

e User ID - the user who entered or updated this housing record. This will be automatically filled in by the
system.

e Last Updated - the date and time the housing record was last updated. This will be automatically filled in by
the system.

Roommates - used for tracking a client's roommate(s).
¢ Roommate Name - enter the roommate's name.

e Contact Name - enter the name of a contact associated with this roommate, such as their representative
payee.
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Email - enter an email address associated with the roommate or contact. If an address is entered, emails can
be sent to this address by clicking the envelope button to the right of the "Email” field.

Roommate Notes - enter any notes about the roommate, such as the division of housing expenses. Click
Notes to expand this field into a larger box for entry or viewing.

User ID - the user who entered or updated this roommate record. This will be automatically filled in by the
system.

Last Updated - the date and time the roommate record was last updated. This will be automatically filled in
by the system.
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The Employment tab is used for entering employment details for a client.

Click the + button to add a new row.
Click the X button on a row to delete that row.

Fields are explained below.

e Start Date - the first date of the client's employment in this position (or, if not available, the client's enrollment

date at your company).

Num Lock  Powered by Microsoft Access

e End Date - the end date of the client's employment in this position. This field is optional.

e Employment Description - enter a description of the job.

e Employment Notes - enter any notes. To view the entirety of the notes for an employment entry, click the Notes

button on the right.

e User ID - the user who entered or updated this employment record. This will be automatically filled in by the

system.

e Last Updated - the date and time the employment record was last updated. This will be automatically filled in by

the system.
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The Impairments tab is used for entering a client's impairments.

Click the + button to add a new row.
Click the X button on a row to delete that row.
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Select the appropriate impairment from the list. If applicable, select an impairment category. The list of valid values for
impairments and impairment categories can be maintained in List Maintenance > Impairment.
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The Events tab can be used to track both scheduled and completed events. The Event Listing By Date report can be
used to print a list of clients with a selected event in a date range.

Click the + button to add a new row.
Click the X button on a row to delete that row.

Fields are explained below.

e Date - the date an event is scheduled for or was completed.
e Type - the type of event (List Maintenance > Event).

e Category - a category of the selected type of event. The category is optional.
e Event Notes - enter any notes about the event. To view the entirety of the notes for an event entry, click the

Notes button on the right.
e Complete - check to mark the event complete.

e User ID - the user who entered or updated this event record. This will be automatically filled in by the system.
e Last Updated - the date and time the event record was last updated. This will be automatically filled in by the

system.
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Case Notes Tab
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The Case Notes tab is used for entering case notes for a client.

The "Case Notes Overview" section on the right side of the screen allows you to read the detailed case notes. Click
Hide or Show to turn the overview display off or on.

Click the + button to add a new row.
Click the X button on a row to delete that row.

By default, case notes can only be edited or deleted by the user who entered them. To allow users to edit and/or
delete case notes entered by someone else, manage user security settings on the Users screen. Any user with rights
to update case notes can remove the "Urgent” flag on any case note.

Changes and deletions will be logged in the audit events. Click Audit Rpt to see any changes made to the displayed
case note. Use the reports in the "Audit" section on the Reports screen to see changes made to all case notes.

Fields are explained below.
e Date - the date of the contact with the client.
e First-Rpt - select whether this is the first contact or a repeat occurrence of the contact.

e Sv. Unit - enter the service units associated with this contact. Define your own meaning behind the service unit
values.

e Contact Type - select a value from the list (List Maintenance > Case Notes Contact Type).

e Case Note - enter any notes. Click Notes to expand this field into a larger box for entry or viewing. The Text
Formatting section of the ribbon menu can be used for information entered in the case note text (bold, underline,
italics, highlight, etc.).

e Urgent - check this to mark the case note urgent. Use the "Filter Notes" option to display all case notes or only
urgent case notes. If the client has any urgent case notes, an Urgent Notes button is displayed in red at the top
of the Clients screen, regardless of the selected tab. Click the button to view those urgent case notes.

e User ID - the user who entered this case note. This will be automatically filled in by the system.
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e Last Updated - the date and time the case note was last updated. This will be automatically filled in by the
system.

Click Spell Check to check the spelling within the current case note. Spell Check functionality comes from Microsoft
Office. Spell Check will be available if you are using the same version of Office as the Access runtime version you are
using for RPM.
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Notes Tab
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The Notes tab is used for entering notes for a client. This is recommended for general notes not related to a specific

date. Use the Case Notes tab for date-specific notes on which reports can be run. Notes are limited to 65,536
characters.

Enter new notes in the top box and use Add to add the notes to the existing notes. The current date, time, and user
ID will be automatically added with the notes.

Click Edit to edit any existing notes.

The Text Formatting section of the ribbon menu can be used for information entered in the notes (bold, underline,
italics, highlight, etc.). Formatting will add to the number of characters used.

Click Spell Check to check the spelling within the entered notes. Spell Check functionality comes from Microsoft

Office. Spell Check will be available if you are using the same version of Office as the Access runtime version you are

using for RPM.
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The Contacts tab is used for entering a client's contacts.

Click the + button to add a new row.
Click the X button on a row to delete that row.

Select a "Contact Type" and enter information for the contact. The contact types can be maintained in List
Maintenance > Client Contact Type.

Check the "Mail Statement" box to mail the Client Statement (Window Envelope) report to the contact's mailing
address.
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The Photo tab is used to display a client photo.

Click Select Photo to select the client photo that you wish to use. Other users will only be able to view the photo if it is
in a network location accessible to all users. Click Remove Photo to remove the photo.
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Documents Tab
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The Documents tab is used to link client documents. The documents themselves are NOT stored in RPM—only a link
to the document is stored in RPM.

Click the + button to add a new row.
Click the X button on a row to delete the link. This will not delete the actual document.

Fields and buttons are explained below.
e Document Description - a brief description of the document.

e Link Type - select "Doc" to link a document located on your computer or network. Select "Web" to enter a link to
a website or online document.

e Document Location/Web Link - displays the linked document name and location when "Doc" is selected for the
"Link Type." When "Web" is selected for the "Link Type," enter the website or link to an online document in this
field.

e Select File - used to locate a document on your computer or network. This is only available when "Doc" is
selected for the "Link Type." Other users will only be able to access the documents if they are in a network
location accessible to all users. The documents should be stored using a mapped drive, such as F:\RPM
Documents, and not a specific UNC path, such as \Server\RPM Documents. If the UNC path changes in the
future, there is no way to automatically update the document location to the new path. A drive mapping can
remain the same regardless of the server name.

e View - used to open a document or web link. Not all types of documents can be opened using View. Documents
can be opened either as a Hyperlink or with OLE (Object Linking and Embedding). If there are problems opening
documents with one option, try the other option.

e User ID - the user who entered or updated this record. This will be automatically filled in by the system.

e Last Updated - the date and time the document was last updated. This will be automatically filled in by the
system.
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The Test Scores tab is used to enter client test scores.

Click the + button to add a new row.
Click the X button on a row to delete that row.

To enter a test the client has taken, select a "Test Type" from the list. The list of test types can be maintained in List
Maintenance > Test Type. Enter the date of the test in the "Test Date" and the score achieved in the "Test Score."

If a test has categories, scores can be entered for the individual categories. The scores for each category will be
automatically added together to fill in the total "Score" for that test. Click Fill to create a record for each category of
the selected test, or select categories and enter scores individually.
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The Custom tab is used to enter custom information for a client.
Custom fields can be configured on the Custom Client Fields tab on the System Setup screen.

Fields are explained below.
e Custom Dates - values can be entered for up to 10 custom dates.
e Custom Text - values can be entered for up to 10 custom text fields.

e Custom Lists - values can be entered for up to 10 custom lists. The values in the Custom Lists can be
maintained in List Maintenance > Custom List 1-10.
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The Assets tab allows you to keep track of assets other than checking accounts. The list of asset types can be
maintained in List Maintenance, Asset Type.

Click the + button to add a new row.
Click the X button on a row to delete that row.

Fields are explained below.

e Date - the date for this asset transaction.

¢ Amount - the amount for this asset transaction (this can be positive or negative).

e Description - a description for this transaction.

User ID - the user who entered or updated this asset record. This will be automatically filled in by the system.

Last Updated - the date and time the asset record was last updated. This will be automatically filled in by the
system.
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Click Claim #s on the Basic tab of the Clients screen to open the Claim Numbers screen. Use this to enter one or
more claim numbers for the client. You'll only need this if you import an electronic deposit file from your bank using
the Import ACH Deposits screen. When deposit transactions are imported, the system matches the SSN or claim
number from each deposit to the SSN or claim number(s) entered in RPM. If a match is found, a deposit transaction
will be created for the matching client.

Click the + button to add a new row.
Click the X button on a row to delete that row.
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Select Vendors from the View menu to open the Vendors screen.

The Vendors screen lets you view and maintain information about vendors. Vendors should include anyone to whom
payments will be made other than the clients. Transactions can be paid directly to clients. Clients do NOT need
to be entered as vendors.

Use the "Select Vendor" list to find the record for an existing vendor.

The "Filter Vendors" options allow you to see active, inactive, or all vendors. To view all vendors (active and inactive),
click the All option.

By default, vendors are sorted alphabetically by name. To change the sorting, right-click in the field you wish to sort
and select "Sort A to Z" or "Sort Z to A" from the Shortcut menu.

To add a vendor, click New.
To delete a vendor, click Delete. Vendors with transactions cannot be deleted.

If you are no longer using a vendor, click the "Inactive" checkbox to mark the vendor inactive. Vendors can only be
marked inactive if there are no active scheduled payments assigned to them. Once a vendor has been marked
inactive, no additional transactions can be created for them. Existing transactions can still be viewed.

Click the Mail button next to the email address(es) to start an email message using your default email application.
This functionality may not be available for all email applications, but it should work with Outlook.

If multiple email addresses are entered for one vendor, separate them with semicolons.

Click Total to display the total monetary amount of all transactions paid to this vendor. Click View Trans to display the
transactions for this vendor.
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Account Information for XEFT Transactions

This information will be used for transactions to the vendor using the XEFT payment method.
e Routing Number - routing number.

e Account Number - bank account number.

e Account Type - checking or savings account.

e RPM Client ID - system-generated unique vendor ID.

** To validate the routing and account numbers, a $0 XEFT transaction can be entered using Enter Payment
on the Transactions screen to send a pre-note transaction for a vendor. **

Transaction Defaults

Default options can be set for each vendor in the "Transaction Defaults" section. Details for the options are below.
Changes to the default options for a vendor will only apply to scheduled or manually entered payments that
are entered after the change. Existing scheduled payments for the vendor will not be updated. Use the Update
Scheduled Payments screen to make changes to existing scheduled payments.

e Payment Method - select the default payment method. See details for the available payment methods in the
Payment Methods topic. Set the default for new vendors on the System Settings tab on the System Setup
screen.

e Mail To Client Addr. - select this to default payments to use the client's name and address for the "mail to"
information instead of the vendor's name and address.

e Batch Payments - select this to default payments as batch payments. This will print multiple transactions on a
single check or export multiple transactions as a single XEFT, as long as they are for the same vendor, in the
same bank account, and on the same date.

e Verify Each Pmt. - select this to require each instance of a scheduled payment to be verified before processing.
This is useful if the monetary amount varies by payment, like for a monthly utility payment. When you receive the
actual bill each month, enter the current amount and select "Verified." The payment will then be available to be
processed. Once a verified scheduled payment has been processed, the "Verified" option will be removed, and
the payment must be verified again before the next occurrence can be processed.

e Sort By Client - select this to default payments to sort by the client's name instead of the vendor's name when
printing a check. Set the default to "Sort Checks by Client Name" on the System Settings tab on the System
Setup screen. Do not use this option if you want to batch payments to a vendor for all clients in a mass account.

Addresses

Multiple addresses can be added for each vendor. If a vendor has more than one address, you will be able to select
the address to use for a transaction after selecting the vendor. If a vendor has only one address, that address will be
used by default.

Click the + button to add a new address.

Click the X button on a row to delete that address.

Click the up or down arrow next to an address to reorder the address list.

Click the Envelope button next to an address to print an envelope to that address.
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Merge Vendors

s Representative Payee Manager - a X
File RPM
Backup/Restore ~ - e i N = Client S > o F P Find Y Filter 5| Ascending @ Help
Fo] & 70 B =] o PR .
Import/Export ¥ : ) - Setup v - Y Selection~ £ Descending 1 System Info
Dashboard Clients Transactions Vendors Reconcile List . Reports Users Change  User 5 >
Maintenance Transaction v Boiviid Sitna Y Toggle Filter €7 Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help A~
Dashboard Vendors X -3 Vendor Merge
Close
“Merge To Vendor
Vendor Name |ABC Payee
Phone Batch Routing Number Account Number AccountType Notes
V111111118 987654321 Checking
Duplicate Vendors
Phone Batch Routing Number Account Number AccountType Notes Inactive
P[ merge [[(555) 625-8686 r [checking =
Duplicate Vend... 4+ [1of 1 » Search

Use this screen to combine vendors with the same name into a single vendor record.

Click "Merge" for each duplicate you wish to merge into the main vendor displayed in the Merge To Vendor section. Any addresses under the
duplicate vendor will be added to the merged vendor record.

Existing scheduled payments will continue to use the same address as before the merge. The duplicate vendor will be deleted, including the phone,

batch, routing and account numbers, and notes.

Num Lock  Powered by Microsoft Access  Filtered

Vendor Name

If there are multiple vendors entered with the same name, they can be combined into a single vendor record. To
combine records for similar but not identical vendor names, change the name first to an identical name.

Select one of the vendors with the same name and then click Merge to see the duplicate vendors. Click Merge for
each of the duplicate vendors to be merged into the original vendor. Any addresses under the duplicate vendor will be
added to the merged vendor record. Existing scheduled payments will continue to use the same address that was
used before the merge. The duplicate vendor will be deleted, including the phone number, routing and account

numbers, and notes.

Review possible duplicate or unused vendors on the Reports screen under Vendor > Vendor List with Transaction
Counts.
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View Vendor Transactions

s Representative Payee Manager - a X
File RPM
Backup/Restore ~ @ ..‘ \o. Z_‘] E =) Client ~ ‘E" :‘5& E }3 Find @ Help
e ot o Grants Tafca cions Vehdors Resoncie T Reports Use: Change  User > Al
Maintenance Transaction ¥ Password Settings £ Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help A~
Dashboard *| Vendors X [-3| View Vendor Transactions X X
Close
[aTar
Sort by Receipt ﬁ
Date Pmt. Method Check # Amount Category Client Pay To Void Batch Client Rec. Exp. Req. Revd. Check Memo Use |
»| 01/15/2024 |Check 7184-0001 $45.00 |Phone /Abbott, Lisa A AT&T rF r I " T |Abbott, Lisa A - acct 789754564 adn
01/15/2024 |Check 7184-0002 $47.00 |Phone Baker, Mark L AT&T r ~ r I I T |Baker, MarkL-Phone adn
01/15/2024 |Check 7184-0003 $35.00 |Phone Crawford, Barbara J AT&T r v r T I T |crawford, BarbaraJ- Phone adn
01/15/2024 |Check 7184-0004 $51.00 |Phone Davidson, Linda AT&T r v r T I I |pavidson, Linda- Phone adn
01/15/2024 |Check 7184-0005 $47.00 |Phone Roberts, James A AT&T rF r ™ I I |Roberts, James A - Phone adn
01/15/2024 |Check 3790 $38.00 |Phone 'Young, Michael D AT&T 3R T I I T |Young, Michael D- Phone adn
01/15/2024 |Check 2755 $45.00 |Phone Smith-Jones, Cathy AT&T =T r I I T |[Smith, Cathy - acct 81324555 adn
01/15/2024 |Check 2662 $40.00 |Phone Williams, Ann L AT&T N r I I I |williams, Ann L- Phone adn
12/15/2023 |Check 7148-0001 $45.00 |Phone /Abbott, Lisa A AT&T -V T R ' TI" I |Abbott, Lisa A - acct 789754564 Adn
12/15/2023 [Check 7148-0002 $47.00 |Phone Baker, Mark L AT&T r ~ r R I I T |Baker, MarkL- Phone Adn
12/15/2023 [Check 7148-0003 $35.00 |Phone Crawford, Barbara J AT&T r ~ r R [T I I |crawford, BarbaraJl- Phone Adn
12/15/2023 [Check 7148-0004 $51.00 |Phone Davidson, Linda AT&T r v r R I' I' T |pavidson, Linda-Phone Adn
12/15/2023 |Check 7148-0005 $47.00 |Phone Roberts, James A AT&T B R " T" I |Roberts, James A - Phone Adn
12/15/2023 [Check 3776 $38.00 |Phone 'Young, Michael D AT&T =T r R I I' T |Young Michael D-Phone Adn
12/15/2023 [Check 2741 $45.00 |Phone Smith-Jones, Cathy AT&T B r R [T T I [smith, Cathy - acct 81324555 Adn
12/15/2023 [Check 2648 $40.00 |Phone Williams, Ann L AT&T B N r R I I' I |williams, AnnL- Phone Adn
11/15/2023 [Check 7118-0001 $45.00 |Phone /Abbott, Lisa A AT&T r v R ' TI" I |Abbott, Lisa A - acct 789754564 Adn
11/15/2022 ICheck 71120002 44700 Iphane Raker Mark | ATRT C & r R [ [ [ Ipaker Markl.Dhone Adn
Total|  $39,156.00 ]
| Transaction 14« [10f872 | » » Search [«I 0]

Vendor

Num Lock

Powered by Microsoft Access

The View Vendor Transactions screen is used to view all transactions that exist in the system for the current vendor.

Select View Trans on the Vendors screen to see these transactions.

Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support

types are assigned to your user ID, you will only be able to view transactions for those types of clients. If client types
or support types have NOT been assigned to your user ID, you will be able to view transactions for all clients. "Access
Limited to assigned Client Types and/or Support Types" displays at the top of the screen if your user ID has been set

up for client and/or support type filtering.
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Transactions

KB  Representative Payee Manager - a X
File RPM
Backup/Restore ¥ f’JD ;Q [ﬁ E,‘ﬁ <% Client v :.éy El Qi O Find fj) Help
Import/Export ¥ | pachboard Clients Transactions Vendors Reconcile List ~ Setup~ Reports | Users Change User I save A\ System Info
Maintenance Transaction v Password Settings [ Paste 2 £ Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help ~
[5] Dashboard X m X
Close | Process Pmts I Process Deps Process Xfer | Enter Payment | EnterDeposit | Enter Transfer Print Checks
Select Account |cl\e(kingl ~ I” show Inactive
~Search Criteria
Begin Date End Date Pmt. Method Check # Category Client Pay To
[ 1072272024 | 5 ﬂ] &]
Click "Details" to view, edit, delete, or void a transaction. Sort by Receipt
Date Pmt. Method Check # Amount Category Subcategory Client Pay To Void Batch Client Rec. Exp. Req. Revd. Check Memo
Details | 12/25/2024(Transfer Out $100.00 |Xfer Abbott, LisaAndrea  [TransferToLisaAndrez I 7 T T I I |ToSavings: Indiv
| oetails | 12/24/2022 Deposit $250.00 |Wages Personal grov [Davidson, Linda Fumik [T E wOE
| petails 12/24/2024 |Check 7592 $37.00 |Food Roberts, James Anders{Krager Supermarket m m I] T [T T |Roberts, James ¢
| petails | 12/24/2024|Check 7591 $32.00 |Food Davidson, Linda FumikdKrager Supermarket I T~ T T I T |pavidson, Linda
| Details | 12/24/2024 |Check 7590 $37.00 |Food Baker, Mark Luis SantiafKrager Supermarket B r T I T |Baker,MarkL-F
| oetails | 12/24/2024 [Check 7589 $45.00 |Food Crawford, Barbara Joan|Krager Supermarket - v I I T |crawford, Barbal
| Details | 12/24/2024 |Check 7588 $50.00 |Food Abbott, Lisa Andrea  [Krager Supermarket i v T I T |Abbott, LisaA-F
| petails 12/23/2024 |XEFT XEFT-1173-0001 $55.00 |Spending Crawford, Barbara Joan|Barbara Joanne Crawfo I~ W I Vv ¥ W™ |crawford, Barbal
| petails | 12/23/2024 |XEFT XEFT-1173-0002 $20.00 [Clothing Crawford, Barbara Joan|Barbara Joanne Crawfo I ~ T ¥ T T |crawford, Barbal
| oetails | 12/23/202a |xEFT $50.00 |Spending Holiday Davidson, Linda FumikdLinda Fumiko Davidsor I I T ¥ T T |pavidson, Linda
| oetails | 12/23/2024 |xEFT $50.00 |Spending Roberts, James Anders{James Anderson Rober I~ I m V ¥ ¥ |Roberts, James £
| oetails | 12/23/2024 |xEFT $45.00 |Spending Davidson, Linda FumikdLinda Fumiko Davidson I~ T~ I V ¥ ¥ |pavidson, Linda
| petails 12/23/2024 |XEFT $38.50 |Spending Baker, Mark Luis SantiajMark Luis SantiagoBak ™ I r V¥ ¥ ™ |Baker,MarkL-S
| etails | 12/23/2024[Transfer out $100.00 |Xfer Crawford, Barbara Joan|Transfer To BarbaraJoze I T [T I I T |ToSavings: Indiv
| Details | 12/23/2024 |Check 7587 $55.00 |Spending /Abbott, Lisa Andrea  |Lisa Andrea Abbott W T ¥ ™ |abbott, LisaA-<
Balance | $6,545.91  Total |

Transaction 4 ¢ 360f336  *» »

Select Account

Search

Select Transactions from the View menu to open the Transactions screen.

»

Num Lock  Powered by Microsoft Access

The information on this screen is read-only. To change, delete, or void an existing transaction, click "Details"
to the left of that transaction.

The Transactions screen shows the transaction register for a selected account. Use the "Select Account" dropdown to
view the transaction register for another account. Mass accounts are listed first, followed by individual accounts. Mass
accounts are listed alphabetically by account name. Individual accounts are listed alphabetically by client and account

name.

By default, only active accounts will be shown. To see all accounts, select "Show Inactive."

Use the "Search Criteria" options to search for selected transactions. Enter one or more of the criteria and click
Search to display the transactions matching the criteria. Click Clear to remove all the criteria and display no

transactions. With a large mass account, click Clear prior to processing payments/deposits, entering transactions, or

printing checks to improve processing time.

e Begin Date - enter a date to display transactions on or after, or leave blank for all dates. Set the "Default Number
of Days for Displaying Transactions" on the System Settings tab of the System Setup screen.

e End Date - enter a date to display transactions on or before, or leave blank for all dates.

e Pmt. Method - select a payment method from the list, or leave blank for all payment methods.

e Check # - enter a full or partial check number, or leave blank for all check numbers. Enter "387*" to display all
check numbers beginning with 387. To see all lines for a batch check, enter the check number followed by an

asterisk (*); for example, "3874*".
e Category - select a category from the list, or leave blank for all categories.

e Client - select a client from the list, or leave blank for all categories.
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e Pay To - enter a full or partial "pay to" name, or leave blank for all "pay to" values. Use an asterisk (*) at the
beginning and/or end of the name for a partial match. For example, enter "State*" to display all the pay to names
beginning with State. Enter "*Insurance*" to display all the "pay to" names containing Insurance.

Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support
types are assigned to your user ID, you will only be able to access those types of clients. If client types or support
types have NOT been assigned to your user ID, you will be able to access all clients. "Access Limited to assigned
Client Types and/or Support Types" displays at the top of the screen if your user ID has been set up for client and/or
support type filtering.

By default, the list of transactions is sorted in descending date order with the most recent transactions at the top. To
change the sorting, right-click in the field you wish to sort and select "Sort A to Z" or "Sort Z to A" from the Shortcut
menu.

Check numbers that have a dash are batch checks. The number to the left of the dash is the actual check number,
and the number to the right of the dash is the reference number for that line on the check. Batch XEFT transactions
display a sequence number for the whole transaction, followed by a reference number for each line item. For
example, a batch XEFT to Kroger for $75 might have one $25 payment from A. Shin (displayed as XEFT 99-001) and
one $50 payment from Q. Mijares (displayed as XEFT 99-002).

Click Total to view the current account balance.

50



Process Payments

IE  Representative Payee Manager - - a X
File RPM
Backup/Restore v f"l K 7 i E:‘ﬁ <—l Client ~ 2 El = S Find (@ Help
o L 7 8 B & 85 i s
Import/Export ¥ | pachiboard Clients Transactions Vendors Reconcile List ~ Setup~ Reports | Users Change User A System Info
Maintenance Transaction v Password Settings A £ Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help 52
Dashboard Transactions X [-3] Process Scheduled Payments
Close | Pay All | Report | Click "Reset" to immediately reset processed payments. Reset
Date Range Client/Account Filter Transaction Filter® Negative Balance Check Client Balance
07/19/2024 Thru [ 07/31/2024 & Show All Category v ™ Allow Negative Balance |Baker, Mark L Checking: Mass

 Cclient v
€ Mass Account [Checking v
 Acct. Mgr. v

Frequency & Unverified Payments
Pmt. Method d #Unverified Pmts. 0
Clear Filter r J D

*Click in a field below and use the Filter/Sort menu for additional filtering. a

Balance on 7/29/2024 $1,600.58
Total Account Balance $1,600.58

~Transaction Date
& Next Payment Date

07/19/2024

C OtherDate

Client Method Pay To Category Subcategory Amount Next Payment Frequency Account Check Memo

Pay | Edit | Skip | Bal. |Abbott, Lisa Andrea |Print  |Lisa Andrea Abbott  |Spending $55.00 07/29/2024 |Weekly Checking: Mass Abbott, Lisa A - Spendin
- Pay Edit | Skip | Bal. |Baker, MarkL XEFT Mark L Baker Spending $38.50 07/29/2024 |Weekly Checking: Mass Baker, Mark L - Spendin,
| Pay | Edit | Skip Bal _{Baker, Mark L Print  |Memorial Hospital Medical Pharmacy $25.00 07/29/2024 |Biweekly Checking: Mass Baker, Mark L - Medical
] Pay | Edit | Skip | Bal. |Crawford, BarbaraJi [XEFT Barbara Joanne Crawfi |Spending $55.00 07/29/2024 |Weekly Checking: Mass Crawford, Barbara J - Sp
- Pay Edit | skip | Bal. |Crawford, BarbaraJi |XEFT Barbara Joanne Crawfi |Clothing $20.00 07/29/2024 |Weekly Checking: Mass Crawford, Barbara J - Cl¢
| pay Edit skip | Bal. |Davidson, Linda XEFT  |Linda Davidson Spending $45.00 07/29/2024 |Weekly Checking: Mass Davidson, Linda - Spenc
- Pay Edit | Skip | Bal. JRoberts, James A IXEFT James A Roberts Spending $50.00 07/29/2024 |Weekly Checking: Mass Roberts, James A - Sper
| Pay | edit | skip [ sal. [Smith-Jones, Cathy [XEFT  |Cathy Smith-Jones Spending $50.00 07/29/2024 |Weekly Checking: Individual  |Smith, Cathy - Spending
] Pay | Edit | Skip | Bal. |Smith-Jones, Cathy |XEFT Cathy Smith-Jones Clothing $20.00 07/29/2024 |Weekly Checking: Individual  |Smith, Cathy - Clothing
- Pay | Edit | Skip | Bal. , Ann L Print Ann L Williams Spending $45.00 07/29/2024 |Weekly Checking: Individual  |Williams, Ann L- Spend

Pay | Edit | Skip | Bal. [Young, MichaelD |Print |Michael D Young Spending $40.00 07/29/2024 |Weekly Checking: Individual  |Young, Michael D - Sper

Pay Edit | Skip | Bal. |Zhang, Benjamin EFT Benjamin Zhang Food $80.00 07/29/2024 {Weekly Checking: Individual Zhang, Benjamin - Food

Pay | Edit | skip | Bal. |Abbott, Lisa Andrea |Print  [Kroger Food $50.00 07/30/2024 |Weekly Checking: Mass /Abbott, Lisa A - Food
" pay [ Edit Skip | Bal. |Baker, Mark L Print _ |Kroger Food $37.00 07/30/2024 |Weekly Checking: Mass Baker, MarkL-Food ¥

Payment 4 4 30f21 | » M Search <

Process Scheduled Payments - Display Client Account Balance

Num Lock

Powered by Microsoft Access

The Process Payments screen can be accessed by selecting Process Pmts from the Transactions screen. This is
used to process scheduled payments and add them to the transaction register.

Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support
types are assigned to your user ID, you will only be able to process payments for those types of clients. If client types
or support types have NOT been assigned to your user ID, you will be able to process payments for all clients.
"Access Limited to assigned Client Types and/or Support Types" displays at the top of the screen if your user ID has
been set up for client and/or support type filtering.

Date Range

The screen shows a list of transactions scheduled for payment during the date range you select. The date range
defaults to the date of the earliest unprocessed payment through the current date. Process payments for other dates
by entering a different date range.

Transaction Date

By default, the transactions will be dated on the "Next Payment" date. Use the "Other Date" selection to date the
transactions on a different date. For example, if the "Next Payment" date falls on a holiday or a weekend, use the
"Other Date" option to date the transactions on the day before or the day after the holiday or weekend. Changing the
transaction date does not change the next scheduled payment date.

Client/Account Filter

The "Client/Account Filter" is used to display scheduled payments for all clients, for a selected client, for a selected
mass account, or for clients assigned to a selected account manager. To view transactions for a single client, select
the "Client" filter option and then select the client from the list.
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Transaction Filter

The "Transaction Filter" is used to filter scheduled payments by category, frequency, or payment method. Use the
"Category" list to view payments for a selected category. Use the "Frequency" list to view payments with a selected
frequency. Use the "Pmt. Method" list to view payments for a selected payment method. Click Clear Filter to remove
the "Category," "Frequency," and "Pmt. Method" filters.

Negative Balance Check

Check this option to automatically process payments resulting in a negative balance instead of being prompted for
each. A message displays after the payments are processed showing how many payments, if any, resulted in a
negative balance. This option is only available if the "Negative Balance Check" is set to "Warn" on the System
Setup screen. A user must also have "Update" rights to the "Allow Negative Balance" option on the Users screen.

Unverified Payments

If there are any unverified payments for the selected date range or filter options, the number displays on the screen.
Select "Show Unverified Payments” to view the unverified payments. These cannot be processed until the scheduled
payment is marked as "Verified." Details about payments requiring verification can be found on the Schedule Pmts tab
of the Clients screen.

Pay/Pay All
Click Pay to the left of a payment to process that individual payment. Click Pay All to process all payments shown.
Payments with a payment method of "Print" will be added to the transaction register and can then be printed.

Payments with a payment method of "XEFT" will be added to the transaction register and can then be exported. Other
payment methods will be added to the transaction register with no further processing required.

After the transaction is created, the "Next Payment" date will be updated based on the frequency for that transaction.
If that next calculated pay date is outside of the date range you have selected, the row will disappear after you have
clicked Pay.

Edit

Click Edit if you need to make any changes to the payment before processing. Only users with rights to the Schedule
Pmts tab on the Clients screen will have access to the Edit button.

Changes can be made to groups of scheduled payments on the Update Scheduled Payments screen.

Skip
Click Skip to skip this instance of the scheduled payment. The "Next Payment" date will be updated according to the
scheduled frequency.

Client Current Balance
Click Bal. to display the client's balance on the payment date and total account balance.

Below Minimum

A minimum balance amount can be entered for each client on the Basic tab of the Clients screen. A warning message
displays if a transaction would take the client below their minimum balance.

Negative Balance Warning

If the System Setup options for the "Negative Balance Check" are set to "Warn" for either the "Balance on
Transaction Date" or "Total Account Balance," messages like the following display. Bypass these messages by
checking "Allow Negative Balance" before processing payments.
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7| Process Scheduled Payments X

Ll

The payment for Abbott, Lisa A for $325.00 is greater than the
client’s total account balance of 5216.22,

Are you sure you want their total account balance to be
negative?

=TT T PZTITOUTT U UL ZUZZ VToTIunTy

mlzlcldlmlO

e Select Yes to process the transaction.
e Select No and the transaction will NOT be processed.

e Select Cancel to cancel processing this and any remaining payments. For example, if Pay All was selected
before encountering a potential negative balance, Cancel would cancel the Pay All process.

If No is selected for the balance warning, a message displays for skipping the scheduled payment.

7| Process Scheduled Payments

Ll
I

0 Do you want to skip this scheduled payment?
If you answer Yes, the Next Payment date will be updated to o

the next scheduled occurrence for the payment without this
occurrence being processed.

=TT T PZTIOU U UL ZUZZ [IVTOTIOTy

o] IS 0 S Ol I 3

e Select Yes to skip this payment. The "Next Payment" date will be updated to the next scheduled occurrence for
the payment as if the transaction had been processed. This instance of the payment will not be processed.

e Select No to leave the payment as scheduled. The "Next Payment" date will not be changed, and the payment
will still be displayed on the Process Payments screen after processing payments.

Negative Balance Prevention

If the System Setup options for the "Negative Balance Check" are set to "Prevent" for either the "Balance on
Transaction Date" or "Total Account Balance," a message like the following displays.

| Process Scheduled Payments X 4

L

client’s total account balance of 5216.22 and will not be
processed.

0 The payment for Abbott, Lisa A for $325.00 is greater than the
Do you want to skip this scheduled payment? =
If you answer Yes, the Next Payment date will be updated to

the next scheduled occurrence for the payment without this L
occurrence being processed.

—HAlml=zlcldlml O
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e Select Yes to skip this payment. The "Next Payment" date will be updated to the next scheduled occurrence for
the payment as if the transaction had been processed. This instance of the payment will not be processed.

e Select No to leave the payment as scheduled. The "Next Payment" date will not be changed, and the payment
will still be displayed on the Process Payments screen after processing payments.

e Select Cancel to cancel processing this and any remaining payments. For example, if Pay All was selected
before encountering a potential negative balance, Cancel would cancel the Pay All process.

Click Report to display a report of the scheduled payments currently shown.

Use the Reset button in the upper right of the screen to immediately reset processed payments.
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Process Deposits

IE  Representative Payee Manager - a X
File RPM
Backup/Restore v | v r =T <7 Client ~ |— 2 = S Find (@ Help
: B LY RED G & O 8 , :
Import/Export ¥ | pachiboard Clients Transactions Vendors Reconcile List ~ Setup~ Reports | Users Change User A System Info
Maintenance Transaction v Password Settings £ Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help i
Dashboard Transactions X [-3] Process Scheduled Deposits
Close | Deposit All | Report | Click "Reset" to immediately reset processed deposits. Reset
Date Range Client/Account Filter Transaction Filter® Deposit Ticket Client Balance
07/19/2024 Thru | 08/02/2024 © show All Category v Deposit Ticket Crawford, Barbara Joanne Checking: Mas
 Cli v
Tiahaction Dats Client Frequency Balance on 8/1/2024 $1,976.55
« i v Clear Filter
& Next Deposit Date Mass Account |Checking E Total Account Balance $1,976.55
-
€ Other Date 07/19/2024 AcctoNIgG ¥
*Click in a field below and use the Filter/Sort menu for additional filtering.
Client Category Subcategory Amount Next Deposit Frequency Account Last Updated Notes
Dep | Edit | Skip | Bal. JAbbott, LisaAndrea [SSA $1,175.00 | 08/01/2024 |Monthly Checking: Mass 1/2/2024 10:21:02 AM
Dep | Edit | skip | Bal. |Baker, MarkL SSA $1,035.00 | 08/01/2024 [Monthly Checking: Mass 12/26/2023 9:22:02 AM
»| pep | Edit | skip |{'Bal. |Crawford, Barbara Joai [sSA $1,035.00 | 08/01/2024 [Monthly Checking: Mass 12/26/2023 9:22:05 AM
Dep | Edit | Skip | Bal. |Davidson, Linda SSA $1,035.00 | 08/01/2024 [Monthly Checking: Mass 12/26/2023 9:22:08 AM
Dep | Edit | Skip | Bal. |Roberts, James A SSA $1,050.00 08/01/2024 |[Monthly Checking: Mass 1/2/2024 10:21:30 AM |amount updated - housing chi
Dep | Edit | Skip | Bal. |Smith-Jones, Cathy  |SSI $892.00 | 08/01/2024 [Monthly Checking: Individual 12/26/2023 9:22:55 AM
Dep | Edit | Skip | Bal. , Ann L SSI $892.00 08/01/2024 |[Monthly Checking: Individual 12/26/2023 9:22:55 AM
Dep | Edit | Skip | Bal. [Young, Michael D SSI $1,089.00 08/01/2024 |Monthly Checking: Individual 5/13/2024 10:44:58 AM
Deposit 4 4/30f8 | » M Search < »

Process Scheduled Payments - Display Client Account Balance Num Lock  Powered by Microsoft Access

The Process Deposits screen can be accessed by selecting Process Deps from the Transactions screen. This is
used to process scheduled deposits and add them to the transaction register.

Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support
types are assigned to your user ID, you will only be able to process deposits for those types of clients. If client types
or support types have NOT been assigned to your user ID, you will be able to process deposits for all clients. "Access
Limited to assigned Client Types and/or Support Types" displays at the top of the screen if your user ID has been set
up for client and/or support type filtering.

Date Range

The screen shows a list of scheduled deposits during the date range you select. The date range defaults to the date of
the earliest unprocessed deposit through the current date. Process deposits for other dates by entering a different
date range.

Transaction Date

By default, the transactions will be dated on the "Next Deposit" date. Use the "Other Date" selection to date the
transactions on a different date. For example, if the "Next Deposit" date falls on a holiday or a weekend, use the
"Other Date" option to date the transactions on the day before or the day after the holiday or weekend. Changing the
transaction date does not change the next scheduled deposit date.

Client/Account Filter

The "Client/Account Filter" is used to display scheduled deposits for all clients, for a selected client, for a selected
mass account, or for clients assigned to a selected account manager. To view transactions for a single client, select
the "Client" filter option and then select the client from the list.

Transaction Filter

The "Transaction Filter" is used to filter scheduled deposits by category or frequency. Use the "Category" list to view
deposits for a selected category. Use the "Frequency" list to view deposits with a selected frequency. Click Clear
Filter to remove both the "Category" and "Frequency" filters.
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Deposit Ticket

Enter a deposit ticket ID if you want to group deposits into a batch deposit amount for reconciliation purposes.
Deposits with the same deposit ticket ID and date will appear as a single deposit on the Reconcile screen. Leave this
blank for an individual deposit. A deposit ticket ID can be up to ten characters. For example, use a deposit date
(January 23, 2024) for the deposit ticket ID (01-23-2024).

Dep/Deposit All
Click Dep to the left of a deposit to process that individual deposit. Click Deposit All to process all deposits shown.

After the transaction is created, the "Next Deposit" date will be updated based on the frequency for that transaction. If
that next calculated deposit date is outside of the date range you have chosen, the row will disappear after you have
clicked Dep.

Edit
Click Edit if you need to make any changes to the deposit before processing. Only users with rights to the Schedule
Deps tab on the Clients screen will have access to the Edit button.

Changes can be made to groups of scheduled deposits on the Update Scheduled Deposits screen.

Skip
Click Skip to skip this instance of the scheduled deposit. The "Next Deposit" date will be updated according to the
scheduled frequency.

Client Current Balance
Click Bal. to display the client's balance on the deposit date and total account balance.
Click Report to display a report of the scheduled deposits currently shown.

Use the Reset button in the upper right of the screen to immediately reset processed deposits.
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Process Transfers
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The Process Transfers screen can be accessed by selecting Process Xfer from the Transactions screen. This is
used to process scheduled transfers and add them to the transaction register.

Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support
types are assigned to your user ID, you will only be able to process transfers for those types of clients. If client types
or support types have NOT been assigned to your user ID, you will be able to process transfers for all clients. "Access
Limited to assigned Client Types and/or Support Types" displays at the top of the screen if your user ID has been set
up for client and/or support type filtering.

Date Range

The screen shows a list of transfers scheduled during the date range you select. The date range defaults to the date
of the earliest unprocessed transfer through the current date. Process transfers for other dates by entering a different
date range.

Transaction Date

By default, the transactions will be dated on the "Next Transfer" date. Use the "Other Date" selection to date the
transactions on a different date. For example, if the "Next Transfer date" falls on a holiday or a weekend, use the
"Other Date" option to date the transactions on the day before or the day after the holiday or weekend. Changing the
transaction date does not change the next scheduled transfer date.

Client/Account Filter

The "Client/Account Filter" is used to display scheduled transfers for all clients, for a selected client, for a selected
mass account, or for clients assigned to a selected account manager. To view transactions for a single client, select
the "Client" filter option and then select a client from the list. This filter only applies to the "from" client and "from"
account.

Transaction Filter

The "Transaction Filter" is used to filter scheduled transfers by category or frequency. Use the "Category" list to view
transfers for a selected category. Use the "Frequency" list to view transfers for a selected frequency. Click Clear
Filter to remove both the "Category" and "Frequency" filters.
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Xfer/Transfer All
Click Xfer to the left of a transfer to process that individual transfer. Click Transfer All to process all transfers shown.

Each transfer will consist of two transactions.

e One transaction will be shown for the "from" side of the transfer. This amount will be deducted from the
client's account balance.

e A second transaction will be shown for the "to" side of the transfer. The amount for this transaction will be
added to the client's account balance.

Money moved between categories and/or subcategories within the same account for the same client will not impact
the client's balance.

After the transactions are created, the "Next Transfer" date will be updated based on the frequency for that
transaction. If that next calculated transfer date is outside of the date range you have selected, the row will disappear
after you have clicked Xfer.

Edit
Click Edit if you need to make any changes to the transfer before processing. Only users with rights to the Schedule
Xfer tab on the Clients screen will have access to the Edit button.

Skip
Click Skip to skip this instance of the scheduled transfer. The "Next Transfer" date will be updated according to the
scheduled frequency.

Client Current Balance
Click Bal. to display the client's balance on the transfer date and total account balance.

Below Minimum

A minimum balance amount can be entered for each client on the Basic tab of the Clients screen. A warning message
displays if a transfer would take the client below their minimum balance.

Negative Balance Warning

If the System Setup options for the "Negative Balance Check" are set to "Warn" for either the "Balance on
Transaction Date" or "Total Account Balance," messages like the following display.

"] Process Scheduled Transfers X

1
el | |

The transfer for Abbott, Lisa A for $300.00 is greater than the
client’s total account balance of 5216.22.

Are you sure you want their total account balance to be
negative?

(0 W 8 RS I
T T T=TRK

e Select Yes to process the transaction.
e Select No and the transaction will NOT be processed.

e Select Cancel to cancel processing this and any remaining transfers. For example, if Transfer All was selected
before encountering a potential negative balance, Cancel would cancel the Transfer All process.
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If No is selected for the balance warning, a message displays for skipping the scheduled transfer.

"] Process Scheduled Transfers

1Ll

o Do you want to skip this scheduled transfer?

If you answer Yes, the Next Transfer date will be updated to
the next scheduled occurrence for the transfer without this
occurrence being processed.

| BOARY] 717

ImimimITxTa <l

| Pt OS5 |

Select Yes to skip this transfer. The "Next Transfer" date will be updated to the next scheduled occurrence for
the transaction as if the transaction had been processed. This instance of the transfer will not be processed.

e Select No to leave the transfer as scheduled. The "Next Transfer" date will not be changed and the transfer will
still be displayed on the Process Transfers screen after processing transfers.

Negative Balance Prevention

If the System Setup options for the "Negative Balance Check" are set to "Prevent" for either the "Balance on
Transaction Date" or "Total Account Balance," a message like the following displays.

7 Process Scheduled Transfers X

1L

client’s total account balance of §216.22 and will not be

0 The transfer for Abbott, Lisa A for $300.00 is greater than the
processed.

=TT

Do you want to skip this scheduled transfer?
If you answer Yes, the Next Transfer date will be updated to

the next scheduled occurrence for the transfer without this
occurrence being processed.

&2 | V]S Ve

T T T=TR

e Select Yes to skip this transfer. The "Next Transfer" date will be updated to the next scheduled occurrence for
the transfer as if the transaction had been processed. This instance of the transfer will not be processed.

e Select No to leave the transfer as scheduled. The "Next Transfer" date will not be changed, and the transfer will
still be displayed on the Process Transfers screen after processing transfers.

e Select Cancel to cancel processing this and any remaining transfers. For example, if Transfer All was selected
before encountering a potential negative balance, Cancel would cancel the Transfer All process.

Click Report to display a report of the scheduled payments currently shown.

Use the Reset button in the upper right of the screen to immediately reset processed transfers.
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Enter Payments
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The Enter Payments screen can be accessed by selecting Enter Payment from the Transactions screen. This is used
to create individual transactions that are not scheduled.

After entering a transaction, continue with another by clicking New. To delete a transaction from this screen, click
Delete.

Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support
types are assigned to your user ID, you will only be able to enter payments for those types of clients. If client types or
support types have NOT been assigned to your user ID, you will be able to enter payments for all clients. "Access
Limited to assigned Client Types and/or Support Types" displays at the top of the screen if your user ID has been set
up for client and/or support type filtering.

The fields on this screen are explained below.
e Client - select the client.

e Pay To Client/Vendor/One Time Vendor - select whether this payment will be paid to the client, a vendor, a
one-time vendor. For "Vendor," select a vendor from your active vendor list. For "One Time Vendor," enter the
vendor's name and address information manually. This field defaults to "Vendor" for the initial payment. If that is
changed for a payment, subsequent payments entered in the same session will default to the new selection.

e Account - select the account. This defaults to the client's default account.
e Category - select a category from the list (List Maintenance > Payment Category).
e Subcategory - select an optional subcategory from the list (List Maintenance > Subcategory).

e Date - enter the date. This defaults to the current date. If the date is changed, subsequent payments entered in
the same session will default to that new date.

e Pay To - select the vendor for a payment to a vendor or enter a vendor name manually for a one-time vendor.

e Amount - enter the amount. A negative amount can be entered to reverse an EFT payment or to enter a credit
line for a batch check.
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Vendor Address - select the vendor address. If the vendor has only one address, it will be used by default. If the
vendor has more than one address, select the address you wish to use. Leave the selection blank to print no
address on the check.

Mail to Client - select this to print the client's mailing address on a check.

e For a check paid to a vendor, the client's mailing address will print on the check instead of the vendor's
address. Use this to mail a check to a client that is paid to a vendor. Set the default for a vendor on the
Vendors screen.

e For checks paid to clients, select this to print the client's mailing address on the check. Otherwise, no mailing
address will print on the check. This can be used to separate checks that should be mailed to a client from
those that will be picked up by the client. Set the default "Mail to Client Address" setting on the System
Settings tab of the System Setup screen.

Sort by Client - select this to sort a check paid to a vendor by the client's name instead of the vendor's name
when printing. Set the default for a vendor on the Vendors screen.

Mail To - defaults to the vendor address or to the client's address based on whether this check is paid to the
client or to a vendor and the "Mail to Client" option.

Memo - defaults to the client's name and category. Can be changed.
Notes - notes about the transaction can be entered but will not print on checks.

Payment Method - select a value from the list. Select "Print" if you want a check to print for this transaction. The
other payment methods will add a transaction to the register without printing a check. See details for the available
payment methods in the Payment Methods topic. Set the default payment method for a vendor on the Vendors
screen. Set the default for payments to clients on the System Settings tab of the System Setup screen.

Batch Payment - select this if you want to print multiple transactions on a single check or export multiple
transactions as a single XEFT. This will group all payments on a single check or XEFT, as long as they are to the
same vendor, in the same account, and for the same date. Select "Batch Payment" for client payments to print a
single check or export a single XEFT to a client for more than one category. This option is the default for Print
and XEFT payment methods if the selected vendor is marked as "Batch Payments" on the Vendors screen and
the client type is marked as "Batch Payment" in List Maintenance > Client Type. Check or remove this option for
any payment manually.

Check # - enter the check number when the payment method is "Manual Check."

Receipt Required - select this if a receipt is required for the payment. Mark the receipt as received on the
Transaction Detail screen. View transactions requiring a receipt on the Receipts Required screen.

Balance on Date - displays the client's account balance on the transaction date. A message displays if you enter
a transaction that causes the client to have a negative balance on that date. The message will warn about or
prevent the negative balance based on the "Negative Balance Check" setting for the "Balance on Transaction
Date" option on the System Setup screen.

Total Account Balance - displays the client's total account balance. A message displays if the transaction
causes the client to have a negative total account balance. The message will warn about or prevent the negative
balance based on the "Negative Balance Check" setting for the "Balance on Transaction Date" option on the
System Setup screen.

Minimum Balance - displays the client's minimum balance (if any) from the Basic tab of the Clients screen. A
warning message displays if the transaction would take the client below their minimum balance.
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Documents

This is used to link documents, such as receipts or invoices, to a transaction. The documents themselves are NOT

stored in RPM—only a link to the document is stored in RPM.

e Click the + button to add a new row.

e Enter a description in the "Document Description" field and select the "Link Type." Select "Doc" to link a
document located on your computer or network. Select "Web" to enter a link to a website or online document.

e Document link - click Select File to locate the document on your network. Other users will only be able to
access the documents if they are in a network location accessible to all users. The documents should be
stored using a mapped drive, such as F:\\RPM Documents, and not a specific UNC path, such as
\\Server\RPM Documents. If the UNC path changes in the future, there is no way to automatically update the
document location to the new path. A drive mapping can remain the same regardless of the server name.

e Web link - enter a website or link to an online document.
e Click the X button on a row to delete the link to the document. This will not delete the actual document.
Once this screen is closed, any payments entered will be included on the Transactions screen.
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The Enter Deposits screen can be accessed by selecting Enter Deposit from the Transactions screen. This is used to
create individual deposit transactions that are not scheduled.

After entering a transaction, continue with another by clicking New. To delete a transaction from this screen, click
Delete.

Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support
types are assigned to your user ID, you will only be able to enter deposits for those types of clients. If client types or
support types have NOT been assigned to your user ID, you will be able to enter deposits for all clients. "Access
Limited to assigned Client Types and/or Support Types" displays at the top of the screen if your user ID has been set
up for client and/or support type filtering.

The fields on this screen are explained below.

o Date - enter the date. This defaults to the current date. If the date is changed, subsequent deposits entered in the
same session will default to that new date.

e Client - select the client.

e Account - select the account. This defaults to the client's default account.

e Amount - enter the amount. A negative amount can be entered to reverse a deposit.

e Category - select a category from the list (List Maintenance > Deposit Category).

e Subcategory - select an optional subcategory from the list (List Maintenance > Subcategory).
¢ Notes - enter any notes.

e Claim # - select the claim number associated with this deposit (optional). Claim numbers can be entered by
clicking Claim #s on the Clients screen.

e Deposit Ticket - enter a deposit ticket ID if you want to group deposits into a batch deposit amount for
reconciliation purposes. Deposits with the same deposit ticket ID and date will be shown as a single deposit on
the reconciliation screen. Leave this blank for an individual deposit. A deposit ticket ID can be up to ten
characters. For example, use a deposit date (January 23, 2024) for the deposit ticket ID (01-23-24).
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e Balance on Date - displays the client's account balance on the transaction date.
e Total Account Balance - displays the client's total account balance.

Documents
This is used to link documents, such as receipts or invoices, to a transaction. The documents themselves are NOT
stored in RPM—only a link to the document is stored in RPM.

e Click the + button to add a new row.

e Enter a description in the "Document Description” field and select the "Link Type." Select "Doc" to link a
document located on your computer or network. Select "Web" to enter a link to a website or online document.

e Document link - click Select File to locate the document on your network. Other users will only be able to
access the documents if they are in a network location accessible to all users. The documents should be
stored using a mapped drive, such as F:\\RPM Documents, and not a specific UNC path, such as
\\Serve\RPM Documents. If the UNC path changes in the future, there is no way to automatically update the
document location to the new path. A drive mapping can remain the same regardless of the server name.

e Web link - enter a website or link to an online document.

e Click the X button on a row to delete the link to the document. This will not delete the actual document.

Once this screen is closed, any deposits entered will be included on the Transactions screen.
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Enter Transfers
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The Enter Transfer screen can be accessed by selecting Enter Transfer from the Transactions screen. This is used
to transfer money between clients, accounts, categories, and/or subcategories.

After entering a transaction, continue with another by clicking New. To delete a transaction from this screen, click
Delete.

Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support
types are assigned to your user ID, you will only be able to enter transfers for those types of clients. If client types or
support types have NOT been assigned to your user ID, you will be able to enter transfers for all clients. "Access

Limited to assigned Client Types and/or Support Types" displays at the top of the screen if your user ID has been set
up for client and/or support type filtering.

The fields on this screen are explained below.

Transfer From/To
e "From" Client - the client from whom the money will be transferred.
e "To" Client - select the client who will receive the transferred money.

e "From" Account - select the account from which the money will be transferred. This defaults to the client's
default account.

e "To" Account - select the account into which the money will be transferred.

e "From" Category - select a category from the list (List Maintenance > Payment Category) for the outgoing side
of the transfer. For transfers between different accounts belonging to the same client, the "From Category" and
"To Category" will default to "Xfer."

e "To" Category - select a category from the list (List Maintenance > Payment Category) for the incoming side of
the transfer. For transfers between different accounts belonging to the same client, the "From Category" and "To
Category" will default to "Xfer."

e "From" Subcategory - select an optional subcategory from the list (List Maintenance > Subcategory) for the
outgoing side of the transfer.

e "To" Subcategory - select an optional subcategory from the list (List Maintenance > Subcategory) for the
incoming side of the transfer.
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Transfer Details
e Date - enter the date. This defaults to the current date. If the date is changed, subsequent transfers entered in
the same session will default to that new date.
e Amount - enter the amount.
e Pmt. Method - select from the available payment methods. For transfers within the same account, the payment
method defaults to "Transfer" and cannot be changed.
¢ Notes - notes about this scheduled transfer. This defaults to the "from"/"to" client and "from"/"to" account.

Transfer From Client Account Balance

e Balance on Date - displays the client's account balance on the transaction date. A message displays if you enter
a transfer that causes the client to have a negative balance on that date. The message will warn about or prevent
the negative balance based on the "Negative Balance Check" setting for the "Balance on Transaction Date"
option on the System Setup screen.

e Total Account Balance - displays the client's total account balance. A message displays if you enter a transfer
that causes the client to have a negative total account balance. The message will warn about or prevent the
negative balance based on the "Negative Balance Check" setting for the "Balance on Transaction Date" option

on the System Setup screen.

¢ Minimum Balance - displays the client's minimum balance (if any) from the Basic tab of the Clients screen. A
warning message displays if a transfer would take the client below their minimum balance.

Documents

This is used to link documents, such as receipts or invoices, to a transaction. The documents themselves are NOT

stored in RPM—only a link to the document is stored in RPM.

e Click the + button to add a new row.

e Enter a description in the "Document Description” field and select the "Link Type." Select "Doc" to link a
document located on your computer or network. Select "Web" to enter a link to a website or online document.

e Document link - click Select File to locate the document on your network. Other users will only be able to
access the documents if they are in a network location accessible to all users. The documents should be
stored using a mapped drive, such as F:\RPM Documents, and not a specific UNC path, such as
\\Server\RPM Documents. If the UNC path changes in the future, there is no way to automatically update the
document location to the new path. A drive mapping can remain the same regardless of the server name.

e Web link - enter a website or link to an online document.

e Click the X button on a row to delete the link to the document. This will not delete the actual document.

Once this screen is closed, any transfers entered will be included on the Transactions screen. Each transfer will

consist of two transactions.

e One transaction will be shown for the "from" client and account. This amount will be deducted from the client's
account balance.

e A second transaction will be shown for the "to" client and account. The amount for this transaction will be added
to the client's account balance.

Money moved between categories and/or subcategories within the same account for the same client will not impact
the client's balance.
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Print Checks
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& selected Criteria Select a Specific Printer and Printer Tray to print your checks to a location other than your default printer.
Dated Through i 01/27/2025 Select Advanced Printer and click "Settings" to set other advanced printer settings.
Account Manager 4 IDoe, Jane v

Check "Preview Checks before Printing" to display a preview of checks when clicking "Print."

-
Client Type | Click "Save Printer" to save your selected print options.

Checks on First Page

Click "Report" to review the list of the checks selected to print and the order in which they will print. Changes can be made
& Three C Two € One to the sorting settings on the Check Sorting tab under Utilities > Setup > Check Layout.
No additional menu items can be opened while the Print Checks screen is open. Close the Print Checks
First Check Number 7291

screen to access another RPM menu item.

Click "Reset" to reset a check run. If checks are not available for printing in a specific account, another user may be printing checks from that account. Use the

Clear Check Printing User screen under Utilities > Transaction > System to clear another user from the check printing process.

Select Account Num Lock  Powered by Microsoft Access

The Print Checks screen can be accessed by selecting Print Checks from the Transactions screen. This is used to
print checks for transactions where the payment method is "Print."

Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support
types are assigned to your user ID, you will only be able to print checks for those types of clients. If client types or
support types have NOT been assigned to your user ID, you will be able to print checks for all clients. "Access Limited

to assigned Client Types and/or Support Types" displays at the top of the screen if your user ID has been set up for
client and/or support type filtering.

Select Account

With more than one bank account, "Print Check Numbers" must be selected on the Check Layout screen to print for

all accounts at the same time. If "Use Numbered Checks" is selected, checks can only be printed for one account at a
time.

Select Checks to Print
e All Checks - use this option to print all checks.

e Selected Checks - click Choose to select individual checks. As you select checks to print, your user ID will be
saved with the selected checks. More than one user can print checks at the same time, but only for different bank

accounts. Once you select checks to print, another user will not be able to print in the same account(s) until you
are done.

e Selected Criteria - select one or more of the criteria options, including checks through a date, assigned to a
specific account manager, or assigned to a specific client type.
Checks on First Page

When using standard checks (three checks per page), select whether the first page of checks is a full page of three
checks or a partial page of one or two checks.
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First Check Number

When using pre-numbered checks, make sure the "First Check Number" matches the number on your actual check
paper. If it does not match, change the number before clicking Print.

If check numbers are being printed on your check paper, the "First Check Number" will be disabled and will be
automatically calculated based on the last check number printed for the account.

Select Printer

e Your current Default Printer displays at the top of the "Select Printer" section of the screen. To use a different
printer, select the "Specific Printer" option and choose a printer from the dropdown list.

e After selecting a printer, you can change the tray your checks will print to using the "Printer Tray" dropdown. If
you have selected a PDF printer, the tray will default to the "Forms" tray.

e To change advanced printer settings, select the "Advanced Printer" option and click Settings. Save this
advanced printer as your selection to continue using these settings.

e Check "Preview Checks before Printing" to display a Print Preview when you click Print. Checks can be
reviewed here and printed from the preview.

e To save your printer, tray, and preview selections for the next time you print checks, click Save Printer.
Printer settings can also be selected on the Printer tab of the Check Layout screen.

Report
Click Report to see a report of the checks selected to print and the order in which they will print.

Print

Click Print to print the checks. If "One Account” is selected, a dialog box displays showing the number of checks that
will be printed and the check numbers to be used. This box will not display when "All Accounts" is selected.

If "Preview Checks before Printing" is selected, clicking Print will open a Print Preview screen that displays the
checks that will be printed. Click Print Checks on the Print Preview screen to select your advanced printer settings
and print the checks. To close the Print Preview screen without printing the checks, click Close Check Preview
without clicking Print Checks; this will set the checks back to "Print."
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Print Checks Confirmation
After checks have been sent to the printer, the following screen displays.
** Do not click "Yes" on this screen until confirming the checks have printed correctly. **

Backup/Restore v &g‘ ‘Z:] 5' Client ~ IE"@ &% @

Import/Export v ; ; : 5 Setup v
Dashboard Clients Transactions Vendors Reconcile List Reports Users Change  User

Maintenance Transaction v Password Settings

File View Utilities Reports Security
Dashboard X Transactions X Print Checks X E Print Checks Confirmation

Did Checks Print Correctly?
Yes ALL checks printed correctly.
No Checks did NOT print correctly.

Confirm all checks have printed correctly before continuing.

—Select Check Run Reset Options
@ set Checks back to Print

" void and Create New Checks for Printing

First incorrectly printed check |Checking: 7189 ¥

Reset

If any of the checks did not print correctly, use the reset options above.

» Select "Set Checks back to Print" to remove the check numbers so the checks can be printed again.

e Select "Void and Create New Checks for Printing" to void the printed checks and create new ones for printing.
¢ Select the name and number of the first incorrect check and click "Reset."

If you have a problem with a specific check, use the "Details" button on the Transactions screen to either set it
back to print or void it and create a new transaction.

After checks have finished printing, click Yes if all the checks printed correctly.
Click No if any of the checks did not print correctly and select from the reset options below.

Select Check Run Reset Options

e Set Checks back to Print - this will simply set the incorrect checks back to print for printing again. Corrections
can be made to the transactions before printing again.

e Void and Create New Checks for Printing - this will void the incorrect checks and create new transactions for
printing. Corrections can be made to the new transactions before printing.

e Firstincorrectly printed check - select the first check if the entire check run was incorrect. Otherwise, select
the check where the incorrect printing starts. All checks on or after the selected check will be reset.

Click Reset to reset the selected checks. A confirmation message will display. Click Yes to continue.
** Any checks that print incorrectly and are reset should be destroyed. **

If checks need to be reset after closing this screen, use one of the options below.

e Click the Reset button at the top of the screen to reset all or part of a check run. This can only be done if none of
the checks in the check run have been voided or reconciled.

e Change the "Payment Method" for a printed check to "Print" on the Transaction Detail screen.
e Click Void for a printed check on the Transaction Detail screen and create a new transaction for printing.
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Transaction Detail

IE  Representative Payee Manager - a X
File RPM
Backup/Restore v fq K 7 r Ejﬁ <7 Client ~ I— 2 El = S Find 7 (@ Help
o foa f# V B o= Q+ i - :
Import/Export ¥ | pachiboard Clients Transactions Vendors Reconcile List ~ Setup~ Reports | Users Change User | -2 I Save | A\ System Info
Maintenance Transaction v Password Settings | ) Saved Record v € Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help ~
Dashboard T x |3 Detail X X
Close Delete | Void Audit Report | View Related
»| Details Documents
Transaction Detail Client Account Balance
Client /Abbott, Lisa Andrea Payment Method |Check v [ Current Transaction Excluded Included
Date I_01/01 /2025 Check # 7601 c [—7 Balance on 1/1/2025 1931.25] $1,903.25
Category Utility ~ BatchReference |0002 Total Account Balance $1,634.73 $1,606.73
Subcategory I_water 5 T v Minimum Balance $100
Amount $28.00 r Notes
Check Memo  |Abbott, Lisa A - Utility Receipt Required I € Ei [Amount updated before printing (12/30/24)
Date Processed [12/30/2024 10:22:45 AM Account Checking: Mass v
ProcessType  [Scheduled Payment r
Date Printed 12/30/2024 10:32:32 AM Reconciled
EnteredBy  [AdminUser  [12/30/202410:22:45 AM
Eeviie After a check has been printed, only the category, subcategory, payment method, check #, and notes
Pay To Client/Vendor |Vendor: Hillside Apartments can be changed. To make changes and print a check again, use the "Void" button to void and create a
payable To Hillside Apartments new transaction, or change the Payment Method back to Print.
Mail To Hillside Apartments
Mail To Address P O Box 150 [
City/st/Zip Louisville [iky [a0202-
Account Balance on Date - Excluding current transaction Num Lock  Powered by Microsoft Access  Filtered

To change, delete, or void an existing transaction, click Details to the left of that transaction on the Transactions

screen or on the View Trans tab of the Clients screen.

Depending on the type of transaction, the Transaction Detail screen will have different options availab

le. Users must

have "Update" rights on the Users screen under the View tab for the "Details - Edit Payment," "Details - Edit Deposit,"

or "Details - Edit Transfer" menu option to be able to update that type of transaction.

Click Delete to delete a transaction. Users must have "Update" rights on the Users screen under the View tab for the
"Details - Delete Payment," "Details - Delete Deposit," or "Details - Delete Transfer" menu option to be able to delete

that type of transaction.

Click Void to void a transaction. Users must have "Update" rights on the Users screen under the View tab for the
"Details - Void Payment," "Details - Void Deposit," or "Details - Void Transfer" menu option to be able to void that type

of transaction.

If the transaction has been reconciled or cleared, it must be unreconciled and/or uncleared on the Reconcile screen

before any changes can be made.

Any changes or deletions made on this screen will be logged in the audit events. Click Audit Report to see any
changes for the displayed transaction. See changes to all transactions on the Reports screen under "Audit."

Click View Related to immediately view any corresponding transfers, voids, batch items, or deposit ticket items

associated with the current transaction.
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Client Account Balance

Balances are displayed, both excluding and including the current transaction. Any changes to the amount for a
transaction will check the following balances.

e Balance on Date - displays the client's account balance on the transaction date. A message displays when
changing the amount would result in a negative balance on that date. The message will warn about or prevent
the negative balance based on the "Negative Balance Check" setting for the "Balance on Transaction Date"
option on the System Setup screen.

e Total Account Balance - displays the client's total account balance. A message displays when changing the
amount would result in a negative total account balance. The message will warn about or prevent the negative
balance based on the "Negative Balance Check" setting for the "Balance on Transaction Date" option on the
System Setup screen.

e Minimum Balance - displays the client's minimum balance (if any) from the Basic tab of the Clients screen. A
warning message displays if changing an amount would take the client below their minimum balance.

Deposits
A deposit can be changed unless it is cleared or reconciled.

ATM/Cash, Credit Card, Debit, Debit Card, EFT, and Manual Check Payments
Payments of these types can be changed unless they are cleared or reconciled.

Unprinted Checks
Checks can be changed before printing. The "Payment Method" will be "Print" for a check that has not been printed.

Printed Checks

After a check has been printed, only the category, subcategory, payment method, check number, and notes can be
changed. To make changes and print a check again, use the Void button to void and create a new transaction, or
change the "Payment Method" back to "Print."

XEFT
XEFT payments can be changed unless the transaction has been exported, cleared, or reconciled.

If the transaction has been exported, the "Exported” box must be unchecked before any changes can be made. Only
users who have rights to export XEFT transactions can remove the "Exported" flag.

Transfers

Transfers can be changed unless either of the two transactions associated with the transfer are exported, cleared, or
reconciled.

If you change the date, type, or amount for a transfer, the associated "transfer from" or "to" transaction will also be
updated. If you delete a transfer transaction, the associated "transfer from" or "to" transaction will also be deleted.
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Void

File RPM
Backup/Restore ~ ~ ® v 4 ’7 =\ Client ~ S A .
& 72 B = o | & &
Import/Export v 2 y . N Setup v o
Dashboard Clients Transactions Vendors Reconcile List ) Reports Users Change |
Maintenance Transaction v Password Se
File View Utilities Reports Security

Transactions X |=5| Transaction Detail X EVMTHMn X

Close l Void |
[ Transaction to Void | [ Void Transaction Information
Client IRoberts, James A| Void Date | 01/25/2024
Account [Checking: Mass Memo IVoid

Date I01/ 16/2024 Notes
Payment Method lcheck
Check Number |7187

~Create New Check

Category [Food r
Create New Check for Printin
Amount l$37.00 g
01/25/2024
Pay To [Kroger

Any type of transaction other than an XEFT can be voided with the Void button on the Transaction Detail screen.
The "Void Date" defaults to the current date but can be changed to any date on or after the original transaction date.
The same transaction cannot be voided more than once.

If you void a batch check, all detail lines associated with that check will be voided.

Check "Create New Check for Printing" to automatically create a new copy of the check for printing to replace the void
check. Changes can be made to the new check before printing.

Click Void to create the void transaction. A void check will have the same original check number followed by the letter
"V." Both the original and void transaction will be flagged as "Void."

** |f you mistakenly void a transaction, click "Details" for the void transaction on the Transactions screen and
delete the void transaction. **
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Documents

KB  Representative Payee Manager - - a 2
File RPM
Backup/Restore K |74 =€ B Client v N 2 s Find @ Hel
’ [ & A o 5 o 23 f_) g
. 5 o v 2 . A
lmport/Export Dashboard Clients Transactions Vendors Reconcile List ~ Setup Reports | Users Change User I Save A\ System Info
Maintenance Transaction v Password Settings “) Can'tUndo £ Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help ~
Dashboard T A= Detail X X
Close Delete Void Audit Report View Related
»| Details Documents
Transaction Documents
Edit Documents Using © Hyperlink ¢ OLE
+ |Document Description Link Type Document Location/Web Link User ID
»| x [Receipt 1/5/25 @ Doc  Web |c:\Shared Folder\RPM Documents\Export\7601_receipt.jpg SelectFile |View|AdminUser
X [Invoice ¢ Doc & Web |https://www.sharepoint.com/files/payee/invoice_122924_abbott Select File | View |AdminUser
*| x & Doc  Web SelectFile |View

The Documents tab is used to link documents, such as receipts or invoices, to a transaction. The documents
themselves are NOT stored in RPM—only a link to the document is stored in RPM.

Click the + button to add a new row.
Click the X button on a row to delete the link. This will not delete the actual document.

The fields and buttons are explained below.
e Document Description - a description for the document.

e Link Type - select "Doc" to link a document located on your computer or network. Select "Web" to enter a link to
a website or online document.

e Document Location/Web Link - displays the linked document name and location when "Doc" is selected for the
"Link Type." When "Web" is selected for the "Link Type," enter the website or link to an online document.

e Select File - used to locate a document on your computer or network. This is only available when "Doc" is
selected for the "Link Type." Other users will only be able to access the documents if they are in a network
location accessible to all users. The documents should be stored using a mapped drive, such as F\RPM
Documents, and not a specific UNC path, such as \Server\RPM Documents. If the UNC path changes in the
future, there is no way to automatically update the document location to the new path. A drive mapping can
remain the same regardless of the server name.

e View - used to open a document or web link. Not all types of documents can be opened using View. Documents
can be opened either as a Hyperlink or with OLE (Object Linking and Embedding). If there are problems opening
documents with one option, try the other option.

e User ID - the user who entered or updated this record. This will be automatically filled in by the system.
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Reconcile

B Representative Payee Manager =

File RPM
Backup/Restore v f(?) ,QQ\ z/j @ @ Client v . é. ﬁ Q%:— X cut O Find < Fitter 2| Ascending
Import/Export Y | pachboard Clients Transactions Vendors Reconcile Lst ~ Setup~ Reports :se: Change  User | [BCopy  [Esave A selection %] Descending ey
Maintenance Transaction v Password Settings | [P Paste ) Saved Record v Y A v
File View Utilities Reports Security Edit Records Filter/Sort ~
(53] Dashboard X m
Close | Clear All | Unclear All | Clear Range | Import | Update | Report oncile Click "Finish" to complete this statement.
Select Account |checking v I show Inactive BeginningBalance | $5,595.47
Select Statement Ending 12/3—1/2()24—v Add New Cleared Balance w
Statement Ending Date m Delete Cleared Pmts. | $7,064.68 Count | 91 Ending Balance m
Outstanding Items Thru m Cleared Deps. I $5,211.70 Count I 10 Difference —(s—am Finish [ Completed [—
All Payments | Deposits | Deposits
Clear Date Pmt. Method Check # Amount Paid To Client - Clear Date Amount Deposit For Category *
Details [T [10/29/2024 [Check 7518 $50.00 |Krager Supermarket |Abbott, Lisa Andrea | Details | I |10/31/2024 $35.00 |Roberts, James Anderson Cash deposi
Details | ¥ [12/01/2024 |Check 7560 $1,377.50 |Hillside Apartments Batch Check Details | ¥ [12/01/2024 $1,035.00 |Crawford, Barbara Joanne ISSA
Details | ¥ [12/01/2024 |Check 7561 $37.50 |Memorial Hospital /Abbott, Lisa Andrea Details | I |12/01/2024 $1,035.00 |Davidson, Linda Fumiko SSA
Details | V¥ [12/01/2024  [Check 7562 $50.00 |Transit Bus Service |Abbott, Lisa Andrea | Details | ¥ [12/01/2024 $1,050.00 |Roberts, James Anderson ISSA
Details | ¥ [12/01/2024 |Check 7563 $60.00 |Transit Bus Service Baker, Mark Luis Sar Details | ¥ [12/01/2024 $1,075.00 |Baker, Mark Luis Santiago ISSA
Details | ¥ [12/02/2024 |Check 7564 $55.00 |Lisa Andrea Abbott \Abbott, Lisa Andrea Details | ¥ [12/01/2024 $1,175.00 |Abbott, Lisa Andrea ISSA
Details | ¥ [12/03/2024 |Check 7565 $50.00 |Krager Supermarket /Abbott, Lisa Andrea Details | ¥ [12/03/2024 $270.00 |Davidson, Linda Fumiko \Wages
Details | ¥ [12/03/2024 |Check 7566 $45.00 (Krager Supermarket Crawford, Barbara Jc Details | ¥ [12/15/2024 $150.00 |Crawford, Barbara Joanne Pension
Details | ¥ [12/03/2024 |Check 7567 $37.00 |Krager Supermarket Baker, Mark Luis Sar | Details | ¥ [12/15/2024 $200.00 |Abbott, Lisa Andrea Pension
Details | I [12/03/2024 |Check 7568 $32.00 |Krager Supermarket Davidson, Linda Fun Details | ¥ [12/24/2024 $250.00 |Davidson, Linda Fumiko \Wages
Details | I [12/03/2024 |Check 7569 $37.00 |Krager Supermarket Roberts, James And Details | I |12/30/2024 $0.01 |Payee, ABC Interest
Details | ¥ [12/02/2024 |Check 7570 $25.00 |Memorial Hospital Baker, Mark Luis Sar | Details 12/30/2024 $1.55 |Roberts, James Anderson Interest
Details | I [12/09/2024 |Check 7571 $55.00 |Lisa Andrea Abbott Abbott, Lisa Andrea Details | I |12/30/2024 $2.23 |Baker, Mark Luis Santiago Interest
Details | ¥ [12/10/2024 [Check 7572 $50.00 |Krager Supermarket Abbott, Lisa Andrea | Details [T [12/30/2024 $2.96 |Abbott, Lisa Andrea Interest
Cleared Subtotal | $7,064.68 Cleared Count 91 v Cleared Subtotal $5,211.70  Cleared Count 10 v
Payments 4 4 110f95 | » » \ Search 4 » Deposits 4 4 [17 of 17 M 2 Search B — >

Clear

Num Lock

Powered by Microsoft Access

Select Reconcile from the View menu to open the Reconcile screen. This is used to reconcile bank accounts. Use the

"Select Account” list to select the account you wish to reconcile. Mass accounts will be listed first, followed by
individual accounts. Mass accounts will be listed alphabetically by account name. Individual accounts will be listed

alphabetically by client and account name.

By default, only active accounts will be shown. To see all accounts, select "Show Inactive."
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Add New Statement

File RPM
Backup/Restore ¥ - W =L
E%) >«Q‘ "vj R
Import/Exporty; Dashboard Clients Transactions Vendors Reconcile
Mair
File View
Dashboard Reconcile X j Add New Statement X
Close Add |

[~ Account Details

Checking

Latest Completed Statement Date |11/30/2024
Latest Unfinished Statement Date |12/31/2024

Enter New Statement Details

Statement Ending Date | 01/31/2025

Ending Balance ’ $4,501.67

Outstanding Items Thru | 02/01/2025

Click Add New to begin a new statement for the selected account.

At the top of the Add New Statement screen, the selected account name will display, along with the last completed
statement date for that account (if any) and the most recent unfinished statement date for that account (if any).

In the "Enter New Statement Details" section, enter the necessary information for a new statement. After entering a
"Statement Ending Date," the "Outstanding Items Thru" date will default to the same date but can be edited. Enter the
ending balance from the corresponding bank statement.

Once the appropriate details are entered, click Add to add the new statement.

Information Pane

In the upper section of the screen, information is visible pertaining to the selected reconciliation.

Select Statement Ending

Use the "Select Statement Ending" dropdown to select the date of an existing statement for viewing. Both completed
and in-progress statements can be selected.

The fields in the information pane and the transactions shown below will be updated to match the selected statement.

Statement Ending Date

The ending date for the statement. The completed reconciliation will be saved using this date. For reconciliations in
progress, this date can be changed by typing in the field or choosing a new date from the calendar date picker.
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Outstanding Items Thru

The "Outstanding Items Thru" date defaults to the same date as the statement ending date. Outstanding transactions
dated on or before the "Outstanding Items Thru" date can be cleared and reconciled on this statement. For
reconciliations in progress, change this to a later date to include any future outstanding items.

Add New
Use this button to open the Add New Statement screen and begin a new statement (see above).

Delete

Use this button to delete an existing statement. To delete a statement in progress, you must first unclear all cleared
transactions on the statement. To delete a completed statement, you must first Edit and then unreconcile all
reconciled transactions on the statement.

Cleared Subtotals and Counts

Cleared payments and deposits are subtotaled and counted in this section at the center of the information pane. Use
this to compare to the counts and amounts of payments and deposits on your bank statement.

Beginning Balance

The "Beginning Balance" shows the total value of items reconciled prior to this statement ending date. This should
match the beginning balance on your bank statement. If it does not match, verify that previous reconciliations are
correct. On the Reports screen, use Reconciliation > Account Statement List to view reconciliation totals for previous
statements. If any previous months are no longer reconciled, use Audit > Audit Events By Statement to see changes
that have been made to a previously reconciled statement.

Cleared Balance

The "Cleared Balance" shows the reconciled account balance, including the beginning balance and any items cleared
on this statement. As items are cleared, the cleared balance will be updated.

Ending Balance

The "Ending Balance" from the ending balance on your bank statement, entered when you added the statement. For
reconciliations in progress, this ending balance can be edited by typing directly in the field.

Difference

The "Difference" is calculated automatically by subtracting the cleared balance from the ending balance. The
"Difference" will be updated automatically as items are cleared. When the cleared balance and ending balance match,
the difference will be zero and the reconciliation will be ready to finish.

Finish
**Transactions are merely in a reconciling state until "Finish" is clicked. Once finished, the transactions will
be fully reconciled.**

For a reconciliation in progress, click Finish to complete the reconciliation and mark the cleared items as reconciled.
The completed Account Reconciliation report will display. Reconciliation reports are also available on the Reports
screen.

If the Reconcile screen is closed before finishing, items marked as cleared will remain when the screen is opened
again.
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Edit
For a completed reconciliation, click Edit to make any changes to the statement dates, ending balance, and/or

cleared transactions. Any previously reconciled items will display, as well as any remaining outstanding items through
the "Outstanding Items Thru" date.

After a statement is edited, you must click Finish to re-complete the statement.

Completed

For a completed statement, the completion date and time will display. This date and time will update if a completed
statement is edited and finished again.

Update

Click Update to update the displayed transactions with any possible changes made to the transactions while the
Reconcile screen is open. For example, if you or another user changes an existing transaction or adds a new
transaction in the account being reconciled, use Update to show those changes.

Report

For a statement in progress, click Report to display a list of the reconciled, reconciling, and remaining outstanding
items. Outstanding transactions will only be included if they are dated on or before the Statement Ending Date and if
the reconciliation is unfinished.

Unreconcile All

For a previously completed statement that is being edited, use Unreconcile All to unreconcile all transactions on the
statement. This will completely reset the statement and remove all cleared and reconciled items.

Transactions

The lower portion of the Reconcile screen displays payment and deposit transaction items.

For a statement in progress, all as-yet unreconciled transactions dated through the "Outstanding Items Thru" date
appear here, including any transactions marked as cleared on this statement.

For a completed statement, all transactions reconciled on this statement appear here. If a completed statement is
edited, reconciled items appear along with outstanding transactions through the "Outstanding Items Thru" date and
any newly cleared items for this statement.

By default, the "All" tab is selected, which shows payment and deposit transactions simultaneously on the screen. To
expand your view of payments or deposits, click the "Payments" or "Deposits" tab.

Payments will be shown in check number order. Deposits are sorted by date and amount. To change the sorting,
right-click in the field you want to sort and select "Sort A to Z" or "Sort Z to A" from the Shortcut menu.

Click the Clear checkbox to mark any items as cleared. Items that have been marked as cleared will have a gray
background and display "c" in the "R/c" (Reconciled/Cleared) column. Items that have not been cleared will have a
white background and the "R/c" column will be blank. When viewing or editing a previously completed reconciliation,
reconciled items display "R" in the "R/c" column.

For both the "Payments" and "Deposits" sections, the "Cleared Subtotal" field at the bottom shows the total
monetary amount of all items on the screen that have been marked as cleared, and the "Cleared Count" field shows
the number of items on the screen that have been marked as cleared.
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Payments
The following fields display on payment transaction lines on the Reconcile screen:

Details - click to open the Transaction Detail screen for this payment. Transaction details can only be
changed if the transaction has not yet been cleared or reconciled. For batch checks and batch XEFTs, a list of
all transactions in the batch will display.

Clear - click to mark individual payments as cleared. To clear multiple transactions at once, use one of the
options detailed in the "Clearing Transactions Automatically" section below.

Date - transaction date.

Pmt. Method - payment method. Check payments sort at the top of the list, followed by ATM/Cash, Credit
Card, Debit Card, Debit, EFT, Transfer, and XEFT payments, respectively.

Check # - check number for check payments.
Amount - monetary amount of the payment.
Paid To - recipient of the payment.

Client - RPM client making the payment. For batch items, "Batch Check" or "Batch XEFT" will display in this
field.

Category - category assigned to this payment.
Subcategory - subcategory assigned to this payment, if any.
Notes - notes about this payment, if any.

R/c - reconciled/cleared status. "R" indicates reconciled, "c" indicates cleared, and blank indicates
outstanding (neither reconciled nor cleared).

Deposits
The following fields display on deposit transaction lines on the Reconcile screen:

Details - click to open the Transaction Detail screen for this deposit. Transaction details can only be changed
if the transaction has not yet been cleared or reconciled. For deposit tickets, a list of all transactions in the
ticket will display.

Clear - click to mark individual deposits as cleared. To clear multiple transactions at once, use one of the
options detailed in the "Clearing Transactions Automatically" section below.

Date - transaction date.
Amount - monetary amount of the deposit.

Deposit For - RPM client receiving the deposit. For deposit tickets, "Deposit Ticket" will display in this field,
followed by the deposit ticket ID.

Category - category assigned to this deposit.
Subcategory - subcategory assigned to this deposit, if any.
Notes - notes about this deposit, if any.

R/c - reconciled/cleared status. "R" indicates reconciled, "c" indicates cleared, and blank indicates
outstanding (neither reconciled nor cleared).

Clearing Transactions Automatically

There are four options available to clear transactions automatically.
Clear All - use this to automatically clear all uncleared payments and deposits on this statement.

Unclear All - use this to automatically unclear all cleared payments and deposits on this statement. On
previously completed statements, this will NOT remove any reconciled items. Use the Unreconcile All button to
remove previously reconciled items.

Clear Range - clear or unclear a range of selected transactions. See the instructions under "Clear Range" below.

Import - clear a list of checks from a file. See the instructions under "Import" below.
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Clear Range

Click Clear Range to mark or unmark a range of transactions as cleared. Select the "Payment Method" and then
select the range of check numbers or transaction dates. Select the "Mark as Cleared" option to clear a range of items
or the "Unmark as Cleared" option to remove the cleared flag. Click Update to update the selected range. After
closing this screen, the information will be updated on the Reconcile screen.

Backup/Restore v = @ "4 @ .
o & 4] V)

Import/Export ~ X X i
Dashboard Clients Transactions Vendors Reconcile

File View
Dashboard Reconcile X 3 Recondile Range X
Close | Update |

Select Payment Method

Payment Method checﬂ v

Select Range

From 7166 v
To 7187 v

Select Clear Option
& Mark as Cleared

" Unmark as Cleared

Import

Click Import to import and reconcile a list of cleared checks from a file.

The standard import file is a comma-delimited (CSV) file with the following fields:
e Check number

e Amount

e Date

For a different file format, contact us for a quote to add a custom format to RPM.

Once the file has been selected, click Import to import the check file into RPM. Checks in the import file that match
the check number and amount on the Reconcile screen will be automatically marked as cleared. Use the Unmatched
Checks report to see any checks in the file that do not match checks on the reconcile screen. The Matched Checks
report will show the checks that match and have been marked as cleared.

File RPM
Backup/Restore v =~ °® 7 4m o 9 o) Client v [ 2 =+
s {—J 4 = ‘E@ o= (5]
Import/Export ~ - ) ) - Setup ~
Dashboard Clients Transactions Vendors Reconcile List Reports Users Change  User
Maintenance Transaction ¥ Password Settings
File View Utilities Reports Security

Dashboard Reconcile X |-z Import Reconciled Checks X

Close
|Checking

~Select Import File Format

@ standard Format - CSV File
c

Import File

File Location

|F:\RPMI‘ \Import\Check cileList.csv
Last Imported Statement Ending Date

Select Report Type

@ Unmatched Checks

¢ Matched Checks Report

The standard import file is a comma-delimited (CSV) file with the following fields:
* Check Number

* Amount

* Date
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Reports

KB  Representative Payee Manager - - a X
File RPM
Backup/Restore v fq 2 P r E‘ﬁ <7 Client > |— - El = S Find @ Help
) » R °v—:’ g | o= Q+ = 3
Import/Export ¥ | pachboard Clients Transactions Vendors Reconcile List ~ Setup~ Reports | Users Change User I Save A System Info
Maintenance Transaction v Password Settings £ Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help i
(5] Dashboard X [3| Reports X X
Close Report Query Email ‘ Archived Transactions Available From [01/01/2013 Thru {12/31/2018
Select Report Client Statement Email Client Reports
Report List 4 Date Range 07/01/2024 Thru o7/31/zozZ| | Required Send To
*kliept Account [checking ~  Optional & Client Email Address
#ipalances Include Inactive Accounts [~ Optional C  Client Contact Type =
- Transactions By Client Combine A o ot ! -
ombine Accoun ional i
Client Statement | P Test Email
A N Client v~ Optional
Client Stat t (Window E I
ent statement (Window Envelope) . Send Copy To Your Email
Client Statement (Detail) Account Mgr. [ooe, 1ane v Optional
’ & - &
Client Statement By Subcategory Sort By Account Mgr. ™ Optional None cc BCC
Actual Vs. Eudget Totals Client Type | ~  Optional Email Message
Actual and Projected Vs. Budget Totals Support Type 5 Optional e |
B mail Subje Client Statement
Actdual and projected Detail Include Pay To Address [~ Optional
Budget i
,g 7 Bxcliide Minfmum Balance .- Optional Email Message |Your payee statement for July is attached.
Projected Balance Detail . ) )
Scheduled Payment Transactions Include Inactive Clients [~ Optional Jane Doe
Transaction Detail Hide SSN v Optional ABC Payee
Transaction Totals Hide Category Subtotals [~ Optional
Transaction Totals By Group
Archived Transactions
Description

+ Transactions
+ Reconciliation
+ Graphs

+ Vendor

Client transactions and category totals. The date range can include both archived and current transactions.

End Date Num Lock  Powered by Microsoft Access

The Reports screen is used to run reports. Select Reports from the ribbon menu to open this screen.

The reports are grouped into several main categories. Click the + next to a category to expand the category and see
the reports. Select Report List at the top of the reports and click "Report" to see a list of all available reports.

Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support
types are assigned to your user ID, you will only be able to view those types of clients on reports. If client types or
support types have NOT been assigned to your user ID, you will be able to view all clients. "Access Limited to
assigned Client Types and/or Support Types" displays at the top of the screen if your user ID has been set up for
client and/or support type filtering. If your user ID is assigned to only non-financial support types, you will not have
access to any financial reports.

Click the report you wish to view under the "Select Report" list. Any criteria used to run the report displays on the right
side of the screen. Criteria marked as "Required" must be entered to run the report. Criteria marked as "Optional" can
be entered or left blank. If you leave optional criteria blank, all available items display on the report. For example, if
you enter an optional "Client" selection, only the selected client displays on the report. If you leave the client selection
blank, all clients display on the report.

The Columns button will be enabled when a Custom report is selected. Click Columns to select the columns to
include on the report. The available columns for that custom report will display.

Click Report to run the selected report.

Some reports will also have the Query button available, including all the Custom reports. This allows you to view the
report data in a list format that can easily be exported to Excel or any other spreadsheet. Click Query, if available, to
run the query for the selected report.

The Email button will be available for most of the Transactions By Client reports. The client reports can be sent to
each client's email address or an email address for a selected contact type for each client. Select Test Email to send
the reports to your own email address as entered on the User Settings screen.
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Columns

File RPM

Backup/Restore v
Import/Export ¥

Fe & 20

(3

Dashboard Clients Transactions Vendors Reconcile

File View

Representative Payee Manager

54 :ﬁent v ’E"
) etup v
List Reports

Maintenance Transaction v

Utilities Reports

Dashboard

Close | Mark All |

Clear All

Reports X - Custom Report Column Selection

Save New

Save

Selected Custom Report |Client demographic information

Clients

Saved Custom Reports

s —+
o8 (=7
Users Change User |
Password Settings | | [Paste
Security Edit

H save
2| Ascending

Records Filter/Sort

| 2 Find %1 Descending

@ Help

1 System Info

7 Tech Support

Help A~

Selected Column

T First Name

T Middle Initial

T Last Name

V" Iclient Name (Last, First)

I Client Name (First Last)

1 SSN

I SSN (no dashes)

I Status

V= Igirth Date

Age

/Add Date

Start Date

T
T

T Client Type
T Support Type
T

\Account Manager

Phone

v Cell Phone

M |address 1

WV Taddress 2

Custom Report Name

Custom Report Notes

UserID

Last Updated

X | Select

Client birthday list

List of client birth dates

4/1/2019 4:18:25 PM

X | select

Client demographic information|

igender, race, ethnicity, marital status

adminuser

(4/10/2019 10:05:48 AM

X | select

Client status and type list

status, client type and support type

adminuser

14/25/2019 4:02:18 PM

| x [ select

Client address phone list

address and phone information

3/1/2019 2:11:46 PM

X | Select

Client XEFT account info

routing an daccount number for XEFT transactions paid to !

transuser

4/1/2019 4:20:12 PM

¥ oy
¥ Istate it L
Report Name NumLock  Powered by Microsoft Access

Click Columns when you have selected a Custom report on the Reports screen to select which columns to include in

the query results. Select Custom > Custom Report Column List to see a list of the available column selections for

each custom report.

To use this group of columns again in the future, use Save New to save the selected columns as a Saved Custom

Report.

Click Select for a Custom Report to select that report.

If changes are made to the columns selected for a Selected Custom Report, use Save to save those changes. Use
Save New to save the selected columns as a new Saved Custom Report and leave the original report unchanged.
Saved custom reports can only be changed by the user who created them. To make changes to a report saved by

another user, use Save New.

Once the custom report and/or columns have been selected, click Close and use Query on the Reports screen to

view the results. This can be done without saving the custom report. Saving the selected columns as a custom report

just allows you to easily re-select those columns in the future.
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File Menu

The following file menu options are used for importing and exporting information in RPM.

Export Positive Pay File

IE  Representative Payee Manager

® - o x
File  RPM
Backup/Restore v f1 R Y i E_‘ﬁ <‘1 Client > 2 El ==t SO Find (@ Help
IR D G D & O 8 2 ;
Import/Export | p;chpoard Clients Transactions Vendors Reconcile List ~ Setup Reports | Users Change User (g Save A\ System Info
Maintenance Transaction v Password Settings C £ Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help 52
(5] Dashboard X [-3] Export Positive Pay File X 1%
Close Export | Reset

Select Checks to Export Positive Pay Export

Latest Positive Pay Export [5/20/2024 10:54:00 AM

@ Checks Not Exported

c aycheckDateRange| 07/19/2024 | 07/19/2024

Select Export File Format Select Standard Format Options

@ Standard Format - CSV File
o

Amount Format |N0 Decimal +  Example |$123.45 will export as 12345

If you are using the Checks Not Exported option, the checks will be marked as
exported when the export is complete. Click "Reset" to reset a positive pay
export and remove the "exported" flag for a selected process date.

The standard export file is a comma-delimited (CSV) file with the following fields:
* Account Number
* Check Number

Date Format Immddyy v Example 1071924 * Amount (format based on selected Amount Format)
Text Qualifier |None «  Example |123456785, 1000 * Check Date (format based on selected Date Format)
*PayTo
Select Account or Bank
& Account |Cl\eckingl % CsV files should only be opened for viewing using Notepad. Do not open/save
CsV files using Excel.
€ Bank [First National Bank v

rpmecs.com/resources/notepad/
Select Export File

Location

IC:\Shared Folder\RPM Documents\Export\RPM Positive Pay.CSV

Select File

Account Num Lock  Powered by Microsoft Access

Select Export Positive Pay File from the File, Import/Export menu to open this screen. This is used to export check
transactions to a file. The available options are outlined below.

Select Checks to Export
e Checks Not Exported - export any checks that have not been previously exported.
e By Check Date Range - export checks dated in a selected date range.

Latest Positive Pay Export
This field shows the date and time of the most recent Positive Pay export.

Select Export File Format

e Standard Format CSV File - export checks to a comma-delimited file containing the fields listed below.

*CSV files should only be opened for viewing using Notepad. Do not open/save CSV files using Excel,
or the correct formatting may be lost.**

e Account number
e Check number
e Amount
e Check date
e "Pay to" name
e Custom Format - Contact our office for more information about creating a custom export file format.
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Select Standard Format Options

e Amount Format - export the amount with or without decimals.
e Date Format - select the format for the check date.

e Text Qualifier - export the fields with or without double quotes.

Select Account or Bank
e Account - export checks for a selected account.
e Bank - export checks for all accounts assigned to a selected bank.

Select Export File
Select the export location and enter a file name using Select File.

Once the file has been selected, click Export to export the checks to the selected file. Checks will be marked as
exported when the export is complete.

Reset

Use the Reset button in the upper right of the screen to reset a positive pay export and remove the "Exported” flag on
the associated check payments.
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Export XEFT Transactions

IE  Representative Payee Manager - - a X
File  RPM
Backup/Restore ¥ E) )QO\ 74 E:‘ﬁ @ Client v .é) El Qi O Find (@) Help
@ o7 -
A
Import/Export Dashboard Clients Transactions Vendors Reconcile List ~ Setup Reports | Users Change User I save A System Info
Maintenance Transaction v Password Settings [ Paste A & Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help S
(5] Dashboard X [ ExportXEFT Transactions X
Close Report Export Send Emails Reset
P P
Select Date Range Select Account or Bank XEFT Export Click "Reset" to remove the "XEFT exported” flag.
Begin 01/20/2025] [ © Account [checking & Latest XEFT Export

End 01/20/2025

Select Export File Format
¢ Standard Format - CSV File

@ Standard Format - NACHA File
c

€ Bank [First National Bank v

Select NACHA File Type
€ Balanced File ID Modifier [A~

& Unbalanced

Select Transactions to Export

& Al

© paymentstoClients ¢ PaymentstoVendors ¢ Transfers

Select Export File

Location

r

|C:\Shared Folder\RPM Documents\Export\XEFTExport.txt

12/30/2024 10:45:39 AM

Enter NACHA File Options

Include Addenda Record with Memo ™

Select File

Transactions Not Exported

Bank Account Pmts. To First Date Last Date Amount Count &
>|First NationalBanliChecking IVendor ] 01/17/2075| 01/22/2025 $603.50 8 0
[irst National Bant [Smith-Jones, Catherine - Checl IClient | 01/06/2025 | 01/06/2025 $70.00 2

Total $882.00 15w

Begin Date

Select Export XEFT Transactions from the File > Import/Export menu to open this screen. This is used to export

Export File Format

* CSV file - can be sent to a debit card vendor or to your bank. Both mass and individual
account transactions can be exported to a CSV file.

* NACHA file - can be sent to your bank. Transactions can be exported from mass and

il account i ing on the NACHA File Type selected.

NACHA File Type

= Balanced - includes offset etries for the bank account from which the payments are being
made. Both mass and individual account transactions can be exported.

* Unbalanced - does not include offset entries. Only mass account transactions can be
exported.

NACHA File Options

» File ID Modifier - enter subsequent letters alphabetically if more than one file is sent on
the same day.

* Include Addenda Record with Memo - includes an addenda record containing the check
memo details for each payment.

A $0 XEFT transaction can be entered using Enter Payment on the Transactions screen to
send a pre-note transaction for a client or vendor.

CSV files should only be opened for viewing using Notepad. Do not open/save CSV files
using Excel.

rpmccs.com/resources/notepad/

Num Lock  Powered by Microsoft Access

XEFT transactions to a file. The available options are outlined below.

Select Date Range

Enter the date range for the transactions you want to export.

Select Account or Bank

Account - export transactions for a selected account.

Bank - export transactions for all accounts assigned to a selected bank.

Latest XEFT Export
This field shows the date and time of the most recent XEFT export.

Select Export File Format

Standard Format CSV File - export transactions to a comma-delimited file containing the fields listed below.

** CSV files should only be opened for viewing using Notepad. Do not open/save CSV files using Excel,

or the correct formatting may be lost. **
e Transaction date

e "Pay to" name

e Amount

e Routing number ("to" bank account)

e Account number ("to" bank account)

e "Mail to" name

e Address1

e Address 2
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City

State

ZIP

Check memo

Account type (checking or savings)
RPM client ID

Routing number (“from" bank account)
Account number ("from" bank account)

Standard Format NACHA File - export transactions to a NACHA text file. Each payment will be exported in a
Type 6 Entry Detail Record.

Select NACHA File Type - select the "Balanced" option to include offset entries for the bank account from
which the payments are being made. Select the "Unbalanced" option if offset entries are not required. Ask
your bank which option you should use.

File ID Modifier - enter subsequent letters alphabetically if more than one file is sent on the same day.

Include Addenda Record with Memo - select this to create a Type 7 Entry Detail Addenda Record for each
payment. This will export the check memo for each transaction in the addenda record.

Include Individual Accounts - select this to include transactions from individual accounts in the export file.
This option is only available with balanced NACHA files.

Custom Format - Contact our office for more information about creating a custom export file format.

Select Transactions to Export

All - export all outstanding XEFT and Export Transfer transactions.
Payments to Clients - export only XEFT payments to clients.
Payments to Vendors - export only XEFT payments to vendors.
Transfers - export only Export Transfer transactions.

Select Export File
Select the location and enter a file name using Select File.

Transactions Not Exported
This table shows details and counts for XEFT and Export Transfer transactions that have yet to be exported. Use this
as a guide when selecting export settings.

Report

Click Report to see a report of the transactions currently selected for export.

After exporting, view a report of XEFT transactions and the export information on the Reports screen under
Transactions > Exported Transactions.

Export

Once the file has been selected, click Export to export the transactions into the file.

After the export has been run, the transactions will be marked "Exported." Report on transactions included in a
specific export file on the Reports screen under Transactions > Exported Transactions.

A $0 XEFT transaction can be entered using Enter Payment on the Transactions screen to send a pre-note
transaction for a client or a vendor.

85



Reset

Use the Reset button in the upper right of the screen to reset an XEFT export and remove the "Exported"” flag on the
associated transactions. This can only be done if the transactions have not been reconciled.

View or remove the "Exported"” flag for individual transactions by clicking Details for an XEFT transaction on the
Transactions screen.

Send Emails

KB  Representative Payee Manager - a X
File RPM
Backup/Restore ¥ K v . B Client v N o = Find @ Hel
| B R P A B @ & B g i P ‘ D1
Import/Export ¥ | p;chboard Clients Transactions Vendors Reconcile List ~ Setup~ Reports | Users Change User | -2 I Save A\ System Info
Maintenance Transaction v Password Settings ) ©) Can'tUndo~ & 8 Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help i
(5] Dashboard X (5| Export XEFT Transactions X |5 Email Vendor Exported Transactions X X
Close Preview | Email | Test Email |
Select Date Select Vendor * Use the "Preview" button to preview the vendor reports that will be
& Export Date/Time A5 [DA TS S 0 AM S — | emailed based on the date selection.
© Export Date Range | 07/19/2024 | 07/19/2024  Use the "Email" button to automatically send the reports to each

€ Transaction Date Range vendor's email address.
* Use the "Test Email" button to send the reports to the "To Test Email"

Email Message address entered on the screen.

Reply To Email ‘
i Irpm@rpmccs o * Enter your own email for the "CC" or "BCC" email address to send copies

To Test Email I of the messages to yourself.

¢ I » To send emails to multiple recipients for a single vendor, enter multiple

BCC ljdog@rpmccs_mm email addresses separated by semicolons on the Vendors screen.

Email Subject IPaymentDetailsAnached

Email Message |The attached payments will be sent to you for clients on behalf of ABC Payee.

Export Date/Time Num Lock  Powered by Microsoft Access

The Send Emails button on the Export XEFT Transactions screen opens the Email Vendor Exported Transactions
screen. This screen can be used to email reports to vendors showing the transactions that have been exported for
that vendor. Emails will be sent to each vendor based on the email address entered for the vendor on the Vendors
screen.

The fields on this screen are explained below.

Select Date/Vendor

e Export Date/Time - select this to email reports for all the transactions sent in a selected export. Once emails
have been sent for a selected export, the date and time the emails were sent displays for that export to prevent
duplicate emails.

e Export Date Range - select this to email reports for all the transactions exported within the date range entered.
The "Vendor" selection will be available to send a report to a single vendor.

e Transaction Date Range - select this to email reports for all transactions dated within the date range entered.
The "Vendor" selection will be available to send a report to a single vendor.
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Email Message

e Reply To Email - the email address used for replies to the sent emails. Emails will be sent from the address
selected on the System Setup screen.

e To Test Email - the email address used with the Test Email button.

e CC - acopy of the emails will be sent to this optional address. For example, enter your email address to CC
yourself on the sent messages.

e BCC - ablind copy of the emails will be sent to this optional address. For example, enter your email address to
BCC yourself on the sent messages.

e Email Subject - the subject of the message.
e Email Message - the text to be included in the body of the message.

Click Preview to preview the reports that will be sent based on the date/vendor selections.

Click Email to automatically send the reports to each vendor's email address. When using the "Export Date/Time"
option, the email process will be logged in the audit events (as "Email XEFT Transactions"). For each individual

vendor email message, an audit event will be logged for each successful email ("Vendor Email Sent") or unsuccessful

email ("Vendor Email Failed").

Click Test Email to automatically send the reports to the "To Test Email” address. For example, use your own emai
address to send test emails to verify the "Email Subject” and "Email Message" are correct.
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Import ACH Deposits

IE  Representative Payee Manager

File RPM
Backup/Restore v K 7 =L ] Client ~ N 2 = Find
- B8 E P G & O R ke P
Import/Export ¥ | pachiboard Clients Transactions Vendors Reconcile List ~ Setup~ Reports | Users Change User | -2 I Save
Maintenance Transaction Password Settings A
File View Utilities Reports Security Edit Records Filter/Sort

(5] Dashboard X |3 Import ACH Deposits X

Close Reset

- - o 3¢
(@ Help
A\ System Info
£ Tech Support
Help S

Select Account Deposit Import Posting

Account ]checkingl M Latest Deposit Import Posting |7/19/2024 11:42:59 AM

Select Import File Format

Click "Reset" to remove the deposits imported for a selected process date.

CSV file is a comma-delimited file with the following fields:

@ Standard Format - CSV File " standard Format - NACHA File « Transaction Date (formatted as mm/dd/yy or mm/dd/yyyy)
* Amount

ol S . c

Standard Format - Fixed Length Text File » Social Security Number/Claim Number (numbers/letters only - no dashes)

* Deposit Type

Import File * Client Name

File Location

. = Fixed-length text file is a text file with the following format:
[C:\Shared Folder\RPM Documents\Import\SampleCSVDepositimport.csv Select File

 Transaction Date: 8 characters, positions 1- 8

Deposit File Date | 07/01/2024 Deposit Count 74 Deposit Amount $3,697.00 Import * Amount: 10 characters, positions 9 - 18

o Claim Number: 3 characters, positions 28 - 30
* Deposit Type: 50 characters, positions 31 - 80
¢ Client Name: 50 characters, positions 81 - 130

Select Report Type

© Unmatched Deposits Count] 0 Amountl

& Matched Deposits Count I 7 Amount | $3,697.00 Report Use the link below for details and sample import files:

rpmccs.com/resources/importing-deposits/

Select Deposit Date

©  Imported Deposit Date

€ Other Deposit Date [07/01/2024 Post

| LA

Account

 Social Security Number: 9 characters, positions 19 - 27

Num Lock  Powered by Microsoft Access

Select Import ACH Deposits from the File > Import/Export menu to open this screen. This is used to import deposit

transactions from a file provided by your bank.

Select Account
Select the account for which the deposits will be posted.

Latest Deposit Import Posting
This field shows the date and time the most recent deposit import was posted.

Select Import File Format

e Standard Format CSV File - import deposits from a comma-delimited file containing the fields listed below.

** Only open CSV files using Notepad. Do not open/save CSV files using Excel, or the correct formatting

may be lost. **

e Transaction date (formatted as mm/dd/yy or mm/dd/yyyy)

e Amount

e Social Security number/claim number (numbers/letters only—no dashes)
e Deposit type

e Client name

e Standard Format Fixed Length File - fixed-length text file with the format listed below.

e Transaction date: 8 characters, positions 1-8

e Amount: 10 characters, positions 9-18

e Social Security number: 9 characters, positions 19-27
e Claim number: 3 characters, positions 28-30

e Deposit type: 50 characters, positions 31-80

e Client name: 50 characters, positions 81-130
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e Standard Format NACHA File - import deposits from a NACHA text file. This is a standard bank file format.

e Custom Format - if your deposit file is not in one of the above formats, a custom format can be added to RPM.
Regardless of the format, all the above fields (excluding client name) must be included in your deposit file to
import deposits into RPM. Contact our office for information on adding a custom import file format.

Import
The first step is to import the file provided from your bank. Select the file to import using Select File.

Once the file is selected, click Import to import the file into RPM. When the file has been imported, the following
information displays on the screen:

o Deposit File Date - the date of the transactions in the deposit file.
e Deposit Count - the number of deposits in the file.
e Deposit Amount - the total monetary amount of all deposits in the file.

Report

The second step is to run the Unmatched Deposits and Matched Deposits reports. The number of deposits that will be
included in each report, along with the total monetary amount of both matched and unmatched deposits, appears on
the screen. Select the report you wish to run and click Report.

The Unmatched Deposits report shows deposits from the file that will not be posted for one of the following reasons:

e There is no RPM client matching the social security or claim number in the deposit file. The client must be added,
or the social security number or claim number must be entered for the client on the Clients screen.

e There is a matching client, but the client is not assigned to the selected account. The account must be added for
the client on the Clients screen.

e There is a matching client, but the client is inactive. The client's status must be changed to "Active" on the Clients
screen.

e The deposit date, amount, or category is missing from the imported deposit. If any of this information is missing in
the deposit file, the deposit cannot be posted.

Either correct the errors shown on the Unmatched Deposits report before continuing the post process or enter those

transactions manually.

The Matched Deposits report shows deposits for which there are matching client social security numbers or claim

numbers in the system. These deposits will be imported to the appropriate client when posted.

Post

The third and final step is to post the deposits. By default, the date from each imported transaction will be used as the
deposit date. Change this to a different date by selecting "Other Deposit Date" and entering the date. Click Post to
post the deposits into the RPM transaction register.

After the deposits have been posted, report on transactions included in a specific import file on the Reports screen
under Transactions > Imported Deposits.

Use the Reset button in the upper right of the screen to remove the deposits imported for a selected process date.
This can only be done if the transactions have not been reconciled.
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Configuration

s Representative Payee Manager - a X
File RPM
Backup/Restore v == o0 7 . = Client ~ BN o + | £ Find @ Help
(o] & '/V—J E v = \Em o8 [e=]
Import/Export ¥ . Setup v o = H save 1. System Info
Dashboard Clients Transactions Vendors Reconcile List Reports Users Change  User ”
Maintenance Transaction v Password Settings 7 Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help ~
Dashboard Import ACH Deposits X E Import Configuration X X
Close
SSN/Claim Number ------  ===-z-m-m- Client Name ---------- Not Each deposit type that has been imported in any of your deposit files will be
Import Deposit Type Located In Start End Located In Start End Category Used shown.
» i v - il L

X REARFARAI a0, 1 11 |Addenda Info 3 S75SA - To configure a deposit type, you have to assign the location for the SSN/Claim

X |SSI TREAS 310 Detail ID & 1| 11 |Addendainfo - 36| 57(ssl ad Number and the Client Name as well as the corresponding Category to be used

X |VACP TREAS 310 Detail ID v 1 15 [Detail Name 1 22 VA v T for that type of deposit.
The "Report" button will print a report showing the detailed deposits in the last
import file. You can use that report to find the location of the SSN/Claim Number
and the Client Name. There are three possible locations for the information:
* Detail ID (up to 15 characters) - this often contains the SSN/Claim Number.
* Detail Name (up to 22 characters) - this often contains your company name or
the Client Name.
» Addenda Info (up to 80 characters) - this is not always available. If it is
available, it may contain the SSN/Claim Number and/or the Client Name.
The position numbers are shown on the report for each column: Detail ID, Detail
Name and Addenda Info. Once you enter the "Located In" value and the "Start"
and "End" positions for both the SSN/Claim Number and the Client Name, you can
run the report again to see the results. When you close the Import Configuration
screen, you should import the latest file again if you made any changes to the
configuration.
Not all deposit types will contain a SSN/Claim Number for importing deposits. If
you have a type that does not contain that information, you can check the "Not
Used" option to ignore that type. Those deposits will show on the Unmatched
Deposits report and will have to be entered manually in RPM.

import Configur... 4 «[10f3 | » M Search

Import Configuration - Report

The Configuration button will only be enabled when using the Standard Format NACHA file option. Use this to

Num Lock  Powered by Microsoft Access

configure any additional deposit types that are added or changed after the initial configuration.

Each deposit type that has been imported in any deposit file will be shown. To configure a deposit type, assign the
location for the "SSN/Claim Number" and the "Client Name," as well as the corresponding "Category" to be used for

that type of deposit. Click Report to print a report showing the detailed deposits in the last import file. Use that report

to find the location of the SSN/claim number and the client name. There are three possible locations for the

information:

e Detail ID (up to 15 characters) - this often contains the SSN/claim number.
e Detail Name (up to 22 characters) - this often contains your company name or the client's name.

e Addenda Info (up to 80 characters) - this is not always available. If it is available, it may contain the SSN/claim

number and/or the client's name.

The position numbers are shown on the report for each column: "Detail ID," "Detail Name," and "Addenda Info." Once
the "Located In" and "Start" and "End" positions for both the SSN/claim number and the client name are entered, run

the report again to see the results. After closing the Import Configuration screen, import the latest file again if any

changes were made to the configuration.

Not all deposit types will contain an SSN/claim number for importing deposits. For any deposit types that do not
contain that information, check the "Not Used" option to ignore that type. Those deposits will be shown on the
Unmatched Deposits report and must entered manually in RPM.
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Utilities Menu

The following utilities are used for system setup and maintenance.

List Maintenance
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File RPM
Backup/Restore v Zl e® 7N e | ﬁ = Client v E= 2 P Find @ Help
. o & ) B v LM o8 = =
Import/Export v Setup~ B3 Copy | Hsave 1 System Info
Dashboard Clients Transactions Vendors Reconcile List Reports | Users Change User | _ =
Maintenance Transaction v Password Settings | 03 Paste {7 Tech Support
File View Utilties Reports Security Edit Records Fiter/Sort Help ~
%) Dashboard X 5| ListMaintenance X 3
close |
Select List Payment Category
= ~Descript
Account Manager B
AT 8 (= ®)jCateaory; Boect Group Inactive 1 | used to set up categories for payment
SSELIYpE. »| x [Bank Fee Other I transactions.
z:::NotescomaaType ijcuile e ‘
et X [car Payment Other T +The Report Group is used to further
e BEiGe rrrm T categorize payments for reports. The same
GlientType: — = . group can be used for one or more payment
County x |child support Other categories.
County District x [Client Fees Payee Fee ]
Custom List 1- Education level [ x [clothing e T sUse the "Merge" button to move all
Custom List 2 - Career field Imllrsoa Foodaml Hausing T transactions in one category to another
Custom List 3- Dependent childr  (— o : category.
Custom List4- Pets Jmi-%i|Gasoling iz X
Custom List 5 - Preferred commu | | X [Insurance Other
Custom List 6 - Religious affiliatic X |Legal fees Other I
Custom List 7-Title x |Medical Other I
Deposit Category [ x [MiscPayment Other T
E‘h“‘“'y X [Mortgage Pmt Food and Housing T
vent 1
x |Personal Needs Other I
Gender — T
Housing Type [ X |Phone Other
Impairment x |Rent Food and Housing T
Legislative District x [spending Other T
Marital Status X [Tax Payment Other :
Mass Account X [Transfer Other T
Payment Category
Pronouns Merge —
Select List NumLock  Powered by Microsoft Access

Select List Maintenance from the Utilities menu to open this screen. This is used to maintain the available values in
the various lists in the system.

Click the list you wish to maintain under the "Select List" option. The corresponding list displays on the screen.
Click the + button to add a new item to a list.
To delete an item from a list, click the X button next to the item.

The current available lists are:

e Account Manager - account managers and each manager's RPM user ID. Clients can be assigned to an
account manager on the Basic tab of the Clients screen. Some reports can be filtered by account manager.

e Asset Type - asset types. Asset types are used on the Assets tab of the Clients screen.

e Banks - banks assigned to accounts. Banks are assigned to mass accounts under the "Mass Account” list and
assigned to individual accounts on the Basic tab of the Clients screen.

e The "Routing Number" should be entered if you are printing the encoding line on your checks.
e The "Bank Information" should be entered if your bank information is not pre-printed on your checks.

e The "ACH File ID" is used for the Immediate Origin number in the File Header record of a NACHA file. It is
often a 1 followed by your Federal Tax ID number. Check with your bank to confirm.

e Case Notes Contact Type - case notes contact types. Case notes contact types are used on the Case Notes
tab of the Clients screen.

e Client Contact Type - client contact types. Contact types are used on the Contacts tab of the Clients screen.

e Client Type - client types and groups. The client type is used on the Basic tab of the Clients screen. Some
reports can be filtered by client type.

e The "Batch Payment" option defaults transactions to "Batch Payments" if the client type and vendor are both
marked as "Batch Payment."

e The "Apply Fee" flag is used by the Client Fee Posting utility. Only client types with this flag will have fees
applied.
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County - counties. Counties are used on the Personal tab of the Clients screen.

County District - county district codes and descriptions. The county district is used on the Personal tab of the
Clients screen.

Custom Lists 1 through 10 - custom list values. The custom lists are used on the Custom tab of the Clients
screen. Custom lists can be configured on the Custom Client Fields tab of the System Setup screen.

Deposit Category - deposit categories. Deposit categories are used to categorize deposit transactions.

e The "Apply Fee" flag is used by the Client Fee Posting utility. Only deposit categories with this flag set will be
included in the fee calculation.

e The "Report Group" is used to further categorize deposits for reports. The same group can be used for one or
more deposit categories.

e Use Merge to move all transactions from one category to another category.

Ethnicity - ethnicity values. Ethnicity is used on the Personal tab of the Clients screen.

Event - events and event categories. Events are used on the Events tab of the Clients screen.
Gender - gender values. Gender is used on the Personal tab of the Clients screen.

Housing Type - housing types. Housing types are used on the Housing tab of the Clients screen.

Impairment - impairment and impairment categories. Impairments are used on the Impairments tab of the
Clients screen.

Legislative District - legislative district codes and descriptions. The legislative district is used on the Personal
tab of the Clients screen.

Marital Status - marital status codes and descriptions. Marital status is used on the Personal tab of the Clients
screen.

Mass Account - mass accounts. Clients are assigned to these account(s) on the Basic tab of the Clients screen.

e The "Account Number" should be entered and the "Bank" selected if you are printing the encoding line on
your checks.

e The account type (checking or savings) and next check number that will print in the account are required.

e The "ACH Company ID" is used for the Company ldentification number in the Batch Header records of a
NACHA file. It is often a 1 followed by your Federal Tax ID number. Check with your bank to confirm.

e Check the "Default Acct." box for the primary mass account (if more than one).

e Check the "Inactive" box for an account that will no longer be used.

e Use Move Acct to automatically move clients from an old to a new mass account.

Payment Category - payment categories. Payment categories are used to categorize payment transactions.

e The "Report Group" is used to further categorize payments for reports. The same group can be used for one
or more payment categories.

o Use Merge to move all transactions from one category to another category.
Pronouns - pronoun values. Pronouns are used on the Personal tab of the Clients screen.
Race - race values. Race is used on the Personal tab of the Clients screen.

Referral Source - referral sources. The referral source is used on the Personal tab of the Clients screen.

Subcategory - optional subcategory for transactions. Transactions can be totaled by subcategory.

Support Type - support types. The support type is used on the Basic tab of the Clients screen. Some reports
can be filtered by support type. Transactions can only be entered for clients if "Allow Transactions" is checked.

Termination Reason - termination reasons. The termination reason is used on the Personal tab of the Clients
screen. -

Test Type - test types and test categories. Test types are used on the Test Scores tab of the Clients screen.

Ward Number - ward number codes and descriptions. The ward number is used on the Personal tab of the
Clients screen.
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Mass Account Update

Backup/Restore ~ &G ?‘

Import/Export ~

Dashboard Clients Transactions Vendors Reconcile List
Maintenance

File View Util
Dashboard List Maintenance X E Mass Account Update X
Close Update |

Select Accounts

Move FROM Old Account |checking v

Move TO New Account " v

[~ Select Options
Include Inactive Clients |

Transfer Balances to New Account ™

Transfer Date 01/30/2024

This will assign the new mass account to all clients who are currently
assigned to the old mass account. All scheduled payments, deposits,
and transfers for the old account will be assigned to the new account. If
selected, transfers will be entered to move each client's current
balance from the old to the new account.

Select Move Acct under the "Mass Account” list on the List Maintenance screen to open this screen.
The Mass Account Update screen is used to move clients from an old mass account to a new mass account.

The information to be entered includes:

Select Accounts
¢ Move FROM Old Account - the mass account from which clients will be moved.
e Move TO New Account - the mass account to which clients will be moved.

Select Options
¢ Include Inactive Clients - select this to include inactive clients.

e Transfer Balances to New Account - select this to automatically enter transfers moving each client's existing
balance from the old to the new account. The date for the transfer must be entered.

Click Update to move clients from the old to the new account. Based on your selections, a message displays showing
what will be included in the update. The update will assign the new mass account to all clients who are currently
assigned to the old mass account. All scheduled payments and deposits for the old account will be assigned to the
new account. If selected, transfers will be entered to move each client's current balance from the old to the new
account. A message displays when the update is complete.
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Client Utilities

Archive Case Notes

@ Representative Payee Manager

File RPM
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Archive Case Notes Prior To 01/20/2023[ E

[ Case Notes Information

Number Case Notes |4—4—1——
Earliest Date [m
Latest Date [01/02/2025°
Number To Archive [344—-

Case notes that have been archived can be viewed under:
* Reports > Case Notes > Archived Case Notes By Client
* Reports > Custom > Case Notes Archived

Select Archive Case Notes from the Client section of the Utilities menu to open this screen.

This is used to archive older case notes. Archived case notes no longer display on the Clients screen but can be
viewed on reports.

Select "All" clients or only "Inactive" clients.
Enter the archive date.

The total number of case notes, earliest and latest case note date, and the number to be archived are displayed.
Click Archive to start the process. A message displays reminding you to create a backup before beginning the
archive process. Answer Yes to continue.

A final message prompts you to continue the archive process. Select Yes to continue or No to cancel. After selecting
Yes, do not cancel or interrupt the archive process. A message displays when the archive is complete.

Archived case notes can be viewed on the Reports screen under Case Notes > Archived Case Notes By Client and
Custom > Case Notes Archived.
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Case Notes Posting
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Select Case Notes Posting from the Client section of the Ultilities menu to open this screen.
This is used to add case notes to all active clients or by client type and/or account manager.

The information for the case notes includes:

e Case Note Date - the date for the case note.

e First-Repeat - select whether this is the first or a repeat occurrence of the case note.
e Service Unit - the service units associated with the case note.

e Contact Type - select a contact type for the case note.

e Case Note - enter any notes for the case notes.

Once all the information has been entered, click Post to automatically create the case note records.



Client Information Update
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Select Client Information Update from the Client section of the Utilities menu to open this screen.

This is used to quickly update values shared by a group of clients, including account managers, client types and
support types, and balance minimums and limits.

Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support
types are assigned to your user ID, you will only be able to update information for those types of clients. If client types
or support types have NOT been assigned to your user ID, you will be able to update information for all clients.
"Access Limited to assigned Client Types and/or Support Types" displays at the top of the screen if your user ID has
been set up for client and/or support type filtering.

Client Filter

The "Client Filter" is used to filter scheduled deposits by the account manager, client type, support type, or status. The
default filter on this screen displays only active clients. Click Clear Filter to remove any client filters.

Update Clients

Once you have the desired set of clients displayed, enter the information that you want to automatically change.
Automatically update any or all the following: "Account Manager," "Client Type," "Support Type," "Balance Minimum,"
"Balance Limit," and/or "Mail Statement." If you leave any of these items blank, the information will remain unchanged.
The balance minimums and limits will only be updated if you enter an amount greater than zero.

Update/Update All

Click Update to the left of a client to update the information on that individual client. Click Update All to update all
clients shown. A message will display asking you to confirm the update before it is processed. Changes will be logged
in the audit events.

Individual clients' information can also be updated manually on this screen.
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Delete Client
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This is used to completely remove a client from the system. This should only be used to delete clients that have been entered in error. Once a client
has transactions entered, you cannot delete the client. Instead, set the Status to "Inactive" on the Clients screen. This will preserve the client's history
in the system but no longer allow transactions to be entered for that client.

Select Delete Client from the Client section of the Utilities menu to open this screen.

The Delete Client screen is used to completely remove a client from the system. This should only be used to delete
clients that have been entered in error. Clients with transactions cannot be deleted. Instead, set the "Status" to

"Inactive" on the Clients screen. This will preserve the client's history in the system but prevent any additional
transactions for them.

To delete a client, select the desired client from the list. The client's name and type display for verification. Click
Delete to delete all information for the selected client.
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Setup Utilities

Check Layout

KB  Representative Payee Manager - a 3C
File RPM
Backup/Restore v En R 4 "i EH <7 Client v 2 E] = S Find % (@ Help
b & B ) & [ e R - : s
Import/Export* | pashinoard Clients Transactions Vendors Reconcile List ~ Sewe~ Reports | Users Change User I Save A SystemInfo
Maintenance Transaction v Password Settings 2 £ Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help -
(3] Dashboard X [=3] Check Layout
Close | Test Check | | | To learn more about adjusting the check layout:  rpmccs.com/resources/adjusting-check-layout/
Check Layout Blank Check Fields Check Sorting Printer Sample Layouts
Check Format Margins [ [Field Positions Optional Field Positions Click "Help" to see detailed
Check Type [Voucher Checks] v Top 0.250 Erintion RN IoD L Insteuctionson settingUpyour
= Date 6.5 Memo 4 25 check layout.
Check # Print Check Numbers v Bottom | 0.200
Stub1 4 3.7

o
0.2 "Top" values represent the
0.2

distance in inches from the top

Left 0.250 kaylo -
v
Page Size Right '—0‘250 Amount s
A Amount Text
Check Height 10.5

3

6.5 Stub2 4 72
margin of the check.

Void Message M 1.55 5.2 Void After Days| 90

. i "Left" values represent the

Hide Mail To when same asPayTo ™ 5 = P f

Vendor Batch Check Options distance in inches from the lef

margin of the check.

ol.Ll¢
Jelele[3

Font Mail To 1.6

Address 1.8
Check Font |Courier New Select Font

Uppercase Pay To/Mail To Address ™

Hide details on Stub for Checks with more than 7lines I™
Print Batch Check Details Report after Checks v * Tomoyea Held dowron the
check, increase the value in the
“Top” column.

Allow Individual * To move a field up on the
Print  Top Left  Shared Signature File User Signatures check, decrease the value in the

s 7 “Top” column.
signature1 M 1.7 4.7 |C:\Shared Folder\RPM D \Sig \Signatur 1.bmp Select Eile)]|\Remave File L * To move a field right on the
Signature 2 ke 23 4.7 |C:\Shared Folder\RPM D \Sig! igl 2.bmp SelectFile | Remove File |1 check, increase the value in the

&
a

Electronic Signature

Maximum Amount for Signature(s) 50.00 (Use $0 if no maximum) For Electronic Signature details: rpmccs.com/resources/electronic-signatures-on-checks/ Left” column.
* To move a field left on the
Check Message check, decrease the value in the
i “Left” column.
Print  Top Left

Message | 0 [

Type of checks you will be printing Num Lock  Powered by Microsoft Access

Select Check Layout from the Setup section of the Utilities menu to open this screen.

RPM can be set up to work with many different types of checks using the Check Layout screen. For check paper
details, see our Knowledge Base article: rpmccs.com/resources/check-paper/. For any questions about checks you
currently use, contact us.

Click Test Check to print a test check using the information entered. When printing a test check, boxes outlining each
field can be included. This can assist in positioning fields and determining any potentially overlapping fields. The
outline boxes will not print on live checks. If "Preview Checks before Printing" is checked on the Printer tab, the text
check will open in a Print Preview that can either be printed or closed.

Click Save to save any changes to the check layout.
Click Close and select Yes to close without saving changes.

Check Format
e Check Type

e Voucher Checks - laser printer checks with one check and two stubs per page.

e Standard Checks - laser printer checks with three checks per page and no stubs.

e Continuous Checks - dot matrix printer, continuous feed checks with or without stubs.
e Check #

e Print Check Numbers - select this if your check paper does not have pre-printed check numbers. This option
requires a MICR font and MICR toner to print encoding on checks. Enter the account number and select the
bank for each mass account on List Maintenance > Mass Account. For individual accounts, enter the account
number and select the bank on the Basic tab of the Clients screen. Enter the routing number and bank
information for each bank on List Maintenance > Bank.

e Use Numbered Checks - select this if your check paper has pre-printed check numbers.
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Page Size
All measurements are in inches.

The "Check Height" is the vertical size of the check less any margin. For voucher checks, this will usually be 10.5. For
standard checks, this will be 3.5. For continuous checks, this should be the actual height of a single check/stub from
your continuous forms.

Margins
Set your desired margins in the "Margins" section of the screen. If the margins are set smaller than your selected
printer will allow, printing a Test Check will automatically set the smallest allowable margins.

Font

Use Select Font to select the font to be used on checks. This only applies to the font used on the check, not on the

check stubs. Only the "Font" can be changed. The font "Size" cannot be changed. After changing the font, use Test
Check to print a test check and answer Yes to include boxes outlining each field. This will confirm the selected font

will print correctly in the space available for each field.

Field Positions

The "Field Position" values determine where each field is located on the check. The "Top" value is the distance of the
field from the top of the check after the margin. The "Left" value is the distance of the field from the left edge of the
check after the margin. For example, if the date field should print 1.25" from the top of the check and the top margin is
0.25", enter a "Top" value of 1 for the field. If the date field should print 6.75" from the left of the check and the left
margin is 0.25", enter a "Left" value of 6.5 for the field. To prevent fields from overlapping, the "Top" values should be
at least 0.2" apart. For example, if the "Mail To" top value is 1.8, the "Address" top value should be 2. All fields print on
a single line and need to be at least 0.2” apart on the check except the following:

e Address - prints up to 3 lines (address 1, address 2, city/state/zip) - height 0.6"
e Check Stub - height 2.5"

e Signature - height 0.5"

e Message - prints up to 3 lines - height 0.5"

e Company Info - prints up to 4 lines - height 0.625"

e Bank Info - prints up to 3 lines - height 0.4"

To easily position the fields on the check, use Test Check to print a sample check. If a field is not printing in the
desired location, measure the difference from the top left of the current location to the top left of the desired location
and add or subtract that amount from the "Top" and "Left" values.

The fields below can be turned on or off on the check with the "Print" box for that field.

¢ Amount $ - when checked, prints a dollar sign ($) to the left of the check amount. Use this if the dollar sign is not
pre-printed on the checks.

e Hide Mail To when same as Pay To - when checked, the "Mail To" name will not print if it is the same as the
"Pay To" name. This would normally be used if your "Pay To" and "Mail To" print together on the checks. If these
lines print in two different locations, do not check this option.

e Memo - when checked, the memo will print on the check. The memo will always print on check stubs if stubs are
selected to print.

e Stub 1 and Stub 2 - when checked, prints one or two check stubs including the following information: company
information, "pay to," check number, date, amount, and account manager (if sorting by account manager). The
check stub also includes up to 7 detail lines showing the amount, client, check memo, and category for each line
item on the check.

e Void Message - when checked, prints "Void After X Days" on checks. Enter the number of days to use in the
void message.

e Signature 1 and Signature 2 - when checked, one or two electronic signatures can be printed. See the
"Electronic Signature" details below.
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Vendor Batch Check Options

e Hide details on stub for checks with more than 7 lines - when checked, the check stubs will NOT display batch
detail lines if there are more than 7 lines. All batch details lines will be shown instead on the Batch Check Details
report.

e "Print Batch Check Details Report after Checks" - when checked, the Batch Check Details report displays
automatically following the check run if it includes any batch checks to vendors.

Electronic Signature

To include electronic signatures on the check, check the box for "Signature 1" and/or "Signature 2." Set the position
for these fields and use Select File to select the signature file(s). To remove existing signature files, click Remove
File. Signature files should not be larger than 3" x 1/2".

For each signature slot selected to print on checks, the ability of individual users to set their own unique signature files
can be enabled by checking "Allow Individual User Signatures." Individual users' signature files can be managed on
the User Settings screen.

Enter a value in the "Maximum Amount for Signature(s)" field to electronically sign checks up to that amount. Any
checks over the maximum amount will be printed without the signature and must be signed manually. To sign all
checks electronically, set the maximum amount to $0.

Check Message
To include a message on your checks, check the box for "Message," set the positions for the message, and enter the

message text to use. The message can only be printed when using voucher checks for the "Check Type."
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(maximum 4 lines) 587 First Street SRS "Left" values represent the
Client Name 0.625 0 Louisville, KY 40205 3 R
2, Eorindiidiial - e th ; distance in inches from the left
Bank Info v 0 25 or individual accounts, enter the accoun e e e
P Eoiabel v ) number for each client on the Basic tab of the
aydolabe 1 0 Client Name Label JF"" Clients screen. « To move a field down on the
Dollars Label 14 14 7 check, increase the value in the
SignatureLinel 22 a7 Enter the routing number and bank information “Top” column.
S ines 57 o for each bank using the Bank list on the List * To move a field up on the
8 = Maintenance screen. check, decrease the value in the
Encoding 3 15 “Top” column.
Check # Min. Length 6 * To move a field right on the
check, increase the value in the
“Left” column.
* To move a field left on the
check, decrease the value in the
“Left” column.
Check Layout Num Lock  Powered by Microsoft Access

Information on the Blank Check Fields tab is only enabled if "Print Check Numbers" is selected for the "Check #"
option on the Check Layout tab. If you are using pre-numbered checks, the Blank Check Fields tab will be disabled
and cannot be used. For pre-numbered checks, all of this information must be pre-printed on your checks: check
number, company information, bank information, "pay to" label, dollars label, signature line(s), and encoding.
Encoding includes the check number, bank routing number, and bank account number.
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For individual accounts, the client's name will automatically print on the check following the "Client Name Label." This
should be positioned below the "Company Information." The height of the "Company Information” is 0.625", so the
"Client Name" top value should be 0.625" more than the "Company Info" top value. For mass accounts, the "Client
Name" and "Client Name Label" will not print on the check—only the "Company Information" will print on the check.
The "Company Information” is set up for 4 lines of information. For a second instance of the "Company Information,"
check the "Company Info 2" box.

When using checks without the encoding but with labels, turn off the fields that are already on the check paper: "Bank
Info," "Pay To Label," "Dollars Label," "Signature Line 1," and "Signature Line 2." When using completely blank check

paper, select those fields to print.

The "Account Name" field is optional. Enable this field to print the name of the bank account for the relevant
transaction on the checks.

Enter a value in the "Check # Min. Length" to zero-fill the check numbers in the encoding line to print as the same
minimum length. For example, some clients may use 4-, 5-, or 6-digit check numbers. Enter 6 as the Check # Min.
Length to print all check numbers with 6 digits. Check 1000 will then print as 001000 in the encoding line.

To print encoding on checks, a MICR font and MICR toner must be used. The only fonts that work with RPM are
included in the RPM Client install: MICR, MICRN, MICRN2, MICRW, MICRW2, MICRdark, MICRdarkN, MICRdarkN2,
MICRdarkW, and MICRdarkW?2. Select the font using Select Font.

Check Sorting

Representative Payee Manager

File  EECY]
Backup/Restore ¥ m— e® 7 N = Client N 2 +F | Yot | PFind
B & O B V| S i) | o [
Import/Export Setup ~ . Eg Copy | B save
Dashboard Clients Transactions Vendors Reconcile List . Reports | Users Change User
Maintenance Transaction v Password Settings
File View Utilities Reports Security Edit Records

=] Dashboard X [-3| Check Layout

Close |

Test Check | Save Printer

Save |

@ Help
1 System Info

.7 Tech Support

Filter/Sort Help

Check Layout Blank Check Fields Check Sorting printer Sample Layouts

Account Sorting

Bank Account L

Client Check Sorting
Account Manager r
With or Without Mailing Address |

Name/Date Sort
@ Client, Date

€ Date, Client

Vendor Check Sorting
Account Manager r
With or Without Mailing Address L]

Name/Date Sort
& Vendor, Date, Client

€ Date, Vendor, Client

* Account Sorting - only available if "Print Check Numbers" is selected for the Check # option on the
Check Layout tab. If this option is selected, checks will print in bank account order and client checks will
print followed by vendor checks for each account. If this option is not selected, client checks for all
accounts will print followed by vendor checks for all accounts.

« Client Check Sorting - checks will be sorted by account manager if that option is checked. Checks
without a mailing address will sort next, followed by checks with a mailing address if that option is
checked. Checks will then be sorted by either the client name and then date or the date followed by
the client name.

¢ Vendor Check Sorting - checks will be sorted by account manager if that option is checked. Checks
without a mailing address will sort next, followed by checks with a mailing address if that option is
checked. Checks will then be sorted by vendor name, date, and client name or date, vendor name, and
client name.

Use the "Preview" button on the Print Checks screen or use Reports, Transactions, Unprinted Checks to
preview checks to be printed and review the sort order.

Click "Help" to see
detailed instructions on
setting up your check
layout.

Account Sorting - Bank Account

Num Lock  Powered by Microsoft Access

The Check Sorting tab is used to set the order in which checks will print. Checks can be sorted by the following:
e Bank Account (optional)
e Client Checks

Account Manager (optional)
With or Without a Mailing Address (optional)
"Client Name, Date" or "Date, Client Name"
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e Vendor Checks
e Account Manager (optional)
e With or Without a Mailing Address (optional)
¢ "Vendor Name, Date, Client Name" or "Date, Vendor Name, Client Name"

The first sort option is by bank account. This option is only available if "Print Check Numbers" is selected for the
"Check #" option under Check Format. When using pre-numbered checks, this option is not available, since checks
can only be printed for one bank account at a time. If this option is selected, checks will print in bank account order,
and within each account, client checks will print followed by vendor checks. If this option is not selected, client checks
for all accounts will print, followed by vendor checks for all accounts.

There are three possible selections for sorting checks paid to clients. The first option is to sort by account manager.
The second option is for sorting checks with or without a mailing address. If this option is selected, client checks
without mailing information will print first, followed by client checks with mailing information. The third option is for
sorting by client name and then date or by date first and then client name.

There are also three possible selections for sorting checks paid to vendors. The first option is to sort by account
manager. The second option is for sorting checks with or without a mailing address. If this option is selected, vendor
checks without mailing information will print first, followed by vendor checks with mailing information. The third option
is for sorting by vendor name, date, and then client name or by date, vendor name, and then client name.

See the sort order of checks before printing on the Reports screen under Transactions > Unprinted Checks. Change
the sort settings on the Check Layout screen and run the report again to see how the changes affect check sorting.

Printer
@ Representative Payee Manager
File RPM
Backup/Restore ¥ - L‘f r == <—| Client v r e-.‘
E f 7 N4 4] | o%g K
Import/Expost; Dashboard Clients Transactions Vendors Reconcile List Setup: Reports Users Change  Us¢
Maintenance Transaction v Password Settir
File View Utilities Reports Security
j Dashboard X E Check Layout
Close | Test Check | Save Printer To learn more about adjusting the check lay:
Check Layout Blank Check Fields Check Sorting Printer  Sample Layouts
Select Printer
© Default Printer ]Microsoft Printto PDFI
& specific Printer ]\\ \Brother HL-L2370DW series Printer

Printer Tray ]Upper tray e

© Advanced Printer |Microsoft XPS Document Writer

W preview Checks before Printing

Select a Specific Printer and Printer Tray to print your checks to a location other than your default printer.
Select Advanced Printer and click "Settings" to set other advanced printer settings.
Check "Preview Checks before Printing" to display a preview of checks when clicking "Print."

Click "Save Printer" to save your selected print options.

The Printer tab displays your current Check Printer information.

e Your current Default Printer displays at the top of the screen. To use a different printer, select the "Specific
Printer" option and choose a printer from the dropdown list.

e After selecting a printer, you can change the tray your checks will print to using the "Printer Tray" dropdown. If
you have selected a PDF printer, the tray will default to the "Forms" tray.
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e To change advanced printer settings, select the "Advanced Printer" option and click Settings. Save this
advanced printer as your selection to continue using these settings.

e Check "Preview Checks before Printing" to display a Print Preview when you print a check or a Test Check.

Test checks can be reviewed here and either printed from the preview or closed.
e To save your printer, tray, and preview selections for printing checks, click Save Printer.

Sample Layouts

Backup/Restore ~ %o :‘?a ,://‘j E Sf Client ~ IE

Import/Export ¥ i i . X Setup v
Dashboard Clients Transactions Vendors Reconcile List Reports
Maintenance Transaction v
File View Utilities Reports

=] Dashboard X [-5| CheckLayout

Close I Test Check | Save Printer Save

Check Layout Blank Check Fields Check Sorting Printer Sample Layouts

Sample Layouts

Sample Layout Check Type

3 Checks Per Page Standard Checks {Use Layout:
Check/Stub/Stub Voucher Checks Use Layout
Stub/Check/Stub Voucher Checks Use Layout
Stub/Stub/Check Voucher Checks Use Layout

Click "Use Layout" to change the current check layout to one of the sample layouts.
Use the "Test Check" button to print a test check with the changes.

Make any additional changes on the Check Layout and Blank Check Fields tabs.
Click "Save" to save the changes or "Close" to discard the changes.

For further details on the sample check layouts: rpmccs.com/resources/check-print-layout/

The Sample Layouts tab is used to change the check layout to any of the available sample layouts. The initial default

layout is a voucher check followed by two check stubs.

Click Use Layout to change the current check layout to the selected sample layout.

Use Test Check to print a test check with the new layout.

Make any changes to the layout on the Check Layout and Blank Check Fields tabs.

Changes can be saved using Save or discarded using Close.
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System Setup

Select System Setup from the Setup section of the Utilities menu to open this screen. This is used to set default
options in RPM. The settings on this screen apply to all RPM users.

System Settings Tab

KB Representative Payee Manager - - a X
File RPM
Backup/Restore v fq . 4 i E,‘ﬁ <7 Client ¥ 2 El s £ Find Z | Descending @
AR ) 5 [4) | s® 23 -
Import/Export ¥ | o chboard Clients Transactions Vendors Reconcile Lst ~ Setup~ Reports  Users Change User - I Save Help
Maintenance Transaction v Password Settings “) Can'tUndo~ | % Ascending M
File View Utilities Reports Security Edit Records Filter/Sort o
(5] Dashboard X |3 System Setup
Close
System Settings Custom Client Fields Security Settings User Schedule
Data Entry Settings Transaction Settings Report Settings For system settings details:
Auto-Capitalize Name and Address for Clients/Contacts/Vendors 14 Default Number of Days for Displaying Transactions ga Hide ssN M rpmccs.com/resources/system-settings
Mail Statement to Client ¥ Negative Balance Check
Defaults for New Pay to Clients (Scheduled and d) Balance on Transaction Date @ on ¢ Off Warn -
Mail to Client Address ¥ Total Account Balance Warn v
Payment Method |Print v Transaction Date Check \Warn v
Defaults for New Vendors Days in the Past 180
Payment Method |Print v Days in the Future 180

Sort Checks by Client Name r

Sort Settings Email Settings For email settings details:
Use descending date order on Clients screen ¥ Outgoing Mail Server (SMTP) Test Email rpmecs.com/resources/email-settings/
SSL Authentication r
Balance Highlight Settings ’—
Under Minimum " Default Acct. & All Accounts I ~ &
Over Limit © Default Acct. & All Accounts | (2] (O
Default Number of Days for Displaying Transactions Num Lock  Powered by Microsoft Access

Fields on the System Settings tab are explained below.

Data Entry Settings

e Auto-Capitalize Name and Address for Clients/Contacts/Vendors - check this option if you want the first
letter of each word in a name or address automatically capitalized. For example, if you enter "123 first street," it
will automatically be changed to "123 First Street."

e Mail Statement to Client - check if you want to mail the Client Statement (Window Envelope) report to each
client's mailing address. The option can be turned on or off for each client.

e Defaults for New Payments to Clients

e Mail to Client Address - check this option if you want checks paid to clients to automatically include the
client's address on the check by default. The option can be turned on or off for each transaction.

e Payment Method - select the default payment method to use when entering payments to clients. See details
for the available payment methods in the Payment Methods topic.

e Defaults for New Vendors

e Payment Method - select the default payment method to use when entering new vendors. See details for the
available payment methods in the Payment Methods topic.

e Sort Checks by Client Name - check this option to have checks paid to vendors sort by the client's name
instead of the vendor's name by default. This option can be turned on or off for each vendor. The setting
entered here will be the default for new vendors.
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Sort Settings

e Use descending date order on Clients screen - check this option if you want the most recently dated records
to show at the top of each list on the Clients screen. This includes Housing, Income, Events, Case Notes, Test
Scores, and Assets.

Balance Highlight Settings
These settings pertain to the client account balances that appear in multiple locations on the Basic Tab of the Clients
screen.
e Under Minimum
e Default Acct. - Highlight only the balance of the client's default account if it falls below their minimum.
e All Accounts - Highlight all account balances if they fall below the client's minimum.
e Over Limit
e Default Acct. - Highlight only the balance of the client's default account if it rises above their
maximum.
e All Accounts - Highlight all account balances if they rise above the client's maximum.

Transaction Settings

o Default Number of Days for Displaying Transactions - enter the maximum number of days old you want
displayed transactions to be on the Transactions screen. With a large mass account, using a lower default
number of days will allow the Transactions screen to open faster. You can change the date range to view older
transactions.

e Negative Balance Check

e Balance on Transaction Date - select the option to warn about or prevent negative balances based on the
client's account balance on the date of a transaction. Select "Warn" to display a warning message when
transactions are being entered that causes a client to have a negative balance. Select "Prevent" to stop
transactions from being entered that cause a client to have a negative balance. If this option is turned off, only
the total account balance will be checked.

e Total Account Balance - select the option to warn about or prevent negative balances based on the client's
total account balance. Select "Warn" to display a warning message when transactions are being entered
that cause a client to have a negative balance. Select "Prevent" to stop transactions from being entered that
cause a client to have a negative balance.

e Transaction Date Check - select the option to warn about or prevent transaction dates outside of the selected
past/future date range. Select "Warn" to display a warning message, or select "Prevent” to stop transactions
outside of the selected past/future date range. Enter the number of days to check for "Days in the Past" and
"Days in the Future." Any transaction dates entered outside of this range will display a warning message or be
prevented from being entered based on your settings.

Report Settings

e Hide SSN - check this option to default reports to hide the client's social security number. The option can be
turned on or off when running reports.

Email Settings

The email settings are used for sending reports to yourself, vendors, and clients. You may need to get this information
from your IT department or from your internet provider. Click Test Email to test your email settings. Each user can
enter their own email address on the User Settings screen.

See our Knowledge Base article rpmccs.com/resources/email-settings for examples using Office 365 or Gmail.
e Qutgoing Mail Server (SMTP) - the host name for your outgoing email.

e SSL Authentication - check this option if your outgoing mail server requires authentication, and fill in the
remaining fields below.

e Port (Outgoing Server SMTP) - enter the port for your outgoing mail server.
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e Logon Name/Email - enter the login name for your outgoing mail server.

e Password - enter the password for your outgoing mail server.
e Send From Email - select "Logon Email" to send all emails from the email address entered on this screen. This

would apply when using a relay account or app password.

e Reply To Email - select "Logon Email" to set the "reply to" address to the same address used for sending
emails. Select "User Email" to set the "reply to" address to each user's email entered on the User Settings

screen.

Custom Client Fields Tab

KB Representative Payee Manager

File  RPM
Backup/Restore v fq 2 P i E_‘ﬁ <—l Client > 2 El =
o> & ¢ g [ | o 83
Import/Export ¥ | o chboard Clients Transactions Vendors Reconcile List ~ Setup~ Reports | Users Change User
Maintenance Transaction v Password Settings
File View Utilities Reports Security

(5] Dashboard X |3 System Setup

Close

- - a x
£ Find Z | Descending ©
IFE save Help
“) Can'tUndo~ | % Ascending M
Edit Records Filter/Sort i

System Settings Custom Client Fields Security Settings User Schedule

Custom Date Configuration Custom Text Configuration Custom List Configuration

Show Fields on Clients Screen

BasicTabField1 |Text6 ¥

BasicTabField2 |List8 b

[Preferred communication method

Enable Label Enable Label Enable Label

Datel ¥ [admissiondatd | | Text1 ¥ [Mother's maiden name ust1 ¥ [Education level
pate2 P [Endofincarceration Text2 M [Favorite teacher ust2 ¥ [Careerfield

pates ¥ [Viedical emergency Text3 M [Foodstamps amount ($) tst3 ¥ [pependent children
Dated M [Vedical procedure Texta ¥ [Employer usta P [pets

Date5 M [Email undeliverable Texts ™ [occupation Lsts W

vates ¥ [Voicemaillert Texte M [Financial goal uste ¥ [Religion

Date7 M [Varmiage Text7 M [personal goal ust7 ¥ [ritie

pates M [pivore Texts M [cultural considerations Lst8 ¥ [insurance provider
patey ¥ ,W Texts M |Spouse name Lsts M ]Pharmacy

Date10 ¥ [spousedeath Textio T ustio |

Custom fields are used on the Custom tab of the Clients screen.
Check the box for each field you want to use and enter the label you want for that field.
Once enabled, maintain the values in the Custom Lists under Utilities, List Maintenance, Custom List 1- 10.

Select 1 or 2 fields to appear on the
Basic tab of the Clients screen.
All fields will appear on the Custom tab.

Custom Date 1 Label

Custom fields are used on the Custom tab of the Clients screen.
below.

Num Lock  Powered by Microsoft Access

Fields on the Custom Client Fields tab are explained

Check the box for each field you want to use and enter the label you want for that field.

Configuration
e Custom Dates - configure up to 10 custom dates.
e Custom Text - configure up to 10 custom text fields.

e Custom Lists - configure up to 10 custom lists. The values in the Custom Lists are maintained in List

Maintenance > Custom List 1-10.

Show Fields on Clients Screen

Select any one or two custom dates, text fields, and/or lists to appear on the Basic tab of the Clients screen. Values in
the selected fields can be managed from the Basic tab as well as the Custom tab of the Clients screen.
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Security Settings Tab

s Representative Payee Manager - a X

File RPM

Backup/Restore v - ® v = Client ~ S > + | 2 Find %! Descending @ Help
o & /vj E = E o EE
Import/Export ¥ . Setup ¥ H save 1 System Info
Dashboard Clients Transactions Vendors Reconcile List Reports | Users Change User o A %
Maintenance Transaction v Password Settings | 'BPaste | € Can'tUndo~ | 2| Ascending {7 Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help A~
| System Setup
Close

System Settings Custom Client Fields Security Settings User Schedule
Password Requirements
Require Passwords
Maximum Days Password Age
Minimum Password Length
Alpha Required
Uppercase Alpha Required

Number Required

—ITITITIT‘E‘TI

Special Character Required

* Require Passwords - check this box if users are required to have passwords.

* Maximum Days Password Age - enter the frequency with which users are required to change passwords. Enter 0 if passwords do not need to be changed.
* Minimum Password Length - enter a minimum password length (1-20).

* Alpha Required - check this box if each password must include an alphabetical character (upper or lower case letter a-z).

* Uppercase Alpha Required - check this box if each password must include an upper case alphabetical character (upper case letter A-Z).

* Number Required - check this box if each password must include a number (0-9).

 Special Character Required - check this box if each password must include a special character (examples include: | @#5%)

Maximum Days Password Age Num Lock  Powered by Microsoft Access

Fields on the Security Settings tab are explained below.
e Require Passwords - check if users are required to have passwords.

¢ Maximum Days Password Age - enter the frequency with which users are required to change passwords. Enter
"0" if passwords do not need to be changed.

e Minimum Password Length - enter a minimum password length from 1 to 20.

e Alpha Required - check if each password must include an alphabetical character (upper or lower case letter, a—
2).

e Uppercase Alpha Required - check if each password must include an upper case alphabetical character (upper
case letter, A-Z).

e Number Required - check if each password must include a number (0-9).

e Special Character Required - check if each password must include a special character (examples include:
|@#$%).
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User Schedule Tab

s Representative Payee Manager - a X
File RPM
Backup/Restore v - e = Client 5 2 + | 2 Find @ Help
Bl & 71 B =] By | & [T
Import/Export ¥ . Setup ¥ = H save 1. System Info
Dashboard Clients Transactions Vendors Reconcile List _ Reports | Users Change User o 2
Maintenance Transaction v Password Settings | | [ Paste 7 Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help ~
5| System Setup
Close I
System Settings Custom Client Fields Security Settings User Schedule
[ Default Schedule for New Users
Work Schedule € 24 hours, 7 days a week
@ Limit Schedule
~Copy Schedule
Copy |Sunday v~ To  Weekdays Every Day
Schedule Day FromTime ToTime 24 Hours
M T Sunday 8:00AM | s:00pm T
4 Monday 8:00AM | 5:00PM T
v Tuesday 8:00AM | 5:00PM T
¥ |wednesday 8:00AM | s5:00PM T
~ Thursday 8:00AM | 5:00PM [T
v Friday 8:00AM | 5:00PM T
I Saturday 8:00AM | s:00PM T
Set the default schedule for new users.
Update each user's schedule on the Users screen.
Users will only be allowed to access RPM during their scheduled work hours.
If RPM is left open, the user will be logged out automatically after their scheduled work hours.
Select Day to Copy From Num Lock  Powered by Microsoft Access

The User Schedule tab is used to set default allowable login times for new users. Changes on this screen will not
impact existing users. To set a login schedule for existing users, go to the Schedule tab of the Users screen.

The available options on this tab are explained below.

Work Schedule
e 24 hours, 7 days aweek - select to allow users to log in to RPM at any time.
e Limit Schedule - select to set up a limited schedule for the users.

Limit Schedule

When "Limit Schedule" is selected, the allowable login times can be set for each day of the week.

e Schedule - check this to set the allowed login times. Uncheck to prevent users from logging in at all on that day.
e From Time - enter the earliest login time allowed.

e To Time - enter the latest login time allowed. If RPM is left open after this time, users will be automatically logged
out.

e 24 Hours - check this to allow users to log in at any time.

Copy Schedule
e Weekdays - copy the schedule from the selected "Copy" day to weekdays.
e Every Day - copy the schedule from the selected "Copy" day to every day.
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Transaction Utilities

Posting

Bank Fee Posting

File RPM

Backup/Restore v f]j ,4\Q W
G 8

Import/Export v =

Dashboard Clients Transactions Vendors Reconcile

File View

5] Dashboard X [-3] Bank Fee Posting X

Close | Post |

If:'hl Client

Maintenance Transaction v

& O &%

Reports Users Change  User
Password Settings

List  SetupY

Utilities Reports Security E

Select Account

Mass Account Ichecking ¥

Select Date Range

Include Balances from |01/01/2025 thru |01/31/2025

Select Bank Fee Allocation

Reset
Bank Fee Posting
Latest Bank Fee Posting [11/25/2024 10:49:54 AM

This utility allocates bank fees to all active clients in an
account who have a start date on or before the thru date
entered. Each client is allocated a portion of the bank fee
based on their average daily balance during the date

range.
Total Fees to Allocate

$27.98

Minimum Fee Per Client $0.00 (Use $0 if no minimum)

Allocate Remaining Fee to Client |Payee, ABC v

Click "Reset" to remove the bank fee transactions for a
selected process date.

Enter Fee Transaction Information

Transaction Date | 02/01/2025

Pay to Vendor IABC Payee ¥
Category ]Bank Fee v
Subcategory | b
Memo Ijanuary 2025

Select Bank Fees from Utilities > Transaction > Posting to open this screen.

The Bank Fee Posting screen is used to allocate bank fees to all active clients in an account who have a start date on
or before the thru date entered. This process is only available for mass accounts. Each client is allocated a portion of
the bank fee based on their average daily balance during the date range.

The information to be entered for the transactions includes:
e Mass Account - the account to which the bank fees will be posted.

¢ Include Balances from - the date range for calculating each client's average daily balance. This should be the
period for which the bank fee was charged and would usually come from the bank statement.

e Total Fees to Allocate - the total bank fees deducted from the account on the bank statement.

e Minimum Fee Per Client - optional minimum fee for each client. If a minimum fee is entered, each client will be
charged the minimum fee, and the remaining fees above or below the minimum will be allocated based on each
client's average daily balance. If the minimum fees add up to more than the total fees, the additional fees will be
removed from each client's fee transaction based on the client's average daily balance. If the minimum fees add
up to less than the total fees, the remaining fees will be added to each client's fee transaction based on the
client's average daily balance.

e Allocate Remaining Fee to Client - the client to which any remaining amount (due to rounding) will be allocated.
This is typically a dummy internal client set up for the purpose of entering any adjustment transactions for the
account.
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e Transaction Date - enter the date.

e Pay to Vendor - the vendor to whom the fee will be paid.
e Category - select the category.

e Subcategory - optional subcategory.

e Memo - enter the memo.

The posting process will create a fee transaction using the "Transaction Date," "Pay to Vendor," "Pay Type," and
"Memo" entered. The transactions will have a payment method of "EFT" and will be marked as "cleared" for
reconciliation.

Click Post to start the process. A report of the transactions displays to review before posting. When the posting
process is complete, a message displays about the amount of any remaining bank fee that is allocated to the dummy
client.

Bank fees will be allocated to clients regardless of their current balance, so a client could have a negative balance
after bank fees are applied. Check for any negative balances in the account on the Reports screen under Balances >
Balances Under Amount.

The "Latest Bank Fee Posting" field displays the date and time of the most recent bank fee posting.

Use the Reset button in the upper right of the screen to remove the bank fee transactions for a selected process date.
This can only be done if the transactions have not been reconciled.
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Client Fee Posting

5] Dashboard X [-3] Client Fee Posting X

File RPM

Backup/Restore ~ IfCD QQ L;@ If:5 Client v :&%,:‘ I% Q_;':_

/i v v
Import/Export Dashboard Clients Transactions Vendors Reconcile List Setup Reports Users Change  User
Maintenance Transaction v Password Settings
File View Utilities Reports Security

Close I Post |

Enter Fee Information

Fee % of Deposits 5.00%

Maximum Fee $50.00 (Use SO if no maximum)

Select Date Range

Include Deposits from [12/01/2024 thru [12/31/2024

Enter Fee Transaction Information

Transaction Date |01/01/2025

Pay To Vendor IABC Payee 7

Vendor Address |1 v

Category Iclient Fees v
Subcategory I =
Payment Method ’XEFT—

Memo [pec 2025

Batch Payment ~

Reset
Client Fee Posting
Latest Client Fee Posting |12/30/2024 10:40:39 AM

This utility creates client fee transactions for each active
client as a percentage of their total deposits for the date
range.

Fees are only charged to clients assigned to a client type with
"Apply Fee" checked on the Client Type list and for deposit
types with "Apply Fee" checked on the Deposit Category list
on the List Maintenance screen.

Click "Reset" to remove the client fee transactions fora
selected process date.

Select Client Fees from Ultilities > Transaction > Posting to open this screen.

This is used to create client fee transactions for each active client based on their total deposits during a date range.
This only applies to clients who are assigned to a client type with "Apply Fee" checked on List Maintenance > Client
Type. Deposits are only included in the total for deposit types with "Apply Fee" checked on List Maintenance >
Deposit Category. Client fee transactions will be posted to the client's default active account.

If you charge a flat fee, enter those transactions as scheduled payments for each client using the Schedule Pmts tab
on the Clients screen or the Create Scheduled Payments utility.

The information to be entered for the transactions includes:

Fee % of Deposits - the percentage of total deposits used for calculating each client's fee. For example, if the
fee is 0.5% and a client has deposits totaling $1,000 for the date range entered, that client's fee transaction will
be $5.

Maximum Fee - the optional maximum fee amount for each client.
Include Deposits from - the date range for totaling deposits.
Transaction Date - enter the date.

Pay To Vendor - select the vendor to whom the fee will be paid.

Vendor Address - select the vendor address. If the vendor has only one address, it will be used by default. If the
vendor has more than one address, select the address you wish to use. Leave the selection blank if you don't
want to print an address on the check.

Category - select the category.
Subcategory - optional subcategory.

111



e Payment Method - select "Print" if you want a check to print for this transaction. The other payment methods will
add a transaction to the register without printing a check. See details for the available payment methods in the
Payment Methods topic.

e Memo - enter the memo.
e Batch Payment - select this if the transactions should be grouped on a single check or XEFT transaction.

Once all the information has been entered, click Post to automatically create the client fee transactions. A report of
the transactions displays to review before posting. These transactions will be added to the transaction register, and
checks can be printed if the "Print" payment method was selected. Transactions will only be created for active clients
with a balance greater than the fee amount due.

The "Latest Client Fee Posting" field displays the date and time of the most recent client fee transaction posting.

Use the Reset button in the upper right of the screen to remove the client fee transactions for a selected process
date. This can only be done if the transactions have not been printed, cleared, or reconciled.
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Interest Posting
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Select Interest from Utilities > Transaction > Posting to open this screen.

The Interest Posting screen is used to allocate interest earned in an account to each active client in the account. This
process is only available for mass accounts. Each client is allocated a portion of the interest based on their average
daily balance during the date range.

The information to be entered for the transactions includes:
e Mass Account - the account to which the interest will be posted.

¢ Include Balances from - the date range for calculating each client's average daily balance. This should be the
period for which the interest was earned and would usually come from the bank statement.

e Total Interest to Allocate - the total interest to be allocated. This would usually be the interest amount on the
bank statement.

e Allocate Remaining Interest to Client - the client to which any remaining amount (due to rounding) will be
allocated. This is typically a dummy internal client set up for the purpose of entering any adjustment transactions
for the account.

e Transaction Date - enter the date.

e Category - select the category.

e Subcategory - optional subcategory.
e Memo - enter the memo.

The posting process will create a deposit transaction using the "Transaction Date," "Category," and "Memo" entered.
Click Post to start the process. A report of the transactions displays to review before posting. When the posting
process is complete, a message displays about the amount of remaining interest allocated to the dummy client.

The "Latest Interest Posting" field displays the date and time of the most recent interest transaction posting.

Use the Reset button in the upper right of the screen to remove the interest transactions for a selected process date.
This can only be done if the transactions have not been reconciled.
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Client Balance Payout

@ Representative Payee Manager

File RPM
Backup/Restore v f"\ - 74 |i E_H <T| Client v o E] =
> & A ) B3 K3
Impott/Export, Dashboard Clients Transactions Vendors Reconcile List Setip: Reports Users Change  User
Maintenance Transaction v Password Settings
File View Utilities Reports Security Edit
E Dashboard X E Client Balance Payout X
Close | Post | Reset
Enter Payout Transaction Information Client Balance Payout
Transaction Date [01/20/2025 Latest Client Balance Payout |1/20/2025 4:36:49 PM
Category ITransfer v Sl e 2
This utility creates transactions that pay out the current account balance for
Subcategory l v selected clients.
Payment Method |Print v
v Use the "Bal. Pay" checkbox on the Basic tab of the Clients screen to mark
Mail To v the selected accounts. Balance payout transactions will only be created for
- active clients and active accounts.
Memo |Closmg account

Click "Reset" to remove the client balance transactions for a selected
process date.

Select Client Balance Payout from Utilities > Transaction > Posting to open this screen.

This is used to create transactions that pay out the current account balance for selected clients. Use the "Bal. Pay."
checkbox on the Basic tab of the Clients screen to mark the selected client accounts. Balance payout transactions will

only be created for active clients and active accounts.

The information to be entered for the transactions includes:
e Transaction Date - enter the date.

e Category - select the category.

e Subcategory - optional subcategory.

e Payment Method - select "Print" if you want a check to print for this transaction. The other payment methods will
add a transaction to the register without printing a check. See details for the available payment methods in the

Payment Methods topic.
e Mail To - check if you want the client's address printed on the check.
e Memo - enter the memo.

Once all the information has been entered, click Post to automatically create the balance payout transactions. A
report of the transactions displays to review before posting. These transactions will be added to the transaction

register, and checks can be printed if the "Print" payment method was selected. Transactions will only be created for

active clients with a balance greater than $0 in an account marked for balance payout.

The "Latest Client Balance Payout" field displays the date and time of the most recent balance payout transaction

posting.

Use the Reset button in the upper right of the screen to remove the balance payout transactions for a selected
process date. This can only be done if the transactions have not been printed, cleared, or reconciled.
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Scheduling

Create Scheduled Deposits
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Click "Reset" to immediately remove the scheduled deposits created by this process.

Select Create Scheduled Deposits from Utilities > Transaction > Scheduling to open this screen. This is used to
create scheduled deposits for all active clients or by client type, account manager, or support type.

Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support
types are assigned to your user ID, you will only be able to create scheduled deposits for those types of clients. If
client types or support types have NOT been assigned to your user ID, you will be able to create scheduled deposits
for all clients. "Access Limited to assigned Client Types and/or Support Types" displays at the top of the screen if your
user ID has been set up for client and/or support type filtering.

Enter Scheduled Deposit Information
e Category - select a category from the list (List Maintenance > Deposit Category).
e Subcategory - select an optional subcategory from the list (List Maintenance > Subcategory).

e Frequency - select the frequency for this deposit. When you process a scheduled deposit, the system will
automatically schedule the next deposit based on the frequency you have selected. See details for the available
frequencies in the Transaction Frequency topic.

e Deposit Amount - the monetary amount of the deposit. If this varies, the amount can be updated before
processing the deposit.

e Next Deposit Date - enter the next date that the deposit should be processed. Once a deposit is processed, the
next deposit date will be automatically updated based on the selected frequency. This date can be changed if the
deposit schedule changes.

e End Date - enter an end date if you want the deposits to end by a certain date. This can be left blank if the
deposit should continue indefinitely.

e Notes - notes about this scheduled deposit.

Create

Click Create to create scheduled deposits based on the deposit information entered for the selected clients. Once the
scheduled deposits have been created, the Update Scheduled Deposits screen will open and display the deposits
created.

Use the Reset button in the upper right of the screen to remove the scheduled deposits created by this process.
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Create Scheduled Payments
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Click "Reset" to immediately remove the scheduled payments created by this process.

Select Create Scheduled Payments from Utilities > Transaction > Scheduling to open this screen. This is used to
create scheduled payments for all active clients or by client type, account manager, or support type.

Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support
types are assigned to your user ID, you will only be able to create scheduled payments for those types of clients. If
client types or support types have NOT been assigned to your user ID, you will be able to create scheduled payments
for all clients. "Access Limited to assigned Client Types and/or Support Types" displays at the top of the screen if your
user ID has been set up for client and/or support type filtering.

Enter Scheduled Payment Information

Category - select a category from the list (List Maintenance > Payment Category).
Subcategory - select an optional subcategory from the list (List Maintenance > Subcategory).

Frequency - select the frequency for this payment. When you process a scheduled payment, the system will
automatically schedule the next payment based on the frequency you have selected. See details for the available
frequencies in the Transaction Frequency topic.

Pay To Client - select this for a payment to be paid to the client (rather than to a vendor).

Pay To Vendor - select the vendor for a payment to be paid to a vendor. Vendors can be added on the Vendors
screen.

Vendor Address - select the vendor address. If the vendor has only one address, it will be used by default. If the
vendor has more than one address, select the address you wish to use. If you're printing a check, leave the
selection blank if you don't want an address to print on the check.

Payment Method - select a value from the list. Select "Print" if you want a check to print for this transaction. The
other payment methods will add a transaction to the register without printing a check. See details for the available
payment methods in the Payment Methods topic. Set the default payment method for a vendor on the Vendors
screen. Set the default for payments to clients on the System Settings tab on the System Setup screen.

Payment Amount - the monetary amount of the transaction that will be generated. If this varies, the amount can
be updated before processing the payment.
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e Next Payment Date - enter the next date the payment should be processed. Once a payment is processed, the
next payment date will be automatically updated based on the selected frequency. This date can be changed if
the payment schedule changes.

e End Date - enter an end date if you want the payments to end by a certain date. This can be left blank if the
payment should continue indefinitely.

e Notes - notes about this scheduled payment. Notes are included on some reports but will not print on a check.
e Mail to Client Address - select this to print the client's mailing address on a check.

e For a check paid to a vendor, the client's mailing address will print on the check instead of the vendor's
address. Use this to mail a check to a client that they will pay to a vendor. Set the default for a vendor on the
Vendors screen.

e For checks paid to clients, select this if you want the client's mailing address to print on the check. If you do
not select this option for a check paid to the client, no mailing address will print on the check. This can be
used to separate checks that should be mailed to a client from those that will be picked up by the client. Set
the default "Mail to Client Address for Pay to Client checks" option on the System Settings tab on the System
Setup screen.

e Batch Payment - select this if you want to print multiple transactions on a single check or export multiple
transactions as a single XEFT. This will group all payments on a single check or XEFT, as long as they are to the
same vendor, in the same account, and for the same date. Select "Batch Payment" for client payments to print a
single check or export a single XEFT to a client for more than one category.

e Verify Each Payment - select the "Verify Each Payment” option if each instance of the payment needs to be
verified before it can be processed (for example, if the monetary amount varies by payment, like a utility
payment).

e Sort by Client - select this to sort a check paid to a vendor by the client's name instead of the vendor's name
when printing the check. Set the default for a vendor on the Vendors screen.

e Receipt Required - select this if a receipt is required after the payment is processed. Mark the receipt as
received on the Transaction Detail screen. View transactions requiring a receipt not yet received on the Reports
screen under Transactions > Receipt Required Not Received.

Create

Click Create to create scheduled payments for the selected clients based on the payment information entered. Once
the scheduled payments have been created, the Update Scheduled Payments screen will open and display the
payments created.

Use the Reset button in the upper right of the screen to remove the scheduled payments created by this process.
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Update Scheduled Deposits
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Select Update Scheduled Deposits from Utilities > Transaction > Scheduling to open this screen. This is used to
update a group of scheduled deposits.

Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support
types are assigned to your user ID, you will only be able to update scheduled deposits for those types of clients. If
client types or support types have NOT been assigned to your user ID, you will be able to update scheduled deposits
for all clients. "Access Limited to assigned Client Types and/or Support Types" displays at the top of the screen if your
user ID has been set up for client and/or support type filtering.

Select Deposits

Select all deposits for a specific category. Only active deposits (with a next deposit date) will be shown. Right-click on
a field and use the Shortcut menu or use the Filter/Sort ribbon menu options to further filter deposits to update.

Client Filter

The "Client Filter" is used to filter scheduled deposits by the account manager, client type, or support type. Click Clear
Filter to remove any client filters.

Update Deposits

Once you have deposits displayed, enter the information that you want to automatically change. Automatically update
any or all the following: "Category," "Subcategory," "Frequency," "Deposit Amount," "Next Deposit" date, and/or "End
Date." If you leave any of these items blank, the information will remain unchanged. The deposit amount will only be
updated if you enter an amount greater than zero.

Update/Update All

Click Update to the left of a deposit to update the information on that individual deposit. Click Update All to update all
deposits shown. A message will display asking you to confirm the update before it is processed. The "Last Updated"
date/time will be updated when a deposit is changed. Changes will be logged in the audit events.

Individual deposits can also be updated manually on this screen.
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Update Scheduled Payments
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Select Update Scheduled Payments from Utilities > Transaction > Scheduling to open this screen. This is used to
update a group of scheduled payments.

Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support
types are assigned to your user ID, you will only be able to update scheduled payments for those types of clients. If
client types or support types have NOT been assigned to your user ID, you will be able to update scheduled payments
for all clients. "Access Limited to assigned Client Types and/or Support Types" displays at the top of the screen if your
user ID has been set up for client and/or support type filtering.

Select Payments

Select "Vendor Payments” or "Client Payments." If "Vendor Payments" is selected, select a vendor and/or category. If
"Client Payments" is selected, select a category. Only active payments (with a next payment date) will be shown.
Payments with a "Total Due" are not included on this screen and must be updated using the Schedule Pmts tab on
the Clients screen. Right-click on a field and use the Shortcut menu or use the Filter/Sort ribbon menu options to
further filter payments to update.

Client Filter

The "Client Filter" is used to filter scheduled payments by the account manager, client type, or support type. Click
Clear Filter to remove any client filters.

Check Memo Update

This is used to update the "Check Memo" field on the scheduled payments shown on the screen below. Enter the text
to be replaced in the "Find" field, and enter the new desired text in the "Replace" field. Click Replace All to replace all
instances of the designated text.
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Update Payments

Once you have payments displayed, enter the information that you want to automatically change. Automatically
update any or all the following: "Category," "Subcategory," "Payment Method," "Frequency," "Vendor Address," "Mail
to Client,” "Batch Pmt.," "Verify Each," "Verified," "Rcpt. Req.," "Payment Amount,” "Next Payment" date, "End Date,"
and/or "Sort by Client." If you leave any of these items blank, the information will remain unchanged. The payment
amount will only be updated if you enter an amount greater than zero.

Update/Update All

Click Update to the left of a payment to update the information on that individual payment. Click Update All to update
all payments shown. A message will display asking you to confirm the update before it is processed. The "Last
Updated" date/time will be updated when a payment is changed. Changes will be logged in the audit events.

Individual payments can also be updated manually on this screen.
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Receipts Required
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Select Receipts Required from the Utilities, Transaction menu to open this screen. This is used to update the
"Receipt Received" option for transactions requiring receipts. This screen will only display transactions that have the
"Receipt Required" option checked.

The "Filter Status" option filters transactions for active or all clients.
The "Filter Received" option filters transactions with or without the "Receipt Received" option checked.

Client type and support type filters can be added for a user ID on the Users screen. If client types and/or support
types are assigned to your user ID, you will only be able to access those types of clients. If client types or support
types have NOT been assigned to your user ID, you will be able to access all clients. "Access Limited to assigned
Client Types and/or Support Types" displays at the top of the screen if your user ID has been set up for client and/or
support type filtering.

Transaction Filter

Use the "Transaction Filter" options to search for specific transactions. Enter one or more of the following criteria to
display the transactions matching the criteria. Click Clear Filter to remove all the criteria and display all transactions.
Right-click on a field and use the Shortcut menu or use the Filter/Sort ribbon menu options to further filter transactions
shown.

e Begin Date - enter the earliest date for transactions to display, or leave blank for all dates.
e End Date - enter the latest date for transactions to display, or leave blank for all dates.

e Client - select a client from the list, or leave blank for all.

e Account - select an account from the list, or leave blank for all.

e Account Manager - select an account manager from the list, or leave blank for all.

Check the "Receipt Received" option for any displayed transaction. To remove the "Receipt Required" option for a
transaction, click Details to edit that transaction.

Mark All
Use Mark All to automatically check the "Receipt Received" option for ALL the displayed transactions.
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Reset Transactions

@ Representative Payee Manager g -
File RPM
BackupyRestore ¥ " 7 = 3 Client ~ S S e Find (@ Hel
’ b & A B & R f S
/ v 2 y
Impof/Export Dashboard Clients Transactions Vendors Reconcile List Setig Reports Users Change  User [ Save A SystemInfo
Maintenance Transaction v Password Settings £ Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help
E Dashboard X E Transactions X Jj Reset Transactions X
Close Reset
Select Process Type Select Process Date
" Bank Fee Posting " Scheduled Deposits Created I v
" Check Run " Scheduled Payments Created Transaction Count
" Client Balance Payout " scheduled Deposits Processed Processed By User I
" Client Fee Posting © scheduled Payments Processed
" Deposit Import " scheduled Transfers Processed P
g
" Interest Posting " XEFT Export o

" Ppositive Pay Export

Select the process type you wish to reset.

Select Reset Transactions from the Utilities > Transaction menu to open this screen. This is used to reset various
transactions. Any process that is reset will be logged in the audit events.

For each process you want to reverse, select the original "Process Date" or "Statement Ending Date." If you are not
sure which date contains the transactions you want, find this by clicking Details for one of the specific transactions on
the Transactions screen. Use the "Date Processed" for Bank Fee Posting, Client Balance Payout, Client Fee Posting,
Deposit Import, Interest Posting, Scheduled Deposits Processed, Scheduled Payments Processed, and Scheduled
Transfers Processed. Use the "Date Printed" for a Check Run. Use the "Exported” date for Positive Pay Export and
XEFT Export.

Bank Fee Posting

This is used to remove bank fee transactions created with the Bank Fee Posting utility. Bank fee transactions can only
be removed if none of them have been cleared or reconciled.

Select the process date and time you want to reset. The number of transactions and the user who posted them will
display.
Click Reset to remove the transactions.

Check Run

This is used to set checks back to print for a selected check run. Checks are usually set back to print right after a
check run if they did not print correctly. To set the checks back to print after closing that screen, use this utility. Print
runs can only be reset if none of the checks in the print run have been cleared, reconciled, or voided.

Select the process date and time of the print run for the checks you want to reset. The nhumber of checks and the user
who printed them will display.

Select Check Run Reset Options

e Set Checks back to Print - this will simply set the incorrect checks back to print for printing again. Corrections
can be made to the transactions before printing again.

e Void and Create New Checks for Printing - this will void the incorrect checks and create new transactions for
printing. Corrections can be made to the new transactions before printing.

e Firstincorrectly printed check - select the first check if the entire check run was incorrect. Otherwise, select
the first check that printed incorrectly. All checks on or after the selected check will be reset.
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Click Reset to reset the selected checks. A confirmation message will display. Click Yes to continue.
*Any checks that print incorrectly and are reset should be destroyed.**

Use Details on the Transactions screen to set individual checks back to print or void them and create new
transactions.

Client Balance Payout

This is used to remove client balance payout transactions created with the Client Balance Payout utility. Client
balance payout transactions can only be removed if none of them have been printed, cleared, or reconciled.

Select the process date and time for the transactions you want to reset. The number of transactions and the user who
posted them will display.

Click Reset to remove the transactions.

Client Fee Posting

This is used to remove client fee transactions created with the Client Fee Posting utility. Client fee transactions can
only be removed if none of them have been printed, cleared, or reconciled.

Select the process date and time for the transactions you want to reset. The number of transactions and the user who
posted them will display.

Click Reset to remove the transactions.

Deposit Import

This is used to remove deposit transactions imported with the Import ACH Deposits utility. Imported deposits can only
be removed if none of them been cleared or reconciled.

Select the process date and time for the transactions you want to reset. The number of transactions and the user who
posted them will display.

Click Reset to remove the transactions.

Interest Posting

This is used to remove interest transactions created with the Interest Posting utility. Interest transactions can only be
removed if none of them have been cleared or reconciled.

Select the process date and time for the transactions you want to reset. The number of transactions and the user who
posted them will display.

Click Reset to remove the transactions.

Positive Pay Export

This is used to reset checks exported with the Export Positive Pay File utility. Checks that have been marked as
exported can only be reset if none of them have been cleared or reconciled.

Select the process date and time for the transactions you want to reset. The number of transactions and the user who
exported them will display.

Click Reset to remove the exported flag on the transactions.

Scheduled Deposits Created

This is used to delete scheduled deposits created using the Create Scheduled Deposits utility. The scheduled
deposits will only be removed if:

e The scheduled deposit has not been processed to create transactions.

e The scheduled deposit has not been updated since it was created. This applies to any changes made using the
Schedule Deps tab on the Clients screen or the Update Scheduled Deposits utility.

Select the creation date and time for the scheduled deposits you want to delete. The number of scheduled deposits
and the user who created them will display.

Click Reset to remove the scheduled deposits.
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Scheduled Payments Created

This is used to delete scheduled payments created using the Create Scheduled Payments utility. The scheduled
payments will only be removed if:

e The scheduled payment has not been processed to create transactions.

e The scheduled payment has not been updated since it was created. This applies to any changes made using the
Schedule Pmts tab on the Clients screen or the Update Scheduled Payments utility.

Select the creation date and time for the scheduled payments you want to delete. The number of scheduled payments
and the user who created them will display.

Click Reset to remove the scheduled payments.

Scheduled Deposits Processed
This is used to reverse the processing of a group of scheduled deposits. This can only be reversed if:

e Each deposit in the group is the last deposit processed for that scheduled transaction. For example, if you
process weekly deposits for the previous week and then process the same deposits for the current week,
deposits can only be reversed for the current week and not the previous week.

¢ None of the original scheduled transactions have been updated since they were processed. This applies to any

changes made using the Schedule Deps tab on the Clients screen or the Update Scheduled Deposits utility.
Select the process date and time for the deposits you want to reset. The number of deposits and the user who
processed them will display.

Click Reset to remove the deposit transactions and set the "Next Deposit" date back to the previous next deposit
date.

Scheduled Payments Processed
This is used to reverse the processing of a group of scheduled payments. This can only be reversed if:
¢ None of the processed check payments have been cleared, printed, or reconciled.

e Each payment in the group is the last payment processed for that scheduled transaction. For example, if you
process weekly payments for the previous week and then process the same payments for the current week,
payments can only be reversed for the current week and not the previous week.

¢ None of the original scheduled transactions have been updated since they were processed. This applies to any

changes made using the Schedule Pmts tab on the Clients screen or the Update Scheduled Payments utility.
Select the process date and time for the payments you want to reset. The number of payments and the user who
processed them will display.

Click Reset to remove the payment transactions and set the "Next Payment" date back to the previous next payment
date.

Scheduled Transfers Processed
This is used to reverse the processing of a group of scheduled transfers. This can only be reversed if:

e Each transfer in the group is the last transfer processed for that scheduled transaction. For example, if you
process weekly transfers for the previous week and then process the same transfers for the current week,
transfers can only be reversed for the current week and not the previous week.

¢ None of the original scheduled transactions have been updated since they were processed. This applies to any
changes made using the Schedule Xfer tab on the Clients screen.

¢ None of the processed transfers have been cleared or reconciled.

Select the process date and time for the transfers you want to reset. The number of transfers and the user who
processed them will display.

Click Reset to remove the transfer transactions and set the "Next Transfer" date back to the previous next transfer
date.
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XEFT Export

This is used to reset XEFT transactions exported with the Export XEFT Transactions utility. Exports can only be reset
if none of the transactions have been cleared or reconciled.

Select the process date and time for the transactions you want to reset. The number of transactions exported and the
user who exported them will display.

Click Reset to remove the "exported" flag on the transactions.
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System

Clear Check Printing User

Backup/Restore ¥ = @ v 4 \ S
: &S 70 B =

Import/Export ¥ 3 : 2 X
Dashboard Clients Transactions Vendors Reconcile List
Maintenance

File View Utili
5| Dashboard X |-3| Clear Check Printing User X

Close

The user(s) listed below have checks selected to print. No one else can
print these same checks or checks in the same account(s) while these
are selected. If the user is no longer printing checks, use the "Clear"
button to clear the selected checks.

# Transactions
User ID Date/Time Started Selected
» [romdemoa [1/24/200411:10:05am |7 TClear |

Select Clear Check Printing User from Utilities > Transaction > System to open this screen.

The Clear Check Printing User screen is used to clear out a user who has transactions selected to print but is no
longer printing checks. Only one user at a time can print checks within the same bank account. If a user exits RPM
abnormally while printing checks, you may need to use this utility to clear out the user before another user will be able

to print checks in the same account.

Click Clear to clear the user from the check printing screen. Make sure the user is not currently printing checks before
you do this. After this is complete, another user will be able to print checks for the previously selected account(s).
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Archive/Balance Forward

BB Representative Payee Manager

File RPM
Backup/Restore v \ W ’7 =
(& & & 5
Import/Export ¥ Dashboard Clients Transactions Vendors Recot
File View

E Archive/Balance Forward X

Close Archive

This process will archive all reconciled transactions
through the date entered below. The process will
calculate and bring forward reconciled account balances
for each client as of the archive date.

Select Archive Date

Archive transactions prior to: }12/31/2025| |

Transaction Information

Total Transaction Count IF
Earliest Date M
Latest Date [01/22/2025
Earliest Unreconciled Date IM
Previous Archive Date []m

Number Unreconciled Priorto |0
Archive Date

Number Reconciled to Archive |1827

]

Transactions that have been archived can be viewed under:
* Reports > Transactions By Client > Archived Transactions
* Reports > Custom > Transactions Archived

Select Archive/Balance Forward from Utilities > Transaction > System to open this screen.

This is used to archive older transactions. For better system performance, we recommend archiving transactions
more than two years old.

On this screen, the total number of transactions displays, along with the earliest and latest transaction date and the
earliest unreconciled transaction date. Enter a date at least one year old for archiving.

Only reconciled transactions will be archived. We recommend reconciling all transactions prior to the archive date. If
there are any unreconciled transactions remaining, the count displays. On the Reports screen, use Reconciliation >
Account Reconciliation List to see the accounts that have outstanding items. Use Reconciliation > Outstanding
Deposits and Reconciliation > Outstanding Payments through the archive date to view the actual outstanding
transactions.

Archived transactions are saved to a separate transaction archive table, and each client's balance is carried forward
from the archived transactions. "Archive Balance Forward" transactions will be created during the archive process and
will be dated on the specified archive date. All client balances will be the same before and after the archive process.

Click Archive to start the process. A message displays reminding you to create a backup before beginning the
archive process. Answer Yes to continue.
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A final message prompts you to continue the archive process. Select Yes to continue or No to cancel. After selecting
Yes, do not cancel or interrupt the archive process. A message displays when the archive is complete.

Archived transactions no longer display on the Transactions or Clients screens but can still be viewed on reports. On
the Reports screen, archived transactions can be viewed on the following reports:

e Transactions By Client > Client Statement
e Transactions By Client > Archived Transactions
e Custom > Transactions Archived
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Purge Data

Backup/Restore v ry K v d
W & 7 B |

Import/Export ¥

Dashboard Clients Transactions Vendors Reci

View

Purge

This process will permanently remove inactive clients
and all related information prior to the date entered
below. Clients will only be removed if their latest
archived transaction is prior to the purge date. Clients
with any current transactions will not be removed.

—Select Purge Date

Purge inactive clients prior to: 112/31/2018

[~ Archived Transaction Information

Total Archived Transactions I 17241
Earliest Date 101/01/ 2013
Latest Date |12/27/2022

Select Purge Data from Utilities > Transaction > System to open this screen.

This is used to purge inactive clients and related information. Only inactive clients will be removed, and only if they do
not have any transactions after the selected purge date.

Click Report to see a list of the clients that will be purged.

Click Purge to start the process. A message displays reminding you to create a backup before beginning the purge
process. Answer Yes to continue.

A final message prompts you to continue the purge process. Select Yes to continue or No to cancel. After selecting
Yes, do not cancel or interrupt the purge process. A message displays when the process is complete.

Purged clients will no longer be available on any reports or screens.
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Security

The following options are used to set up user IDs and passwords.

Users

IE  Representative Payee Manager

&=

File RPM
Backup/Restore v
Import/Export v
File View
Dashboard X (55| Clients X [55] Users X

Close I New User I Copy Rights | Delete User

Dashboard Clients Transactions Vendors Reconcile

List
Maintenance Transaction v

L DO R B G o & O 8%

Reports  Users Change  User
Password Settings

Setup v

Utilities Reports Security

Reset Pwd Menu Security User Log Cloud Users

select User ID [adminUser] ~  FilterUsers @ Active  Inactive  All

(™) = a X

@ Help
A\ System Info
i, & Tech Support
Filter/Sort Help ~

Add or remove cloud users: rpmccs.com/cloud-user-change/
Manage your subscription payment method: rpmccs.com/customer-portal/

Security Rights Schedule

User Information

UserID \AdminUser
User Name |Admin User

User has a password |No

Require user to change password r
atnext logon

Inactive r

Login Information

LoggedIn |Yes
Login Time |1/20/2025 5:00:58 PM

Notes

Demo user with all rights

Security Rights By Menu

File View

Menu Option

Back Up Data Update v
» |Restore Data Update

Export Positive Pay File Update v

Export XEFT Transactions Update v

Import ACH Deposits Update v

P x

~Client Types Filter

utilities | Reports | Security Programs[ + |ClientType
Security Level [ s

Support Types Filter
+ | Support Type

Password requirements can be configured on the
Security Settings tab under Utilities > Setup > System
Setup.

Assigning Client Types to a user will limit the user to
those types of clients. Leave blank to allow a user to
access all client types.

Assigning Support Types to a user will limit the user to
those types of clients. Leave blank to allow a user to
access all support types.

Menu Option Details:
Restore Data screen under File > Backup/Restore. This is
only il with an RPM Onsite license using an

AllRights | NoRights

Access database.

Use Reports > Security > Security Option List to see a list
of all available security options with descriptions.

User 4 10f8 oM \ Search
Select User ID

Num Lock  Powered by Microsoft Access

Select Users from the Security menu to open this screen. This is used to add, delete, or change the security rights for
each user. Passwords for users can be reset on this screen.

The "Filter Users" options allow you to see active, inactive, or all users. To view all users (active and inactive), click
the All option. Only active users can log in to RPM.

Sample Users
There are several sample users available to start. These initially have blank passwords.
AdminUser - user with all rights.

Use

TransactionUser - user with most rights other than security.

ViewUser - user with view-only rights.
SecurityUser - user with no rights other than security.

RPMDemol - demo user with all rights.
RPMDemo2 - demo user with all rights.
RPMDemo3 - demo user with all rights.
RPMDemo4 - demo user with all rights.

"AdminUser" to log in and set up your own users.

To make changes to an existing user, select their user ID from the "Select User ID" list.
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Security Rights Tab
The Security Rights tab is used to set up security for each user. The available options on this tab are explained below.

The "User ID" will be used to log on to RPM. The "User Name" is for informational purposes only. "User has a
Password" displays if the user has a password. Check "Require user to change password at next logon" to force the
user to change their password the next time they log on to RPM. Password requirements can be configured on the
Security Settings tab on the System Setup screen.

"Logged In" displays as "Yes" if the user is currently logged in to RPM. If the user is logged in, the "Login Time" field
displays the date and time the user logged in.

Use the "Notes" field to enter any notes about this user.

Security Rights By Menu

The security rights are set for each user under the "Security Rights By Menu" section. The available options are
shown on tabs corresponding to the menu options available in RPM. See a list of all available security options on the
Reports screen under Security > Security Option List. Clicking on a menu option updates the "Menu Option Details" to
the right of the screen.

e File - displays the available options under the RPM File menu.

e View - displays the available options under the RPM View menu.

e Utilities - displays the available options under the RPM Utilities menu.
e Reports - displays the available options under the RPM Reports menu.
e Security - displays the available options under the RPM Security menu.

e Programs - displays the options available under the "Start" menu on your computer (outside of RPM). These
applications can be found using the Windows "Search" box.

Once you select a tab, the "Security Level" can be set for each Menu Option under that tab. The "Security Level"
dropdown is a list of the available security levels for that menu option. The possible security levels include:

e None - the user will not have rights.
e View - the user will have view-only rights and will not be able to update any information.
e Update - the user will have update rights and will be able to enter and update information.

Click All Rights to quickly give a user all rights to the selected menu. Click No Rights to give a user no rights to the
selected menu. Give all rights or no rights to a user, and then make any additional changes to the menu security
levels as needed. Alternately, manually enter the rights for each menu option.

Client types can be assigned to a user under the "Client Types Filter" section. If one or more client types are assigned
to a user, they will only have access to those types of clients. Leave this section blank to allow a user to access all
clients.

Support types can be assigned to a user under the "Support Types Filter" section. If one or more support types are
assigned to a user, they will only have access to those types of clients. Leave this section blank to allow a user to
access all clients.
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Schedule Tab

s Representative Payee Manager a
File RPM
Backup/Restore v o e 7 S =, Client~ . . o | 2 Find @ Help
Bl & 72 B v | S5 & | i
Import/Export v . ) - Setup ~ - Hsave 1 System Info
Dashboard Clients Transactions Vendors Reconcile List . Reports Users Change  User >
Maintenance Transaction ¥ Password Settings © Can't Undo ~ £ Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help
5| Dashboard X [53] Clients X -3] Users X
Close | New User | Copy Rights | Delete User Reset Pwd Menu Security User Log
Select User ID [adminUser] ~  FilterUsers @ Active ¢ Inactive © All
#| security Rights Schedule
User Schedule - Set the work schedule for the user.
Work Schedule 24 hours, 7 days a week
The user will only be allowed to access RPM during their scheduled work hours.
& Limit Schedule
If RPM is left open, the user will be logged out automatically after their scheduled work hours.
Copy Schedule
Copy (Sunday v To  Weekdays Every Day
Schedule Day From Time ToTime 24 Hours
AR Sunday 8:00AM| s00PM [T
~ Monday 8:00AM | 5:00PM [T
~ Tuesday 8:00AM | s5:00PM [T
4 Wednesday 8:00AM | s5:00PM [T
4 Thursday 8:00AM | s5:00PM [T
¥ [Friday 8:00AM | s:00PM T
1 Saturday 8:00AM | s:00PM [
User 4 < [10f8 | » bl Search
Select User ID NumLock  Powered by Microsoft Access

The Schedule tab is used to set allowable login times for each user. The default schedule for new users can be set on

the User Schedule tab on the System Setup screen.
The available options on this tab are explained below.

Work Schedule
e 24 hours, 7 days a week - select to allow a user to log in to RPM at any time.
e Limit Schedule - select to set up a limited schedule for the user.

Limit Schedule

When "Limit Schedule" is selected for a user, the allowable login times can be set for each day of the week.
e Schedule - check this to set the login times allowed. Uncheck to prevent the user from logging in.

e From Time - enter the earliest login time allowed.

e To Time - enter the latest login time allowed. If RPM is left open after this time, the user will be automatically

logged out.
e 24 Hours - check this to allow the user to log in at any time.

Copy Schedule
e Weekdays - copy the schedule from the "Copy" day to weekdays.
e Every Day - copy the schedule from the "Copy" day to every day.
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Add a New User

Backup/Restore v ry @ " -
- o & 7] B

Import/Export ¥ X i i
Dashboard Clients Transactions Vendors Reconcile

File View
Dashboard Users X E Add New User X
Close I Add |

New User Information

User ID

User Name I

Password
Verify

Require user to change 4

password at next logon

Default User Rights
* NoRights
C AllRights

" Copy Rights from User v

Passwords are case-sensitive.

To add a new user, click New User.

Enter the desired user ID, full name of the user, and password for the new user. The rights when adding a new user
can be set to no rights, all rights, or rights copied from an existing user. After adding a user, the user's rights can be
changed as needed. Click Add to add the new user.

Copy User Rights

=y I
Backup/Restore ¥ &:. ’Zj ‘E

Import/Export ¥ % 3
Dashboard Clients Transactions Vendors
File View
- Dashboard Users X E Copy Rights X
Close I Copy |
Copy Rights -
To User [adminuser
From User || v

To copy rights from another user, click Copy Rights.

The current selected user ID displays in the "To User" field. Select the user whose rights you want to copy as the
"From User," and click Copy.

Delete a User

To delete a user, select their user ID from the "Select User ID" list and click Delete User. To deactivate a user instead
of deleting them, mark the user as "Inactive" on the "User Information" section of the screen.
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Reset Password

o I
Backup/Restore v &\.‘ ‘7‘;] E

Import/Export ¥ ) i i
Dashboard Clients Transactions Vendors Reconcile
File View
| Dashboard | Users X |- ResetUserPassword X

Close l Change |

Password Information T

User ViewUser
New Password
Verify

Require user to change 4
password at next logon

Passwords are case-sensitive.

To reset a user's password, select the user ID from the "Select User ID" list and click Reset Pwd.

Enter the new password for the user under both "New Password" and "Verify," then click Change. To leave the user's
password blank, click Change without entering anything for "New Password" or "Verify."

Menu Security

s Representative Payee Manager = =] X
File RPM
Backup/Restore ...\o. Zj E = Client ~ ’E’ .'.“.A@ @' ;; Find @ Help
Import/Export ~ = i ) - Setup v H save 1 System Info
Dashboard Clients Transactions Vendors Reconcile List Reports Users Change  User
Maintenance Transaction v Password Settings £ Tech Support
File View Utilities Reports Security Edit Records Filter/Sort Help ~
Dashboard Users X 5] User Security By Menu X | X
Selected Menu Option |View - Clients
Menu Option Details  |Clients screen under the Clients button. "Update" allows adding new
clients. "None" will prevent access to the screen and all options
under the screen. User Rights for Selected Menu Option
Menu Menu Option Menu Sub Option [«] User ID Security Level
File Back Up Data View Users » [AdminUser Update v
File Restore Data View Users RPMDemol Update v
File Export Positive Pay File View Users RPMDemo2 Update v
File Export XEFT Transactions View Users |— RPMDemo3 Update v
File Import ACH Deposits View Users RPMDemo4 Update v
View Dashboard View Users SecurityUser None &
P [View Clients v-ew Users | TransUser Update v
View Clients Basic View Users ViewUser View v
View Clients Basic - Accounts View Users
View Clients Basic - View/Edit SSN View Users
View Clients Basic - Claim #s View Users
View Clients Personal View Users
View Clients Personal - XEFT Account View Users
View Clients Schedule Pmts View Users
\View Clients Schedule Deps View Users.
View Clients Schedule Xfer View Users
View Clients View Trans View Users
\View Clients Housing View Users.
View Clients Income View Users =] AllRights | NoRights
User Security By Menu - View Users Num Lock  Powered by Microsoft Access

To view the user security assigned to each menu option, click Menu Security.

This screen lists all the available security menu options on the left side of the screen. To see all the user rights for that
menu option, click View Users. The selected menu option displays at the top of the screen. Each user and the rights
they have to the selected menu option displays on the right side of the screen.

Click All Rights to quickly give all users all rights to the selected menu option. Click No Rights to remove rights for all
users to the selected menu option. Individual users' rights can also be changed here.
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User Log

Backup/Restore ~ @ ...% Z_—] @ 5 Client ~ 1’[; &A‘.‘.i. @

Import/Export ~ R X i i Setup v
Dashboard Clients Transactions Vendors Reconcile List ; Reports Users Change  User
Maintenance Transaction ~ Password Settings
File View Utilities Reports Security
Dashboard Users X [-5| User Security Logged In Users X
Close

This screen lists the users currently logged in to RPM and displays the login date and time. If a user exits RPM abnormally, their
user ID may not be cleared from the system. Use the "Clear User" button to clear a user's login from RPM. If you click "Clear
User" for a user who is currently using RPM, they will be logged out of RPM within 10 minutes.

Current User |AdminUser

User ID Login Date/Time
» [romdemo4 |1/24/2024 11:12:08 AM |
romdemo3 |1/24/2024 11:12:43 AM Clear User [

To view the users currently logged in to RPM, click User Log.

This screen lists the users currently logged in to RPM and displays the login date and time. If a user exits RPM
abnormally, their user ID may not be cleared from the system. Click Clear User to clear a user's login from RPM. If
you click Clear User for a user who is currently using RPM, they will be logged out of RPM within 10 minutes.

Cloud Users

Click the Cloud Users button to view a list of your current RPM Cloud users. These are the users who can access
your RPM Cloud server by logging in with their email addresses. To add, remove, or swap RPM Cloud users with
access to your server, submit a Cloud User Change form, which is accessible through the link on the screen.

Learn more about RPM Cloud users, as opposed to RPM user IDs, on our RPM Cloud users webpage.

This only applies to companies with a current RPM Cloud subscription. Learn more at rpmccs.com/cloud-pricing.
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Change Password

2] Change Password = (=] X

Password Information

Old Password l— Passwords are case-sensitive.
New Password li
Verify l—

Change Close

Select Change Password from the Security menu to open this screen. This is used to change your logon password.

Users should change their passwords frequently. If you forget your password, it can be reset by another RPM user
who has rights to the Users screen.

To change your password, enter your current password in the "Old Password" field, followed by the new password in

both the "New Password" and "Verify" fields. To leave your password blank, click Change without entering anything
for the "New Password" or "Verify."

*Passwords are case-sensitive.**

The next time you log on to RPM, the new password will be required.
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User Settings

@ Representative Payee Manager

File RPM
Backup/Restore v E’W r\q V If:lﬁ G Client ~ e%» & Q_]:_ /O Find
@ S v E (Y v
Impo/Export. Dashboard Clients Transactions Vendors Reconcile List Setlip Reports Users Change  User F‘ﬂ 3808
Maintenance Transaction v Password Settings ‘4) Can't Undo v
File View Utilities Reports Security Edit Records
Dashboard X E User Settings X
Close | Test Email |
User IAdminUser ]Admin User
Email Settings ~Client Defaults
Email Address Iadminuser@test.com Support Type
Filter Default @Al € selected
Dashboard Settings Default ,‘—v‘
Display Dashboard wh ingRPM ¥
Isplay Dashboard when-opening Display Account Balances at top of Clients Screen 4
SRR T Highlight Balances
Filter Default ® Al T selected tinderMinimum| I
Default | v overLimit ¥
lclicei sy sscsfons Client Schedule Payments Default Display " 2Line  1Line
Days in the Future 7
Edit Documents Using Hyperlink ¢ OLE
Include Urgent Case Notes and Events 7
Display Case Notes Overview
Days in the Past 30
Days in the Future 30
Electronic Check Signature
Signature 1 |C:\Shared Folder\RPM Documents\Signatures\SignatureAdmin.bmp Select File Remove File
Signature 2 I Select File Remove File

UserID

Select User Settings from the Security menu to open this screen. The current RPM user's settings can be changed

here.

Email Settings
[ ]

Test Email to send a test email to the email address

Dashboard Settings

Email Address - enter your email address. This will be used for sending reports in RPM to your own email. Use

entered.

The settings below can be used to set the default options for the Dashboard screen.

Display Dashboard when opening RPM - check this option to automatically display the Dashboard screen

managers or a selected account manager.

Include Transactions - transaction counts on the Dashboard include scheduled deposits, scheduled payments,

unprinted checks, XEFT transactions not exported, and

[ ]
when opening RPM.
e Account Manager
o Filter Default - display information for all account
o Default - select the default account manager to display.
[ ]
unverified scheduled payments, scheduled transfers,
receipts required but not received through this date.
[ ]
[ ]

Days in the Future - the default number of days in the future to show outstanding transaction item counts.
Include Client Information - includes urgent case notes and events not complete.

Days in the Past - the default number of days in the past to show outstanding client items.
Days in the Future - the default number of days in the future to show outstanding client items.
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Client Defaults
The following settings can be used to set default options for the Clients screen.
e Support Type
o Filter Default - display all support types or a selected support type.
o Default - select the default support type to display.
e Display Account Balances at top of Clients screen - choose whether to display account balances.
e Highlight Balances - choose whether to highlight client balances under minimums and/or over limits.
e Client Scheduled Payments Default Display - display 1 or 2 lines by default on the Schedule Pmts tab.

e Edit Documents Using - select the default option to use for opening documents linked to clients or transactions.
If there are problems opening documents with one option, try the other option.

o Display Case Notes Overview - option to turn the "Case Notes Overview" display on or off on the Case Notes
tab.

Electronic Check Signature

If electronic signatures are set to print on checks on the Check Layout screen and the "Allow Individual User
Signatures" option for one or both signatures is enabled, select individual user signatures here by clicking Select File.

To remove existing user signature files, click Remove File. Signatures selected here will overwrite shared signhature
files on checks printed by the current user.

Signature files should not be larger than 3" x 1/2".
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Backing Up Your Data

This topic only applies for an RPM Onsite license with an Access database. For an RPM Onsite license with a SQL
Server database, your IT department will need to back up your data files. For RPM Cloud, we handle all backups.

If RPM is installed on a network server, confirm with your IT department that your RPM Server folder is part of a
regular network backup. Otherwise, use the "Back Up Data" option in RPM.

All current data for RPM is usually stored in a single file, RPMData.mdb (for a Multi-Company license, each additional
company data file will be followed by a number: RPMData2.mdb). The data file is located in your RPM Server folder.
Select System Info from the Help menu in RPM to see the location of your data file.

**Your data file should be backed up daily or as often as you use RPM.**

All archived transactions are stored in a separate file in the RPM Server folder, RPMData_Archive.mdb (for a Multi-
Company license, each additional company archive data file will be followed by a number: RPMData_Archive2.mdb).
This file is only updated when you run the Archive/Balance Forward process and should be backed up periodically (or
at least after you run the Archive/Balance Forward process).

Back Up Data

=2] Back Up Data - O X

Back Up RPM Data
Select File to Back Up To

Back Up Close

Select Back Up Data from the File, Backup/Restore menu to open the backup screen. All other users must be out
of RPM to run the backup.

Click Select File to select your backup file name and location. Once the file has been selected, click Back Up to back
up your data. A message displays when your backup is complete. Both the current and archive data files will be
included in the backup (RPMdata.mdb and RPMData_Archive.mdb). Click Close to close the backup screen.

Restore Data

=Z| Restore Data — O X

Restore RPM Data

Select File to Restore From

lC:\Shared Folder\RPM Documents\Backup\rpmbackup_020124.zip Select File
Current File Information Restore File Information

Version 6.0.7 Version

Latest Transaction Date  |02/06/2024 Latest Transaction Date

Latest Audit Event Date  |01/17/2024 Latest Audit Event Date

il

Close
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Select Restore Data from the File > Backup/Restore menu to open the restore data screen. This option can only
restore from a backup that was created using the Back Up Data screen. All other users must be out of RPM to
restore data.

Click Select File to select the file from which you want to restore. Once the file has been selected, click Restore to
start the process. Information will display from both your current data file and the data file from which you want to
restore. Choose whether or not to restore the data from the displayed backup data file. If you go ahead with the
restore, a message will display when the restore is complete, and RPM will shut down. Both the current and archive
data files will be included in the restore (RPMdata.mdb and RPMData_Archive.mdb).

**Restoring your data from a backup will overwrite any data that you currently have entered in RPM and
replace it with the data in your backup.**
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Installation Instructions

This topic only applies for an RPM Onsite license. For RPM Cloud, we handle all RPM installations.

For detailed instructions and requirements for an RPM Onsite license with an Access database, see our
Knowledge Base topics:

rpmccs.com/resources/category/rpm-onsite-access/

For detailed instructions and requirements for an RPM Onsite license with a SQL Server database, see our
Knowledge Base topics:

rpmccs.com/resources/category/rpm-onsite-sql/

RPM is designed to run either as a standalone application on a single computer or from a network.

The first step installs the RPM Server and database files. The second step installs the RPM Client on each
workstation. We recommend having the installations completed by an IT person. The installation must be run with
administrator rights.

Step 1 - Server Install

a) Download and save the RPM trial RPMServerSetup608.exe program from the link on our website. After you
save the file, right-click on the file and select "Run as administrator" to start the RPM Server installation.

b) Follow the prompts until the Destination Folder screen. The folder defaults to “C:\RPM Server”. To install on
a server, change this to a folder or UNC path located on your network file server (for example, F:\RPM Server
or \Servern\RPM Server). We do NOT recommend installing from an IP address. Users need all rights to the
RPM Server folder to run RPM.

d) The first time RPM is installed on a computer, an option displays to automatically run step 2 and install the
RPM Client. If you select this option, skip to step 2b below. Otherwise, continue with step 2a.

Step 2 - Client Install
This step must be run on each workstation that will be using RPM. It will install a shortcut for RPM on the user’s
desktop and a menu option for Representative Payee Manager in the Windows program menu. The installation must
be run with administrator rights. Users without administrator rights will be able to run RPM but cannot install the
program.
a) When the server install was run, a folder named “Client Install” was created beneath the folder you specified.
From that “Client Install” folder, run RPMClientSetup.exe to install the RPM Client (for example, FARPM
Server\Client Instal\RPMClientSetup.exe). Right-click on RPMClientSetup.exe and select Run as
administrator to start the RPM Client installation.
b) Follow the prompts to install the application in the default location. The default location is “C:\Users”. Do not
install the client files in the same folder as the server files in step 1.

c¢) Follow the remaining prompts until complete.
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Administrator Utilities

The following items can be found under the Start menu on your computer (outside of RPM) or in the "RPM Server"
folder. Applications on the Start menu can be found using the Windows "Search" box. Applications in the "RPM
Server" folder can be found by navigating to the "RPM Server" folder (using File Explorer, for example) and then
double-clicking on the application to run it.

The Optimizer and Refresh Client utilities can also be accessed within RPM on the Tech Support screen. The User
Log option on the Users screen in RPM also performs the same function as the User Maintenance application.

Optimizer

The Optimizer is a utility that can be used to compact your RPM database and repair any errors.

To access the Optimizer within RPM, open the Tech Support screen under the Help section of the ribbon menu. Click
Optimizer.

Before the process begins, a message will display telling you that RPM must be shut down and asking if you want to
continue. Click Yes to run the Optimizer. When it is complete, a message will display stating it has completed.

If you are unable to access the Optimizer in RPM, it can also be accessed from the Windows Start menu and the
"RPM Server"” folder. See our Knowledge Base article for more information: https://romccs.com/resources/optimizer/.

Refresh Client

The Refresh Client utility will update your RPM Client software with a new copy from the RPM server. This utility is
generally only used if directed to do so by RPM technical support personnel.

To access the Refresh Client utility within RPM, open the Tech Support screen under the Help section of the ribbon
menu. Click Refresh Client.

Before the process begins, a message will display telling you RPM must be shut down and asking if you want to
continue. Click Yes to continue. When complete, a message will display stating it has completed.

If you are unable to access Refresh Client in RPM, it can also be accessed from the Windows Start menu and the
"RPM Server" folder. See our Knowledge Base article for more information: https://rpomccs.com/resources/refresh-
client/.

Scheduler

Z2] Unavailable Schedule = O X

Enter the times for each day of the week when the system will be unavailble,
such as during scheduled backups. Any users in the system during these times
will be automatically logged out and not able to log back in until after the End
Time.

Allowable login times can be entered by user on the Users screen in RPM

Day Begin Time End Time

Sunday

Monday

Tuesday
Wednesday
Thursday
Friday 11:00 PM | 11:30 PM
P [saturday [

Close

The Scheduler application is used for entering times when the RPM system will be unavailable. Enter "Scheduler" in
your Windows "Search" box and click the Scheduler app to run this utility.
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If you do not have this on your Windows Programs menu, run the application from the RPM Server folder. From your
RPM Client computer, navigate to the RPM Server folder (using File Explorer, for example) and double-click on the
Scheduler application to run it.

If you are using RPM during these times, users will be automatically logged off and not allowed back in until the time
has passed. In the above example, the system is unavailable on Fridays from 11 p.m. to 11:30 p.m. These times can
be used to schedule backups, run the Optimizer, or install an upgrade.

To change the times, type the begin and end times on the appropriate day of the week in the formation "hh:mm
AM/PM." To remove an unavailable time, highlight and delete the begin and end time.

Users with rights to the Users screen in RPM can use the Schedule tab on that screen to set allowable login times for
each user.

User Maintenance

Z5| User Maintenance = O X

Click the Clear check box next to the User ID and
click the Reset button to clear the user's login and
allow them back into RPM.

Users can also be cleared using the User Log
button on the Users screen in RPM

User ID Login Date/Time Clear
adminuser 10/28/2022 3:10:05 PM
viewuser 10/28/2022 1:32:23 PM |

The User Maintenance application can be used to clear users who have exited RPM abnormally. Enter "User
Maintenance" in your Windows "Search" box and click the User Maintenance app to run this utility.

If you do not have this on your Windows Programs menu, run the application from the RPM Server folder. From your
RPM Client computer, navigate to the RPM Server folder (using File Explorer, for example) and double-click on the
UserMaintenance application to run it.

RPM tracks when you log on to the system. You cannot log on to RPM using the same user ID on more than one
computer at the same time. If you exit abnormally, your user ID may not be cleared from the system. In that case, the
User Maintenance application can be used to clear users from the system. Click the "Clear" checkbox next to the user
ID and click Reset to clear the user and allow them to get back into RPM.

Users with rights to the Users screen in RPM can use the User Log button on that screen to clear other users. See
our Knowledge Base article for more information: https://rpomccs.com/resources/clear-user-log/.

143


https://rpmccs.com/resources/clear-user-log/

Company Connect

ZE] RPM Company List = o X
pany

This utility is used to set up your RPM databases for separate companies. Each company database will have two
data files: RPMDataX.mdb and RPMData_ArchiveX.mdb where X is the company ID shown.

If you are no longer using a company database, mark it as Inactive. Do not delete the data files from your RPM
Server folder.

Company Name Company ID RPM Data File Inactive
» |company 1 RPMData.mdb I Repair
Company 2 2 RPMData2.mdb I Repair
* I Repair

e

Open the CompanyConnect application in the RPM Server folder to start the Company Connect utility. From an RPM
Client computer, navigate to the RPM Server folder (using File Explorer, for example) and double-click on the
CompanyConnect application to run it. This is only available with an RPM Onsite Multi-Company license using an
Access database.

This utility is used to set up RPM databases for separate companies. If there is more than one database, each user
will select the "Company Name" to use when opening RPM. If there is only one database, it will be opened
automatically in RPM.

Use "AdminUser" to log in to a new company database and set up your own users.

Mark a company database as "Inactive” if it is no longer used. Do not delete the data files from your RPM Server
folder.

Click Repair to compact and repair any RPM company databases. All users in that company must have RPM closed
to run the repair process.
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SQL Connect

2] sQL Connection Configuration - O X

For RPM SQL Server instructions, see the details on our web site:
rpmccs.com/files/RPMSQLServerDatabaselnstructions.pdf

Select the SQL Driver to use. This driver must be installed on all RPM Client computers. Instructions for this are in Step 2 of
the above link.

SQL Server must be configured for SQL Server and Windows Authentication mode.

The User ID and Password for each database should be from the CreateSQLDatabase script unless you created a different
user id and password for the database manually.

You can troubleshoot any SQL connections issues by following the instructions in the link below on our web site:
rpmecs.com/files/RPMTestSQLODBCConnection.pdf

Select SQL Driver !ODBC Driver 17 for SQL Server v
Company Name Server Name Database Name User ID Password Type
P |Company 1 ISQLDB IRPMl Irpmuserl I‘***“‘ |Production | Test Connection [
Company 2 ]SQLDB ]RPMZ [rpmuser2 ]****"** [Production [¥] Test connection ]
* ] ] ] ] ]Production < Test Connection |

Save Cancel Close

Open the SQLConnect application in the RPM Server folder to start the SQL Connect utility. From your RPM Client
computer, navigate to the RPM Server folder (using File Explorer, for example) and double-click on the SQLConnect
application to run it. This is only available with an RPM Onsite license using a SQL Server database.

This utility is used to set up the connection to each RPM SQL Server database. If there is more than one database,
each user will select the "Company Name" to use when opening RPM. If there is only one database, it will be opened
automatically in RPM.

Use "AdminUser" to log in to a new company database and set up your own users.

A SQL database must be created with the "CreateSQLDatabase" script before the connection can be set up.
Instructions for setting up the RPM SQL database(s) are on our website: rpmccs.com/resources/setting-up-an-rpm-
sal-server-database/

1) Select the SQL driver to use. The latest supported driver (ODBC Driver 17 for SQL Server) can be installed by
running msodbcsgl.exe from the RPM Server\Client Instal\ODBC Driver 17 for SQL Server folder. The selected
driver must be installed on ALL computers running the RPM Client. (Older supported drivers displayed in order from
newest to oldest are available in the "Select SQL Driver" list and can be downloaded and installed from Microsoft.)

2) SQL Server must be configured for SQL Server and Windows Authentication mode.

3) The user ID and password for each database should be from the "CreateSQLDatabase" script unless you created a
different user ID and password for the database manually.

4) The Type defaults to "Production.” Change it to "Test" to use a database for testing. Live checks cannot be printed
from a test database.

5) The SQL connection will be validated after you enter the connection information. Once a valid connection has been
saved, the users will have access to that company in RPM. If the SQL password or any other information changes in
the future, use this utility to update the connection configuration.

Click Test Connection to test an existing SQL connection.
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Technical Support

For technical support, contact Complete Computer Solutions, Inc.

Mailing address:
PO Box 875
Floyds Knobs, IN 47119

Phone: (812) 923-0910

Visit our website (rpmccs.com) or access our Knowledge Base (rpmccs.com/resources/).

Send emails to "RPM@rpmccs.com”.

One year of support is included with your initial purchase. After the first year, support is included in the annual license
fee. New program releases are also included in this fee.

Unlimited support is available via email. Phone support includes up to 10 incidents per year (excluding RPM Lite).
Additional phone support incidents can be purchased if necessary.

Visit our website to see current pricing for both RPM Cloud and RPM Onsite.
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